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1. System Requirements
You may install BitDefender Total Security 2011 only on computers running the
following operating systems:
●Windows XP with Service Pack 3 (32 bit) / Windows XP with Service Pack 2 (64
bit)

●Windows Vista with Service Pack 1 or higher (32/64 bit)
●Windows 7 (32/64 bit)
Before installation, make sure that your computer meets the minimum hardware
and software requirements.

Note
To find out the Windows operating system your computer is running and hardware
information, right-click My Computer on the desktop and then select Properties
from the menu.

1.1. Minimal System Requirements
● 1 GB available free hard disk space
● 800 MHz processor
● RAM Memory:
▶ 512 MB for Windows XP
▶ 1 GB for Windows Vista and Windows 7

● Internet Explorer 6.0
● .NET Framework 2 (also available in the installer kit)
● Adobe Flash Player 10.0.45.2

1.2. Recommended System Requirements
● 1 GB available free hard disk space
● Intel CORE Duo (1.66 GHz) or equivalent processor
● RAM Memory:
▶ 1 GB for Windows XP and Windows 7
▶ 1.5 GB for Windows Vista

● Internet Explorer 7
● .NET Framework 2 (also available in the installer kit)
● Adobe Flash Player 10.0.45.2

1.3. Software Requirements
Antiphishing protection is provided only for:
● Internet Explorer 6.0 or higher
● Mozilla Firefox 3.x
● Yahoo! Messenger 8.1
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●Microsoft Windows Live Messenger 8
Instant Messaging (IM) encryption is provided only for:
● Yahoo! Messenger 8.1
● Microsoft Windows Live Messenger 8
Antispam protection is provided for all POP3/SMTP e-mail clients. The BitDefender
Antispam toolbar however is integrated only into:
● Microsoft Outlook 2003 / 2007 / 2010
●Microsoft Outlook Express
● Microsoft Windows Mail
● Mozilla Thunderbird 3.0.4
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2. Preparing for Installation
Before you install BitDefender Total Security 2011, complete these preparations to
ensure the installation will go smoothly:
● Make sure that the computer where you plan to install BitDefender meets the
minimum system requirements. If the computer does not meet all the minimum
system requirements, BitDefender will not be installed or, if installed, it will not
work properly and it will cause system slowdowns and instability. For a complete
list of system requirements, please refer to “System Requirements” (p. 2).

● Log on to the computer using an Administrator account.
● Remove any other security software from the computer. Running two security
programs simultaneously may affect their operation and cause major problems
with the system. Windows Defender will be disabled by default before installation
is initiated.

● Disable or remove any firewall program that may be running on the computer.
Running two firewall programs simultaneously may affect their operation and
cause major problems with the system. Windows Firewall will be disabled by
default before installation is initiated.
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3. Installing BitDefender
You can install BitDefender from the BitDefender installation CD or using the
installation file downloaded on your computer from the BitDefender website or from
other authorized websites (for example, the website of a BitDefender partner or an
online shop). You can download the installation file from the BitDefender website
at the following address: http://www.bitdefender.com/site/Downloads/.
● To install BitDefender from the CD, insert the CD into the drive. A welcome screen
should be displayed in a fewmoments. Follow the instructions to start installation.

Note
The welcome screen provides an option to copy the installation package from the
installation CD to a USB storage device. This is useful if you need to install
BitDefender on a computer that does not have a CD drive (for example, on a
netbook). Insert the storage device into the USB drive and then click Copy to USB.
Afterwards, go to the computer without a CD drive, insert the storage device into
the USB drive and double-click runsetup.exe from the folder where you have
saved the installation package.

If the welcome screen does not appear, go to the CD's root directory and
double-click autorun.exe.

● To install BitDefender using the installation file downloaded on your computer,
locate the file and double-click it.

The installer will first check your system to validate the installation. If the installation
is validated, you will be prompted to select the language before the setup wizard
appears.
The wizard will help you install BitDefender on your computer and at the same time
will allow you to configure the main settings and user interface.

3.1. Step 1 - Introduction
Please read the License Agreement and select By checking this box, I agree to
the BitDefender license agreement. Click Next to continue.
If you do not agree to these terms click Cancel. The installation process will be
abandoned and you will exit setup.

3.2. Step 2 - Preparing Install
BitDefender scans your system and checks if any other security software is installed
on it.
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Quick Scan
A quick scan of critical areas on your system is performed to ensure no active
malware is residing on it.
The scan shouldn't take more than a few minutes. You can cancel it at any time by
using the provided button.

Important
It is highly recommended to allow the scan to complete.
Active malware could disrupt the installation and even cause it to fail.

After the scan is completed, the results are displayed. If any threats are detected,
follow the instructions to remove them before continuing the installation.
Click Next to continue.

Removing Existing Security Software
BitDefender Total Security 2011 alerts you if you have other security products
installed on your computer. Click the corresponding button to start the uninstall
process and follow the instructions to remove any detected products.

Warning
It is highly recommended that you uninstall any other antivirus products detected
before installing BitDefender. Running two or more antivirus products at the same
time on a computer usually renders the system unusable.

BitDefender also recommends actions to take on enabledWindows security features.
● Turn off Windows Firewall - to turn off Windows Firewall.

Important
We recommend you to turn off Windows Firewall since BitDefender Total Security
2011 already includes an advanced firewall. Running two firewalls on the same
computer may cause problems.

● Turn off Windows Defender - to turn off Windows Defender.
Click Next to continue.

3.3. Step 3 - Registration
The BitDefender registration process consists in registering the product with a
license key and activating online features by creating a BitDefender account.

Register Your Product
Proceed according to your situation:
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● I purchased BitDefender Total Security 2011 on a CD or online
In this case, you need to register the product:
1. Type the license key in the edit field.

Note
You can find your license key:
▶ on the CD label.
▶ on the product registration card.
▶ in the online purchase e-mail.
If you do not have a BitDefender license key, click the provided link to go to the
BitDefender online store and buy one.

2. Click Register Now.
3. Click Next.

● I downloaded BitDefender Total Security 2011 for evaluation
In this case, you can use all the product features for a 30 day period. To begin
the trial period, select I want to evaluate BitDefender Total Security 2011
for 30 days and click Next.

Activate Online Features
You MUST create a BitDefender account in order to receive BitDefender updates.
The BitDefender account also gives you access to online parental control, free
technical support and special offers and promotions. If you lose your BitDefender
license key, you can log in to your account at http://myaccount.bitdefender.com to
retrieve it.
If you do not want to create a BitDefender account at the moment, select Create
Account Later and click Next.

Note
If you are installing BitDefender Total Security 2011 for evaluation, you must create
a BitDefender account at this point.
If you have purchased the product, you must create an account within 30 days of the
installation.

Otherwise, proceed according to your current situation:
● I don't have a BitDefender account
To successfully create a BitDefender account, follow these steps:
1. Select Create New Account.
2. Type the required information in the corresponding fields. The data you provide

here will remain confidential.
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▶ Username - type in your e-mail address.
▶ Password - type in a password for your BitDefender account. The password
must be between 6 and 16 characters long.

▶ Retype password - type in again the previously specified password.
You do not have to retype the password if you selected not to mask the
password while typing it.

▶ Password hint - enter a word or phrase that will help you remember the
password should you forget it.

Note
Once the account is activated, you can use the provided e-mail address and
password to log in to your account at http://myaccount.bitdefender.com.

3. Optionally, BitDefender can inform you about special offers and promotions
using the e-mail address of your account. Click View Contact Options and
select one of the available options in the window that appears.
▶ Send me all messages
▶ Send me important messages
▶ Do not send me any messages

4. Click Submit.
5. Click Next to continue.

Note
Before being able to use your account, you must activate it.
Check your e-mail and follow the instructions in the e-mail message sent to you
by the BitDefender registration service.

● I already have a BitDefender account
BitDefender will automatically detect if you have previously registered a
BitDefender account on your computer. In this case, provide the password of your
account and click Submit. Click Next to continue.
If you already have an active account, but BitDefender does not detect it, follow
these steps to register the product to that account:
1. Select Sign in (Prev. Account).
2. Type the e-mail address and the password of your account in the corresponding

fields.

Note
If you have forgotten your password, click Forgot your password? and follow
the instructions.
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3. Optionally, BitDefender can inform you about special offers and promotions
using the e-mail address of your account. Click View Contact Options and
select one of the available options in the window that appears.
▶ Send me all messages
▶ Send me important messages
▶ Do not send me any messages

4. Click Submit.
5. Click Next to continue.

3.4. Step 4 - Choose View
This is where you choose the type of installation to perform and the interface view
mode to use.

Choose Setup Type
The following setup options are available:
● Easy Setup - select this option if you prefer a quick installation and do not intend
to configure BitDefender settings in detail.

● Custom Setup - select this option if you prefer to customize the installation and
the BitDefender settings.

To see a video tutorial that will help you with the installation, click Get Help

Note
To install BitDefender in a default configuration and go straight to the last step of the
installation wizard, select Skip Setup.

Click Next to continue.

Choose Setup Location
Note
This step appears only if you have chosen a Custom Setup.

By default, BitDefender Total Security 2011 will be installed in C:\Program
Files\BitDefender\. If you want to change the installation path, click Browse
and select the folder in which you would like BitDefender to be installed.
You can share the product files and signatures with other BitDefender users. This
way, BitDefender updates can be performed faster. If you don't want to enable this
feature, select the corresponding check box.
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Note
No personal identifiable information will be shared if this feature is enabled.

Click Next to continue.

Choose User Interface
Select the user interface view mode that best suits your needs. BitDefender Total
Security 2011 gives you a choice of three interfaces, each tailored to the needs of
a different type of user.
Basic View

Suited for computer beginners and people who want BitDefender to protect
their computer and data without being bothered. The interface is simple to use
and requires minimal interaction on your side.
All you have to do is fix the existing issues when indicated by BitDefender. An
intuitive step-by-step wizard assists you in fixing issues. Additionally, you can
perform common tasks, such as updating the BitDefender virus signature and
product files or scanning the computer.

Intermediate View
You can configure the main BitDefender settings, fix issues separately, manage
the BitDefender products installed on the computers in your household and
choose which issues to be monitored. Moreover, you can control how your
children use the computer and the Internet by configuring Parental Control.

Expert View
Suited for more technical users, this mode allows you to fully configure each
functionality of BitDefender. You can also use all tasks provided to protect your
computer and data.

Make your selection and click Next to continue.

3.5. Step 5 - Configure
This is where you can customize your product.

Configure Settings
Note
This step appears only if you have set the BitDefender interface to Expert View.

Here you can enable / disable BitDefender features organized in two categories. To
change the status of a setting, click the corresponding switch.
● Security Settings

Installing BitDefender 10

BitDefender Total Security 2011



In this area, you can enable or disable product settings that cover various aspects
of computer and data security.

DescriptionSetting
Real-time protection ensures that all files are
scanned as they are accessed by you or by an
application running on this system.

Antivirus

Automatic update ensures that the newest
BitDefender product and signature files are

Automatic Update

downloaded and installed automatically, on a regular
basis.
Automatic vulnerability check ensures that crucial
software on your PC is up-to-date.

Vulnerability Check

Antispam filters the e-mail messages that you
receive, marking unsolicited and junk mail as SPAM.

Antispam

Antiphishing detects and alerts you in real-time if a
web page is set up to steal personal information.

Antiphishing

Identity Control helps you prevent your personal
data from being sent out on the Internet without

Identity Control

your consent. It blocks any instant messages, e-mail
messages or web forms transmitting data you
defined as being private to unauthorized recipients
(addresses).
Chat Encryption secures your conversations via
Yahoo! Messenger and Windows Live Messenger

Chat Encryption

provided that your IM contacts use a compatible
BitDefender product and IM software.
Parental Control restricts the computer and online
activities of your children based on the rules you

Parental Control

defined. Restrictions may include blocking
inappropriate web sites, as well as limiting gaming
and Internet access according to a specified
schedule.
Firewall protects your computer from hacker and
malicious outside attacks.

Firewall

File Encryption keeps your documents private by
encrypting them in special vaulted drives. If you

File Encryption

disable File Encryption, all file vaults will be locked
and you will no longer be able to access the files
they contain.
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●General Settings
In this area, you can enable or disable settings that affect product behavior and
user experience.

DescriptionSetting
GameMode temporarily modifies protection settings
so as to minimize their impact on system
performance during games.

Game Mode

LaptopMode temporarilymodifies protection settings
so as to minimize their impact on the life of your
laptop battery.

Laptop Mode Detection

This ensures that the BitDefender settings can only
be changed by the person who knows this password.

Settings Password

When you enable this option, you will be prompted
to configure the settings password. Type the desired
password in both fields and click OK to set the
password.
By enabling this option, you will receive important
company news, product updates or new security
threats from BitDefender.

BitDefender News

By enabling this option, you will receive information
alerts.

Product Notification
Alerts

The Scan Activity Bar is a small, transparent window
indicating the progress of the BitDefender scanning

Scan Activity Bar

activity. For more information, please refer to “Scan
Activity Bar” (p. 20).
By enabling this option, virus scanning reports are
sent to BitDefender labs for analysis. Please note

Send Virus Reports

that these reports will contain no confidential data,
such as your name or IP address, and that they will
not be used for commercial purposes.
By enabling this option, reports regarding potential
virus-outbreaks are sent to BitDefender labs for

Outbreak Detection

analysis. Please note that these reports will contain
no confidential data, such as your name or IP
address, and that they will not be used for
commercial purposes.

Click Next to continue.
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Configure My Tools
Note
This step appears only if you have set the BitDefender interface to Basic View or
Intermediate View.

WithMy Tools, you can personalize the dashboard by adding shortcuts to the tools
that are most important to you. This way you can ensure easy access to them.
From this screen, you can add shortcuts for any of the following tools:
● Parental Control - control and monitor your children's activities on the computer.
● GameMode - set up BitDefender so as not to allow it to interfere with your gaming
experience.

● Laptop Mode - temporarily modifies protection settings so as to minimize their
impact on the life of your laptop battery.

● HomeNetworkManagement -manage BitDefender products installed on computers
in the home network from a single PC.

Select the tools you want to add and click Next to continue.

Set Up Parental Control
Note
This step appears only if you have added Parental Control to My Tools.

You can select one of three options:
● Set Parental Control on children accounts
Select this option to enable Parental Control on the Windows accounts created
for your children and manage it from the administrative account.

● Set Parental Control on current account
Select this option to enable Parental Control on the current Windows account.
This means you will not have to create separate accounts for your children, but
Parental Control rules will affect everyone using the current account.
In this case, a password is required to protect the Parental Control settings. You
can set it now or at a later time from the BitDefender window.

● Skip setup for now
Select this option to configure this feature at a later time from the BitDefender
window.

Click Next to continue.
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Home Network Management
Note
This step appears only if you have added Home Network Management to My Tools.

You can select one of three options:
● Set up this PC as Server
Select this option if you intend to manage BitDefender products on other
computers in the home network from this one.
A password is required to join the network. Enter the password in the provided
text boxes and click Submit.

● Set up this PC as Client
Select this option if BitDefender will be managed from another computer in the
home network which is also running BitDefender.
A password is required to join the network. Enter the password in the provided
text boxes and click Submit.

● Skip setup for now
Select this option to configure this feature at a later time from the BitDefender
window.

Click Next to continue.

3.6. Step 6 - Support Options
This is where you can customize help and support options:
● Enable / disable Smart Tips. Smart Tips are personalized messages displayed
in the BitDefender Dashboard to help you improve your computer's performance.

● Confirm the e-mail address you will use should you need to contact BitDefender
Customer Care. If you don't plan to contact Customer Care via e-mail, select the
corresponding check box.

3.7. Step 7 - Confirm
This is where you can review the selected configuration.
By default, two tasks are also scheduled:
● A full system scan is scheduled immediately after the installation is finished.
It is recommended to perform this thorough scan that will detect any malware
threats present on your system.

● A system scan is scheduled for every Sunday at 2 AM.
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It is highly recommended to scan your system at least once a week. Select a
different day and time if the default schedule is not suitable for you. If the
computer is shut down when the schedule is due, the scan will run the next time
you start your computer.

Click Finish.

3.8. Step 8 - Finish
The installation is now nearing completion. The final settings are applied and an
update is performed.
The wizard will automatically close when the installation is completed. If this option
was selected during the previous step, a full system scan is initiated.
The setup wizard will detect the network you are connected to and will let you
classify it as Home/Office or Public.

Note
A system restart may be required.
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4. Upgrading From an Older Version of BitDefender
You can upgrade to BitDefender Total Security 2011 if you are using BitDefender
Total Security 2011 beta, the 2008, 2009 or 2010 version.
There are two ways to perform the upgrade:
● Install BitDefender Total Security 2011 directly over the older version. If you install
directly over the 2010 version, the Friends and Spammers lists and the Quarantine
are automatically imported.

● Remove the older version, then restart the computer and install the new version
as described in chapter “Installing BitDefender” (p. 5). No product settings will
be saved. Use this upgrade method if the other fails.
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5. Repairing or Removing BitDefender
If you want to repair or remove BitDefender Total Security 2011, follow the path
from the Windows start menu: Start → All Programs → BitDefender 2011 →
Repair or Remove.
A wizard will appear to help you complete the desired task.
1. Repair or Remove

Select the action you want to perform:
● Repair - to re-install all program components.
● Remove - to remove all installed components.

Note
We recommend that you choose Remove for a clean re-installation.

2. Confirm Action
Make sure to read the information displayed carefully before clicking Next to
confirm the action.

3. Progress
Wait for BitDefender to complete the action you have selected. This will take
several minutes.

4. Finish
The results are displayed.
You need to restart the computer to complete the process. Click Restart to reboot
your computer immediately, or Finish to close the window and reboot at a later
time.
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6. Overview
Once you have installed BitDefender Total Security 2011, your computer is protected
against all kinds of malware (such as viruses, spyware and trojans) and Internet
threats (such as hackers, phishing and spam).
You are not required to configure other BitDefender settings besides those configured
during installation. However, you may want to take advantage of the BitDefender
settings to fine-tune and improve your protection.
From time to time, you should open BitDefender and fix the existing issues. You
may have to configure specific BitDefender components or take preventive actions
to protect your computer and your data. If you want to, you can configure
BitDefender not to alert you about specific issues.
If you have not registered the product (including creating a BitDefender account),
remember to do so until the trial period ends. You must create an account within
15 days after installing BitDefender (if you register it with a license key, the deadline
is extended to 30 days). Otherwise, BitDefender will no longer update. For more
information on the registration process, please refer to “Registration and My Account”
(p. 51).

6.1. Opening BitDefender
To access the main interface of BitDefender Total Security 2011, use the Windows
Start menu, by following the path Start → All Programs → BitDefender 2011 →
BitDefender Total Security 2011 or, quicker, double-click the BitDefender icon
in the system tray.

For more information on the main application window, please refer to “Main
Application Window” (p. 23).

6.2. System Tray Icon
To manage the entire product more quickly, you can use the BitDefender icon in
the system tray. If you double-click this icon, BitDefender will open. Also, by
right-clicking the icon, a contextual menu will allow you to quickly manage the
BitDefender product.
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Tray Icon

● Show - opens the main interface of BitDefender.
●Help - opens the help file, which explains in detail how
to configure and use BitDefender Total Security 2011.

● About - opens a window where you can see information
about BitDefender and where to look for help in case
something unexpected appears.

● Fix All Issues - helps you remove current security
vulnerabilities. If the option is unavailable, there are no
issues to be fixed. For detailed information, please refer
to “Fixing Issues” (p. 42).

● Turn Game Mode On / Off - activates / deactivates Game Mode.
●Update Now - starts an immediate update. A new window will appear where you
can see the update status.

● Basic Settings - opens a window where you can enable or disable the main
product settings and reconfigure your user profile. For more information, please
refer to “Configuring Main Settings” (p. 44).

The BitDefender system tray icon informs you when issues affect your computer or
how the product operates, by displaying a special symbol, as follows:
Red triangle with an exclamation mark: Critical issues affect the security of

your system. They require your immediate attention and must be fixed as soon as
possible.
Letter G: The product operates in Game Mode.

If BitDefender is not working, the system tray icon is grayed out . This usually
happens when the license key expires. It can also occur when the BitDefender
services are not responding or when other errors affect the normal operation of
BitDefender.

6.3. Scan Activity Bar
The Scan activity bar is a graphic visualization of the scanning activity on your
system. This small window is by default available only in Expert View.

Scan Activity Bar

The gray bars (the File Zone) show the number of scanned
files per second, on a scale from 0 to 50. The orange bars
displayed in the Net Zone show the number of Kbytes
transferred (sent and received from the Internet) every
second, on a scale from 0 to 100.
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Note
The Scan activity bar will notify you when real-time protection or the Firewall is
disabled by displaying a red cross over the corresponding area (File Zone or Net
Zone).

6.3.1. Scan Files and Folders
You can use the Scan activity bar to quickly scan files and folders. Drag the file or
folder you want to be scanned and drop it over the Scan Activity Bar as shown
below.

Drag File

Drop File

The Antivirus Scan wizard will appear and guide you through the scanning process.
Scanning options. The scanning options are pre-configured for the best detection
results. If infected files are detected, BitDefender will try to disinfect them (remove
the malware code). If disinfection fails, the Antivirus Scan wizard will allow you to
specify other actions to be taken on infected files. The scanning options are standard
and you cannot change them.

6.3.2. Disable/Restore Scan Activity Bar
When you no longer want to see the graphic visualization, just right-click it and
select Hide. To restore the Scan activity bar, follow these steps:
1. Open BitDefender.
2. Click the Options button in the upper-right corner of the window and select

Preferences.
3. In the General Settings category, use the switch corresponding to Scan Activity

Bar to enable it.
4. Click OK to save and apply the changes.
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6.4. Automatic Device Detection
BitDefender automatically detects when you connect a removable storage device
to your computer and offers to scan it before you access its files. This is
recommended in order to prevent viruses and other malware from infecting your
computer.
Detected devices fall into one of these categories:
● CDs/DVDs
● USB storage devices, such as flash pens and external hard-drives
●mapped (remote) network drives
When such a device is detected, an alert window is displayed.
To scan the storage device, just click Yes. The Antivirus Scan wizard will appear
and guide you through the scanning process.
If you do not want to scan the device, you must click No. In this case, you may find
one of these options useful:
●Don't ask me again about this type of device - BitDefender will no longer
offer to scan storage devices of this type when they are connected to your
computer.

●Disable automatic device detection - You will no longer be prompted to scan
new storage devices when they are connected to the computer.

If you accidentally disabled automatic device detection and you want to enable it,
or if you want to configure its settings, follow these steps:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Antivirus>Virus Scan.
3. In the list of scan tasks, locate the Device Scanning task.
4. Right-click the task and select Properties. A new window will appear.
5. On the Overview tab, configure the scanning options as needed. For more

information, please refer to “Configuring Scan Settings” (p. 74).
6. On the Detection tab, choose which types of storage devices to be detected.
7. Click OK to save and apply the changes.
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7. Main Application Window
BitDefender Total Security 2011 meets the needs of computer beginners and very
technical people alike. Its graphical user interface is designed to suit each and every
category of users.
You can choose to view the user interface under any of three modes, depending on
your computer skills and on your previous experience with BitDefender.
Basic View

Suited for computer beginners and people who want BitDefender to protect
their computer and data without being bothered. This mode is simple to use
and requires minimal interaction on your side.
All you have to do is fix the existing issues when indicated by BitDefender. An
intuitive step-by-step wizard assists you in fixing issues. Additionally, you can
perform common tasks, such as updating the BitDefender virus signature and
product files or scanning the computer.

Intermediate View
Aimed at users with average computer skills, this interface extends what you
can do in Basic View.
You can fix issues separately and choose which issues to be monitored.
Moreover, you can manage remotely the BitDefender products installed on the
computers in your household.

Expert View
Suited for more technical users, this mode allows you to fully configure each
functionality of BitDefender. You can also use all tasks provided to protect your
computer and data.

The view mode is selected during installation.
To change the view mode:
1. Open BitDefender.
2. Click the Options button in the upper-right corner of the window.
3. Select the desired view mode from the menu.

7.1. Basic View
If you are a computer beginner, displaying the user interface in Basic View may be
the most adequate choice for you. This mode is simple to use and requires minimal
interaction on your side.
The window is organized into three main areas:
Status area

Status information is presented in the left side of the window.
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Protect Your PC area
This is where you can take the necessary actions to manage your protection
and maintain your computer.

Help area
This is where you can find out how to use BitDefender Total Security 2011 and
get help.

The Options button in the upper-right corner of the window allows you to change
the user interface view mode and to configure the main program settings.
In the bottom-right corner of the window, you can find several useful links.

DescriptionLink
Opens a window where you can see current license key
information and register your product with a new license key.

License Info

Allows you to see a detailed history of all tasks performed by
BitDefender on your system.

View Logs

Click this link if you need help with BitDefender.Help and Support
Gives you access to a help file that shows you how to use
BitDefender.

7.1.1. Status Area
Status information is presented in the left side of the window.
● Security Status informs you of the issues that affect your computer's security
and helps you fix them. By clicking Fix All Issues, a wizard will help you easily
remove any threats to your computer and data security. For detailed information,
please refer to “Fixing Issues” (p. 42).

● License Status displays how many days are left until the license expires. If you
are using a trial version or if your license is going to expire, you can click Buy
Now to buy a license key. For detailed information, please refer to “Registration
and My Account” (p. 51).

7.1.2. Protect Your PC Area
This is where you can take the necessary actions to manage your protection and
maintain your computer.
Three buttons are available:
● Security provides you with shortcuts to security tasks and settings.
● Tune-Up allows you to perform tasks that optimize your computer's performance
and responsiveness.
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●My Tools allows you to create shortcuts to your favorite tasks and settings.
To perform a task or configure settings, click the corresponding button and choose
the desired tool from the menu. To add or remove shortcuts, click the corresponding
button and choose More Options. For detailed information, please refer to “My
Tools” (p. 33).

7.1.3. Help Area
This is where you can find out how to use BitDefender Total Security 2011 and get
help.
Smart Tips are a fun and easy way to learn about computer security best practices
and how to use BitDefender Total Security 2011.
If you need help, type a keyword or a question in the Help and Support field and
click Search.

7.2. Intermediate View
Aimed at users with average computer skills, Intermediate View is a simple interface
that gives you access to all modules at a basic level. You'll have to keep track of
warnings and critical alerts and fix undesired issues.
The Intermediate View window is organized into several tabs.
Dashboard

The dashboard helps you easily monitor and manage your protection.
Security

Displays the status of the security settings and helps you fix detected issues.
You can run security tasks or configure security settings.

Tune-Up
Displays the status of the BitDefender features designed to improve your
system's performance together with links to tune-up tasks.

File Storage
Displays the status of the file vault and of the backup modules together with
links to the file vault and to backup tasks.

Network
Displays the BitDefender home network structure. This is where you can perform
various actions to configure and manage the BitDefender products installed in
your home network. In this way, you can manage the security of your home
network from a single computer.

The Options button in the upper-right corner of the window allows you to change
the user interface view mode and to configure the main program settings.
In the bottom-right corner of the window, you can find several useful links.
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DescriptionLink
Opens a window where you can see current license key
information and register your product with a new license key.

License Info

Allows you to see a detailed history of all tasks performed by
BitDefender on your system.

View Logs

Helps you purchase a license key for your BitDefender Total
Security 2011 product.

Buy/Renew

Click this link if you need help with BitDefender.Help and Support
Gives you access to a help file that shows you how to use
BitDefender.

7.2.1. Dashboard
The dashboard helps you easily monitor and manage your protection.
The dashboard consists of the following sections:
● Status Details indicates the status of each main module using explicit sentences
and one of the following icons:

Green circle with a check mark: No issues affect the security status. Your
computer and data are protected.

Red circle with an exclamation mark: There are issues that affect the
security of your system. Critical issues require your immediate attention.
Non-critical issues should also be addressed as soon as possible.
Blue circle with letter i: One or several tasks should be performed in order

to optimize the system or to protect your data.
Gray circle with an exclamation mark: The activity of this module's

components is not monitored. Thus, no information is available regarding their
security status. There may be specific issues related to this module.

Click the name of a module to see more details about its status and to configure
status tracking for its components.

● License Status displays how many days are left until the license expires. If you
are using a trial version or if your license is going to expire, you can click Buy
Now to buy a license key. For detailed information, please refer to “Registration
and My Account” (p. 51).

●My Tools allows you to create shortcuts to your favorite tasks and settings. For
detailed information, please refer to “My Tools” (p. 33).

● Smart Tips are a fun and easy way to learn about computer security best
practices and how to use BitDefender Total Security 2011.
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7.2.2. Security
The Security tab allows you to manage the security of your computer and data.
“Status Area” (p. 27)
“Quick Tasks” (p. 27)

Status Area
The status area is where you can see the complete list of monitored security
components and their current status. By monitoring each security module,
BitDefender will let you know not only when you configure settings that might affect
your computer's security, but also when you forget to do important tasks.
The current status of a component is indicated using explicit sentences and one of
the following icons:

Green circle with a check mark: No issues affect the component.
Red circle with an exclamation mark: Issues affect the component.

Just click the Fix button corresponding to a sentence to fix the reported issue. If an
issue is not fixed on the spot, follow the wizard to fix it.
To configure which components must be monitored:
1. Click Add/Edit List.
2. To turn on or off monitoring for a specific item, use the corresponding switch.
3. Click Close to save the changes and close the window.

Important
To ensure that your system is fully protected, enable tracking for all components and
fix all reported issues.

Quick Tasks
This is where you can find links to the most important security tasks:
●Update Now - starts an immediate update.
● Full System Scan - starts a standard scan of your computer (archives excluded).
For additional on-demand scan tasks, click the arrow on this button and select
a different scan task.

● Custom Scan - starts a wizard that lets you create and run a custom scan task.
● Vulnerability Scan - starts a wizard that checks your system for vulnerabilities
and helps you fix them.

● Parental Control - opens the Parental Control configuration window. For more
information, please refer to “Parental Control” (p. 99).
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● Configure Firewall - opens a window where you can view and configure the
Firewall settings. For more information, please refer to “Firewall” (p. 123).

7.2.3. Tune-Up
BitDefender comes with a Tune-Up module that helps you maintain the integrity of
your system. The maintenance tools offered are critical for the improvement of your
system's responsiveness and the efficient management of the hard drive space.
“Status Area” (p. 28)
“Quick Tasks” (p. 28)

Status Area
The current status of a component is indicated using explicit sentences and one of
the following icons:

Green circle with a check mark: No issues affect the component.
Blue circle with letter i: It is recommended that you run the task.

To run a recommended task, click the corresponding Run Now button and follow
the wizard. For more information, please refer to “Tune-Up” (p. 173).

Important
To improve your computer's performance, it is recommended to run all the tasks
periodically.

To configure which tune-up tools must be monitored:
1. Click Add/Edit List.
2. To turn on or off monitoring for a specific item, use the corresponding switch.
3. Click Close to save the changes and close the window.

Quick Tasks
This is where you can find links to the tune-up tasks:
● Disk Defragmenter physically reorganizes the data on the hard disk so that the
pieces of each file are stored close together and continuously.

● PC Clean-Up removes the temporary Internet files and cookies, unused system
files and recent documents shortcuts.

● Duplicate Finder finds and deletes files that are duplicated in your system.
● Registry Cleaner identifies and deletes invalid or outdated references in the
Windows Registry. In order to keep the Windows Registry clean and optimized,
it is recommended to run the Registry Cleaner monthly.
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● Registry Recovery can retrieve registry keys previously deleted from theWindows
Registry using BitDefender Registry Cleaner.

● File Shredder permanently erases files and their traces from your system.
● Performance Optimizer helps you identify the applications that are slowing down
your PC and close them when you need to improve system performance.

7.2.4. File Storage
In the File Storage tab, you can proactively protect your data by making backup
copies of the most important files. You can also store your sensitive files in encrypted
file vaults to prevent them from being accessed by someone else.
“Status Area” (p. 29)
“Quick Tasks” (p. 29)

Status Area
The current status of a component is indicated using explicit sentences and one of
the following icons:

Green circle with a check mark: No issues affect the component.
Red circle with an exclamation mark: Issues affect the component.
Blue circle with letter i: It is recommended that you run the task.

Just click the Fix button corresponding to a sentence to fix the reported issue.
To run a recommended task, click the corresponding Run Now button and follow
the wizard. For more information, please refer to “Backup” (p. 138).
To configure which components must be monitored:
1. Click Add/Edit List.
2. To turn on or off monitoring for a specific item, use the corresponding switch.
3. Click Close to save the changes and close the window.

Quick Tasks
The following buttons are available:
● Backup Locally - helps you make reserve copies of your valuable data on your
computer, a CD, network location or another hard drive, and to restore them if
necessary. Click the button and select the desired task from the menu. A wizard
guides you in performing this task.

● Add File to Vault - starts the wizard that allows you to store your important files
/ documents privately by encrypting them in special, vaulted drives.

● Remove Vault Files - starts the wizard that allows you to erase data from the
file vault.
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● View File Vault - starts the wizard that allows you to view the content of your
file vaults.

● Lock File Vault - starts the wizard that allows you to lock your vault in order to
start protecting its content.

For detailed information on backing up and restoring data, please refer to “Backup”
(p. 138). For detailed information on how to protect your files using file vaults, please
refer to “File Encryption” (p. 162).

7.2.5. Network
This is where you can perform various actions to configure and manage the
BitDefender products installed in your home network. In this way, you can manage
the security of your home network from a single computer.
For detailed information, please refer to “Home Network” (p. 187).

7.3. Expert View
Expert View gives you access to each specific component of BitDefender. This is
where you can configure BitDefender in detail.

Note
Expert View is suited for users having above average computer skills, who know the
type of threats a computer is exposed to and how security programs work.

On the left side of the window there is a menu containing all security modules. Each
module has one or more tabs where you can configure the corresponding security
settings or perform security or administrative tasks. The following list briefly
describes each module. For detailed information, please refer to the “Configuration
and Management” (p. 55) part of this user guide.
General

Allows you to access the general settings or to view the dashboard and detailed
system info.

Antivirus
Allows you to configure your virus shield and scanning operations in detail, to
set exceptions and to configure the quarantine module. This is were you can
also configure antiphishing protection and Search Advisor.

Antispam
Allows you to keep your Inbox SPAM-free and to configure the antispam settings
in detail.

Parental Control
Allows you to protect your children against inappropriate content by using your
customized computer access rules.
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Privacy Control
Allows you to prevent data theft from your computer and protect your privacy
while you are online.

Firewall
Allows you to protect your computer from inbound and outbound unauthorized
connection attempts. It is quite similar to a guard at your gate - it will keep a
watchful eye on your Internet connection and keep track of who to allow access
to the Internet and who to block.

Vulnerability
Allows you to keep crucial software on your PC up-to-date.

Backup
Allows you to back your data up on your computer, on removable disks or on
a network location to make sure you can restore them when necessary.

Encryption
Allows you to encrypt Yahoo and Windows Live (MSN) Messenger
communications and also to local encrypt your critical files, folders or partitions.

Tuneup
Allows you to improve the performance of your computer by defragmenting
your disk and cleaning up registries, duplicated file, etc.

Game/Laptop Mode
Allows you to postpone the BitDefender scheduled tasks while your laptop runs
on batteries and also to eliminate all alerts and pop-ups when you are playing.

Home Network
Allows you to configure and manage several computers in your household.

Update
Allows you to obtain info on the latest updates, to update the product and to
configure the update process in detail.

Registration
Allows you to register BitDefender Total Security 2011, to change the license
key or to create a BitDefender account.

The Options button in the upper-right corner of the window allows you to change
the user interface view mode and to configure the main program settings.
In the bottom-right corner of the window, you can find several useful links.

DescriptionLink
Opens a window where you can see current license key
information and register your product with a new license key.

License Info
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DescriptionLink
Allows you to see a detailed history of all tasks performed by
BitDefender on your system.

View Logs

Helps you purchase a license key for your BitDefender Total
Security 2011 product.

Buy/Renew

Click this link if you need help with BitDefender.Help and Support
Gives you access to a help file that shows you how to use
BitDefender.
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8. My Tools
When using BitDefender in Basic View or Intermediate View, you can customize
your dashboard by adding shortcuts to tasks and settings that are important to you.
This way, you can quickly gain access to features you use regularly and to advanced
settings without having to switch to a more advanced interface view mode.
Depending on the user interface view mode you use, the shortcuts added to My
Tools are available as follows:
Basic View

In the Protect Your PC area, click My Tools. A menu will appear. Click a shortcut
to launch the corresponding tool.

Intermediate View
The shortcuts appear under My Tools. Click a shortcut to launch the
corresponding tool.

To open the window from which you can select the shortcuts that will appear in My
Tools, proceed as follows:
Basic View

In the Protect Your PC area, click My Tools and choose More Options.
Intermediate View

Click one of the buttons under My Tools or the Configure My Tools link.
Use the switches to select the tools to be added to My Tools. You can select any of
the following categories of tools.
● Scan Tasks
Add the tasks you regularly use to scan your system for security threats.

DescriptionScan Task
Scans the entire system. In the default configuration,
it scans for all types of malware threatening your

Deep System Scan

system's security, such as viruses, spyware, adware,
rootkits and others.
Scans the entire system, except for archives. In the
default configuration, it scans for all types of
malware other than rootkits.

Full System Scan

Quick Scan uses in-the-cloud scanning to detect
malware running in your system. Running a Quick

Quick Scan

Scan usually takes less than a minute and uses a
fraction of the system resources needed by a regular
virus scan.

My Tools 33

BitDefender Total Security 2011



DescriptionScan Task
Starts a wizard that lets you create a custom scan
task.

Custom Scan

Use this task to scan important current user folders:
My Documents, Desktop and StartUp. This will

My Documents Scan

ensure the safety of your documents, a safe
workspace and clean applications running at startup.
Takes you to the Antivirus settings window where
you can customize the on-demand scan tasks.

Schedule My Scans

For more information about scan tasks, please refer to “Managing Existing Scan
Tasks” (p. 71)

● Tune-Up Tasks
Add the tasks you use regularly to improve the speed your system.

DescriptionTune-Up Task
Finds and deletes files that are duplicated in your
system.

Duplicate Finder

Identifies and deletes invalid or outdated references
in the Windows Registry.

Registry Cleaner

Removes the temporary Internet files and cookies,
unused system files and recent documents shortcuts.

PC Clean-Up

For more information about tune-up tasks, please refer to “Tune-Up” (p. 173)
● Backup Tasks
Add the tasks you regularly use to backup your data.

DescriptionBackup Task
Back your data up locally.Backup Locally
Restore your locally backed up data.Local Restore

For more information about backup tasks, please refer to “Backup” (p. 138)
● Settings
Add shortcuts to the BitDefender settings you want to configure:
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DescriptionSettings
Configure the Antivirus module. For more
information, please refer to “Antivirus Protection”
(p. 60)

Antivirus Settings

Configure the Firewall module. For more information,
please refer to “Firewall” (p. 123)

Configure Firewall

Configure the Parental Control module. For more
information, please refer to “Parental Control” (p.
99)

Parental Control

Toggle the GameMode. For more information, please
refer to “Game Mode” (p. 181)

Game Mode

Toggle the Laptop Mode. For more information,
please refer to “Laptop Mode” (p. 184)

Laptop Mode

Trigger an update of BitDefender. For more
information, please refer to “Update” (p. 191)

Update Now

Open a wizard that will help you fix all the security
issues affecting your system. For more information,
please refer to “Fixing Issues” (p. 42)

View & Fix All Issues

●Help & Support
Enter the support section. For more information, please refer to “Contact Us
Directly from Your BitDefender Product” (p. 238)
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9. Alerts and Pop-ups
BitDefender uses pop-ups and alerts to inform you about its operation or special
events that may interest you and to prompt you for action when needed. This chapter
presents the BitDefender pop-ups and alerts that you may encounter.
Pop-ups are small windows that temporarily appear on the screen to inform you
about various BitDefender events, such as e-mail scanning, a new computer that
logged to your wireless network, a firewall rule added etc. When pop-ups appear,
you will be required to click an OK button or a link, at the most.
Alerts are larger windows that prompt you for action or inform you about something
very important (for example, a virus has been detected). Besides alert windows,
you may receive e-mail, instant message or web page alerts.
The BitDefender pop-ups and alerts include:
● Antivirus Alerts
● Active Virus Control Alerts
● Device Detection Alerts
● Firewall Pop-ups and Alerts
● Antiphishing Alert Web Pages
● Parental Control Alert Messages
● Privacy Control Alerts

9.1. Antivirus Alerts
BitDefender protects you against various kinds of malware, such as viruses, spyware
or rootkits. When it detects a virus or other malware, BitDefender takes a specific
action on the infected file and informs you about it through an alert window.
You can see the virus name, the path to the infected file and the action taken by
BitDefender.
Click OK to close the window.

Important
When a virus is detected, it is best practice to scan the entire computer to make sure
there are no other viruses. For more information, please refer to “How Do I Scan Files
and Folders?” (p. 196).
If the virus has not been blocked, please refer to “Removing Malware from Your
System” (p. 228).

9.2. Active Virus Control Alerts
Active Virus Control can be configured to alert you and prompt you for action
whenever an application tries to perform a possible malicious action.
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If you are using the Basic View or Intermediate View interface, a pop-up will inform
you whenever Active Virus Control blocks a potentially harmful application. If you
are using Expert View, you will be prompted for action, through an alert window,
when an application exhibits malicious behavior.
If you know and trust the detected application, click Allow.
If you want to immediately close the application, click OK.
Select the Remember this action for this application check box before making
your choice and BitDefender will take the same action for the detected application
in the future. The rule that is thus created will be listed in the Active Virus Control
configuration window.

9.3. Device Detection Alerts
BitDefender automatically detects when you connect a removable storage device
to your computer and offers to scan it before you access its files. This is
recommended in order to prevent viruses and other malware from infecting your
computer.
Detected devices fall into one of these categories:
● CDs/DVDs
● USB storage devices, such as flash pens and external hard-drives
●mapped (remote) network drives
When such a device is detected, an alert window is displayed.
To scan the storage device, just click Yes. The Antivirus Scan wizard will appear
and guide you through the scanning process.
If you do not want to scan the device, you must click No. In this case, you may find
one of these options useful:
●Don't ask me again about this type of device - BitDefender will no longer
offer to scan storage devices of this type when they are connected to your
computer.

●Disable automatic device detection - You will no longer be prompted to scan
new storage devices when they are connected to the computer.

If you accidentally disabled automatic device detection and you want to enable it,
or if you want to configure its settings, follow these steps:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Antivirus>Virus Scan.
3. In the list of scan tasks, locate the Device Detection Scan task.
4. Right-click the task and select Open. A new window will appear.
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5. On the Overview tab, configure the scanning options as needed. For more
information, please refer to “Configuring Scan Settings” (p. 74).

6. On the Detection tab, choose which types of storage devices to be detected.
7. Click OK to save and apply the changes.

9.4. Firewall Pop-ups and Alerts
The firewall uses pop-ups to inform you about various events related to your network
connection (for example, when a new computer connects to your Wi-Fi network,
when a new application is allowed to access the Internet or when a port scan is
blocked). These pop-ups may be very useful in detecting intrusion attempts and
protecting yourself against network threats.
If you are using Expert View, you will be prompted for action, through an alert
window, whenever an unknown application tries to connect to the Internet.
You can see the following: the application that is trying to access the Internet, the
path to the application file, the destination, the protocol used and the port on which
the application is trying to connect.
Click Allow to allow all traffic (inbound and outbound) generated by this application
from the local host to any destination, over the respective IP protocol and on all
ports. If you click Block, the application will be denied access to the Internet over
the respective IP protocol completely.

Important
Allow inbound connection attempts only from IPs or domains you are sure to trust.

Based on your answer, a rule will be created, applied and listed in the table. The
next time the application tries to connect, this rule will be applied by default.
If you are using Basic View or Intermediate View, the connection attempt will be
automatically blocked.

9.5. Antiphishing Alerts
With antiphishing protection enabled, BitDefender alerts you when you try to access
web pages that may be set up to steal personal information. Before you can access
such a web page, BitDefender will block that page and display a generic web page
alert instead.
Check the web page address in the address bar of your browser. Look for clues that
might indicate that the web page is used for phishing. If the web address is
suspicious, it is recommended that you do not open it.
Here are some tips you may find useful:
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● If you have typed the address of a legitimate website, check if the address is
correct. If the address is incorrect, re-type it and go to the web page again.

● If you have clicked a link in an e-mail or an instant message, verify who sent it
to you. If the sender is unknown, this is probably a phishing attempt. If you know
the sender, you should check if that person really sent you the link.

● If you reached the web page by browsing the Internet, check the web page where
you found the link (click the Back button on your web browser).

If you want to view the web page, click the appropriate link to take one of these
actions:
● View the web page this time only. There is no risk as long as you do not
submit any information on the web page. If the web page is legitimate, you can
add it to the White List (click the BitDefender Antiphishing toolbar and select Add
to White List).

● Add the web page to the White List. The web page will be displayed
immediately and BitDefender will no longer alert you about it.

Important
Add to the White List only the web pages that you fully trust (for example, your
bank's web address, known online shops, etc). BitDefender does not check for
phishing the web pages in the White List.

You can manage antiphishing protection and the White List using the BitDefender
toolbar in your web browser. For more information, please refer to “Managing the
BitDefender Antiphishing Protection in Internet Explorer and Firefox” (p. 83).

9.6. Parental Control Alert Messages
You can configure Parental Control to block:
● inappropriate web pages.
● Internet access, for specific periods of time (such as when it's time for lessons).
● web pages, e-mail messages and instant messages if they contain specific
keywords.

● applications like games, chat, filesharing programs or others.
● instant messages sent by IM contacts other than those allowed.
The user is informed whenever an activity is blocked through a specific alert message
(for example, a standard alert web page, e-mail or instant message). Detailed
information is provided so that the user can find out why the activity was blocked.
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9.7. Privacy Control Alerts
Privacy Control provides advanced users with some extra features to protect their
privacy. You will be prompted for action through specific alert windows if you choose
to enable any of these components:
● Registry Control - asks for your permission whenever a program tries to modify
a registry entry in order to be executed at Windows start-up.

● Cookie Control - asks for your permission whenever a new website tries to set a
cookie.

● Script Control - asks for your permission whenever a website tries to activate a
script or other active content.

9.7.1. Registry Alerts
If you enable Registry Control, you will be prompted for permission whenever a new
program tries to modify a registry entry in order to be executed at Windows start-up.
You can see the program that is trying to modify Windows Registry.

Note
BitDefender will usually alert you when you install new programs that need to run
after the next startup of your computer. In most cases, these programs are legitimate
and can be trusted.

If you do not recognize the program and if it seems suspicious, click Block to prevent
it from modifying Windows Registry. Otherwise, click Allow to permit the
modification.
Based on your answer, a rule is created and listed in the rules table. The same action
is applied whenever this program tries to modify a registry entry.
For more information, please refer to “Registry Control” (p. 119).

9.7.2. Script Alerts
If you enable Script Control, you will be prompted for permission whenever a new
web site tries to run a script or other active content.
You can see the name of the resource.
Click Yes or No and a rule will be created, applied and listed in the rules table. The
same action will be applied automatically whenever the respective site tries to run
active content.

Note
Some web pages may not be properly displayed if you block active content.
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For more information, please refer to “Script Control” (p. 121).

9.7.3. Cookie Alerts
If you enable Cookie Control, you will be prompted for permission whenever a new
web site tries to set or request a cookie.
You can see the name of the application that is trying to send the cookie file.
Click Yes or No and a rule will be created, applied and listed in the rules table. The
same action will be applied automatically whenever you connect to the respective
site.
For more information, please refer to “Cookie Control” (p. 119).
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10. Fixing Issues
BitDefender uses an issue tracking system to detect and inform you about the issues
that may affect the security of your computer and data. By default, it will monitor
only a series of issues that are considered to be very important. However, you can
configure it as needed, choosing which specific issues you want to be notified about.
This is how pending issues are notified:
● A special symbol is displayed over the BitDefender icon in the system tray to
indicate pending issues. Also, if you move the mouse cursor over the icon, a
pop-up will confirm the existence of pending issues.

●When you open BitDefender, the Security Status area will indicate the number of
issues affecting your system.
▶ In Basic View, the security status is displayed on the left side of the window.
▶ In Expert View, go to General > Dashboard to check the security status.

10.1. Fix Issues Wizzard
The easiest way to fix the existing issues is to follow the Fix Issues Wizard. To
open the wizard, do any of the following:
● Right-click the BitDefender icon in the system tray and select Fix All Issues.
● Open BitDefender and, depending on the user interface view mode, proceed as
follows:
▶ In Basic View, click View All Issues.
▶ In Expert View, go to General > Dashboard and click View All Issues.

Note
You can also add a shortcut to My Tools.

A list of existing security threats on your computer is displayed.
All current issues are selected to be fixed. If there is an issue that you do not want
to be fixed, just clear the corresponding check box. If you do so, its status will change
to Skip.

Note
If you do not want to be notified about specific issues, you must configure the alert
system accordingly, as described in the next section.

To fix the selected issues, click Start. Some issues are fixed immediately. For others,
a wizard helps you fix them.
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The issues that this wizard helps you fix can be grouped into these main categories:
●Disabled security settings. Such issues are fixed immediately, by enabling
the respective security settings.

● Preventive security tasks you need to perform. An example of such a task
is scanning your computer. It is recommended that you scan your computer at
least once a week. BitDefender will automatically do that for you in most cases.
However, if you have changed the scanning schedule or if the schedule is not
completed, you will be notified about this issue.
When fixing such issues, a wizard helps you successfully complete the task.

● System vulnerabilities. BitDefender automatically checks your system for
vulnerabilities and alerts you about them. System vulnerabilities include the
following:
▶ weak passwords to Windows user accounts.
▶ outdated software on your computer.
▶ missing Windows updates.
▶ Windows Automatic Updates is disabled.
When such issues are to be fixed, the vulnerability scan wizard is started. This
wizard assists you in fixing the detected system vulnerabilities. For detailed
information, please refer to section “Checking for Vulnerabilities” (p. 135).

10.2. Configuring Status Alerts
The status alert system is pre-configured to monitor and alert you about the most
important issues that may affect the security of your computer and data. Besides
the issues monitored by default, there are several other issues you can be informed
about.
You can configure the alert system to best serve your security needs by choosing
which specific issues to be informed about. You can do this either in Intermediate
View or in Expert View.
● In Intermediate View, the alert system can be configured from separate locations.
Follow these steps:
1. Go to the Security, Tune-up or File Storage tab.
2. Click the Add/Edit List link in the Status area.
3. Use the switch corresponding to an item to change its alert state.

● In Expert View, the alert system can be configured from a central location. Follow
these steps:
1. Go to General > Dashboard.
2. Click Add/Edit Alerts.
3. Use the switch corresponding to an item to change its alert state.
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11. Configuring Main Settings
You can configure the main product settings (including reconfiguring the usage
profile) from the Preferences window. To open it, do any of the following:
● Open BitDefender, click Options in the upper-right corner of the window and
choose Preferences.

● Right-click the BitDefender icon in the system tray and select Preferences.

Note
To configure the product settings in detail, use the Expert View interface. For detailed
information, please refer to the “Configuration and Management” (p. 55) part of this
user guide.

The settings are organized into three categories:
● Security Settings
● Alerts Settings
● General Settings
To turn on or off a setting, use the corresponding switch.
To apply and save the configuration changes you make, click OK. To close the
window without saving the changes, click Cancel.
The Reconfigure Profile link in the upper-right corner of the window allows you
to reconfigure the usage profile. For more information, please refer to “Reconfiguring
the Usage Profile” (p. 48).

11.1. Security Settings
In this area, you can enable or disable product settings that cover various aspects
of computer and data security. To turn on or off a setting, use the corresponding
switch.

Warning
Use caution when disabling real-time antivirus protection, firewall or automatic update.
Disabling these features may compromise your computer's security. If you really
need to disable them, remember to re-enable them as soon as possible.

These are the available settings:
Antivirus

Real-time protection ensures that all files are scanned as they are accessed by
you or by an application running on this system.
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Automatic Update
Automatic update ensures that the newest BitDefender product and signature
files are downloaded and installed automatically, on a regular basis. Updates
are performed by default every hour.

Vulnerability Scan
Automatic Vulnerability Scan alerts you about and helps you fix vulnerabilities
in your system that might affect its security. Such vulnerabilities include
outdated software, weak passwords to user accounts or missing Windows
updates.

Antispam
Antispam filters the e-mail messages that you receive, marking unsolicited and
junk mail as SPAM.

Antiphishing
Antiphishing detects and alerts you in real-time if a web page is set up to steal
personal information.

Search Advisor
Search Advisor scans the links in your search results and informs you which of
them are safe and which are not.

Identity Control
Identity Control helps you prevent your personal data from being sent out on
the Internet without your consent. It blocks any instant messages, e-mail
messages or web forms transmitting data you defined as being private to
unauthorized recipients (addresses).

Chat Encryption
Chat Encryption secures your conversations via Yahoo! Messenger andWindows
Live Messenger provided that your IM contacts use a compatible BitDefender
product and IM software.

Parental Control (current user)
Parental Control restricts the computer and online activities of your children
based on the rules you defined. Restrictions may include blocking inappropriate
web sites, as well as limiting gaming and Internet access according to a specified
schedule.

Firewall
Firewall protects your computer from hacker and malicious outside attacks.

File Encryption
File Encryption keeps your documents private by encrypting them in special
vaulted drives. If you disable File Encryption, all file vaults will be locked and
you will no longer be able to access the files they contain.
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The status of some of these settings may be monitored by the BitDefender issue
tracking system. If you disable a monitored setting, BitDefender will indicate this
as an issue that you need to fix.
If you do not want a monitored setting that you disabled to be shown as an issue,
you must configure the tracking system accordingly. You can do that either in
Intermediate View or in Expert View. For detailed information, please refer to
“Configuring Status Alerts” (p. 43).

11.2. Alerts Settings
In this area, you can turn off the BitDefender pop-ups and alerts. BitDefender uses
alerts to prompt you for action and pop-ups to inform you about actions it has taken
automatically or about other events. To turn on or off a category of alerts, use the
corresponding switch.

Important
Most of these alerts and pop-ups should be kept turned on in order to avoid potential
problems.

These are the available settings:
Antivirus Alerts

Antivirus alerts inform you when BitDefender detects and blocks a virus. When
a virus is detected, it is best practice to scan the entire computer to make sure
there are no other viruses.

Active Virus Control Pop-ups
If you are using the Basic View or Intermediate View interface, a pop-up will
inform you whenever Active Virus Control blocks a potentially harmful
application. If you are using Expert View, you will be prompted for action,
through an alert window, when an application exhibits malicious behavior.

Scan Email Pop-ups
These pop-ups are displayed to inform you that BitDefender is scanning e-mails
for malware.

Home Network Management Alerts
These alerts inform the user when administrative actions are being performed
remotely.

Firewall Pop-ups
The firewall uses pop-ups to inform you about various events related to your
network connection (for example, when a new computer connects to your Wi-Fi
network, when a new application is allowed to access the Internet or when a
port scan is blocked). If you are using Expert View, you will be prompted for
action, through an alert window, whenever an unknown application tries to
connect to the Internet.
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These pop-upsmay be very useful in detecting intrusion attempts and protecting
yourself against network threats.

Quarantine Alerts
Quarantine alerts inform you when old quarantined files have been deleted.

Parental Control Alerts
Whenever Parental Control blocks an activity, an alert is displayed to inform
the user why the activity is being blocked (for example, an alert web page is
displayed instead of a blocked web page).

Registration Pop-ups
Registration pop-ups are used to remind you that you need to register
BitDefender or to inform you that the license key is about to or has already
expired.

11.3. General Settings
In this area, you can enable or disable settings that affect product behavior and
user experience. To turn on or off a setting, use the corresponding switch.
These are the available settings:
Game Mode

Game Mode temporarily modifies protection settings so as to minimize their
impact on system performance during games.

Laptop Mode Detection
Laptop Mode temporarily modifies protection settings so as to minimize their
impact on the life of your laptop battery.

Settings Password
To prevent someone else from changing the BitDefender settings, you can
protect them with a password. When you enable this option, you will be
prompted to configure the settings password. Type the desired password in
both fields and click OK to set the password.

BitDefender News
By enabling this option, you will receive important company news, product
updates or new security threats from BitDefender.

Product Notification Alerts
By enabling this option, you will receive information alerts.

Scan Activity Bar
The Scan Activity Bar is a small, transparent window indicating the progress of
the BitDefender scanning activity.

Send Virus Reports
By enabling this option, virus scanning reports are sent to BitDefender labs for
analysis. Please note that these reports will contain no confidential data, such
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as your name or IP address, and that they will not be used for commercial
purposes.

Outbreak Detection
By enabling this option, reports regarding potential virus-outbreaks are sent to
BitDefender labs for analysis. Please note that these reports will contain no
confidential data, such as your name or IP address, and that they will not be
used for commercial purposes.

11.4. Reconfiguring the Usage Profile
During installation, you were able to configure a usage profile. The usage profile
reflects the main activities performed on the computer. Depending on the usage
profile, the product interface is organized to allow easy access to your preferred
tasks.
To reconfigure the usage profile, click Reconfigure Profile and follow the
configuration wizard. You can navigate through the wizard using theNext and Back
buttons. To exit the wizard, click Cancel.
1. Choose Your View

Select the preferred user interface view.
2. Configure My Tools

If you have selected Basic View or Intermediate View, choose the features you
would like to create shortcuts to on the Dashboard.

3. Configure Settings
If you have selected Expert View, configure the BitDefender settings as needed.
To turn on or off a setting, use the corresponding switch.

4. Set Up Parental Control

Note
This step appears only if you have added Parental Control to My Tools.

You can select one of three options:
● Set Parental Control on children accounts
Select this option to enable Parental Control on the Windows accounts created
for your children and manage it from the administrative account.

● Set Parental Control on current account
Select this option to enable Parental Control on the current Windows account.
This means you will not have to create separate accounts for your children,
but Parental Control rules will affect everyone using the current account.
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In this case, a password is required to protect the Parental Control settings.
You can set it now or at a later time from the BitDefender window.

● Skip setup for now
Select this option to configure this feature at a later time from the BitDefender
window.

5. Home Network Management

Note
This step appears only if you have added Home Network Management to My Tools.

You can select one of three options:
● Set up this PC as "Server"
Select this option if you intend to manage BitDefender products on other
computers in the home network from this one.
A password is required to join the network. Enter the password in the provided
text boxes and click Submit.

● Set up this PC as "Client"
Select this option if BitDefender will be managed from another computer in
the home network which is also running BitDefender.
A password is required to join the network. Enter the password in the provided
text boxes and clickSubmit.

● Skip setup for now
Select this option to configure this feature at a later time from the BitDefender
window.

6. Setup Complete
Click Finish.
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12. History and Events
The View Logs link at the bottom of the BitDefender main window opens another
window with the BitDefender history & events. This window offers you an overview
of the security-related events. For instance, you can easily check if the update was
successfully performed, if malware was found on your computer, if your backup
tasks run without error, etc.
In order to help you filter the BitDefender history & events, the following categories
are provided on the left side:
●Dashboard
● Antivirus
● Antispam
● Parental Control
● Privacy Control
● Firewall
● Vulnerability
● Backup
● Chat encryption
● File Encryption
● Tune-Up
●Game/Laptop Mode
●Home Network
●Update
● Registration
● Internet Log
A list of events is available for each category. Each event comes with the following
information: a short description, the action BitDefender took on it when it happened,
and the date and time when it occurred. If you want to find out more information
about a particular event in the list, double-click that event.
This is also where you can view detailed information and statistics regarding Parental
Control events such as websites accessed or applications used by your children.
Click Clear all logs if you want to remove old logs or Refresh to make sure the
latest logs are displayed.
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13. Registration and My Account
Registration is a two-step process:
1. Product activation (registration of a BitDefender account). You must

create a BitDefender account in order to receive updates and to have access to
free technical support. If you already have a BitDefender account, register your
BitDefender product to that account. BitDefender will notify you that you need
to activate your product and it will help you fix this issue.

Important
You must create an account within 15 days after installing BitDefender. Otherwise,
BitDefender will no longer update.

2. Registration with a license key. The license key specifies how long you are
entitled to use the product. As soon as the license key expires, BitDefender stops
performing its functions and protecting your computer. You should purchase a
license key or renew your license a few days before the current license key
expires.

If you purchased BitDefender Total Security 2011 on a CD/DVD or online, you were
prompted to register your product with a license key during the installation.
If you downloaded BitDefender Total Security 2011 for evaluation, you must register
the product with a license key to continue using it after the 30-day trial period.
During the trial period, the product is fully functional and you can test it to see if it
meets your expectations.

13.1. Registering BitDefender Total Security 2011
If you want to register the product with a license key or to change the current license
key, click the License Info link, located at the bottom of the BitDefender window.
The product registration window will appear.
You can see the BitDefender registration status, the current license key and how
many days are left until the license expires.
To register BitDefender Total Security 2011:
1. Type the license key in the edit field.

Note
You can find your license key:
● on the CD label.
● on the product registration card.
● in the online purchase e-mail.
If you do not have a BitDefender license key, click the provided link to start a
wizard that will help you buy one.
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2. Click Register Now.
3. Click Finish.

13.2. Activating BitDefender
To activate BitDefender, you must create or sign in to a BitDefender account. If you
did not register a BitDefender account during the installation wizard, you can do
that as follows:
Basic View

Click View All Issues. The wizard will help you fix all pending issues, including
activating the product.

Intermediate View
Go to the Security tab and click the View & Fix button corresponding to the
issue regarding the product update. Click Start in the wizard window to activate
the product.

Expert View
Go to Registration and click the Activate Product button.

The account registration window will open. This is where you can create or sign in
into a BitDefender account to activate your product.
If you do not want to create a BitDefender account at the moment, select Create
Account Later and click Finish. Otherwise, proceed according to your current
situation:
● “I do not have a BitDefender account” (p. 52)
● “I already have a BitDefender account” (p. 53)

Important
You must create an account within 15 days after installing BitDefender. Otherwise,
BitDefender will no longer update.

I do not have a BitDefender account
To successfully create a BitDefender account, follow these steps:
1. Select Create New Account.
2. Type the required information in the corresponding fields. The data you provide

here will remain confidential.
●Username - type in your e-mail address.
● Password - type in a password for your BitDefender account. The password
must be between 6 and 16 characters long.

● Retype password - type in again the previously specified password.
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You do not have to retype the password if you selected not to mask the
password while typing it.

● Password hint - enter a word or phrase that will help you remember the
password should you forget it.

Note
Once the account is activated, you can use the provided e-mail address and
password to log in to your account at http://myaccount.bitdefender.com.

3. Optionally, BitDefender can inform you about special offers and promotions using
the e-mail address of your account. Click View Contact Options and select one
of the available options in the window that appears.
● Send me all messages
● Send me important messages
●Do not send me any messages

4. Click Submit.
5. Click Finish to close the window.

Note
Before being able to use your account, you must activate it.
Check your e-mail and follow the instructions in the e-mail message sent to you
by the BitDefender registration service.

I already have a BitDefender account
BitDefender will automatically detect if you have previously registered a BitDefender
account on your computer. In this case, provide the password of your account and
click Submit. Click Finish to close the window.
If you already have an active account, but BitDefender does not detect it, follow
these steps to register the product to that account:
1. Select Sign in (Prev. Account).
2. Type the e-mail address and the password of your account in the corresponding

fields.

Note
If you have forgotten your password, click Forgot your password? and follow
the instructions.

3. Optionally, BitDefender can inform you about special offers and promotions using
the e-mail address of your account. Click View Contact Options and select one
of the available options in the window that appears.
● Send me all messages
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● Send me important messages
●Do not send me any messages

4. Click Submit.
5. Click Finish to close the window.

13.3. Buying or Renewing License Keys
If the trial period is going to end soon, you must purchase a license key and register
your product.
Similarly, if your current license key is going to expire soon, you must renew your
license. As a BitDefender customer, you are eligible for a discount when renewing
the license of your BitDefender product. You may also upgrade your product to the
current version at a special discount or free of charge.
To start a simple and secure four-step procedure that will allow you to purchase a
new key or renew an existing one, open BitDefender in Intermediate View or Expert
View and click the Buy / Renew link located at the bottom of the window.
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14. General Settings
The General module provides information on the BitDefender activity and the system.
Here you can also change the overall behavior of BitDefender.
To configure the general settings:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to General > Settings.
● Enable password protection for product settings - enables setting a password
in order to protect the BitDefender configuration.

Note
If you are not the only person with administrative rights using this computer, it is
recommended that you protect your BitDefender settings with a password.

Type the password in the Password field, re-type it in the Retype password
field and click OK.
Once you have set the password, you will be asked for it whenever you want to
change the BitDefender settings. The other system administrators (if any) will
also have to provide this password in order to change the BitDefender settings.
If you want to be prompted for the password only when configuring Parental
Control, you must also select Apply password protection to parental control
settings only. On the other hand, if a password was set only for Parental Control
and you uncheck this option, the respective password will be requested when
configuring any BitDefender option.

Important
If you forgot the password you will have to repair the product in order to modify
the BitDefender configuration.

● Ask me if I want to create a password when I enable Parental Control -
prompts you to configure a password when you want to enable Parental Control
and no password is set. By setting a password, you will prevent other users with
administrative rights from changing the Parental Control settings that you
configured for a specific user.

● Show BitDefender News (security related notifications) - shows from time
to time security notifications regarding virus outbreaks, sent by the BitDefender
server.

● Show pop-ups (on-screen notes) - shows pop-up windows regarding the product
status. You can configure BitDefender to display pop-ups only when the interface
is in Basic / Intermediate View or in Expert View.

General Settings 56

BitDefender Total Security 2011



● Show the Scan Activity bar (on screen graph of product activity) - displays
the Scan Activity bar whenever you log on to Windows. Clear this check box if
you do not want the Scan Activity bar to be displayed anymore.

Note
This option can be configured only for the current Windows user account. The Scan
activity bar is only available when the interface is in Expert View.

Virus Report Settings
● Send virus reports - sends to the BitDefender Labs reports regarding viruses
identified in your computer. It helps us keep track of virus-outbreaks.
The reports will contain no confidential data, such as your name, IP address or
others, and will not be used for commercial purposes. The information supplied
will contain only the virus name and will be used solely to create statistic reports.

● Enable BitDefender Outbreak Detection - sends to the BitDefender Labs
reports regarding potential virus-outbreaks.
The reports will contain no confidential data, such as your name, IP address or
others, and will not be used for commercial purposes. The information supplied
will contain only the potential virus and will be used solely to detect new viruses.

Connection Settings
Several BitDefender components (the Firewall, LiveUpdate, Real-Time Virus Reporting
and Real-Time Spam Reporting modules) require access to the Internet. BitDefender
comes with a proxy manager that allows configuring from one location the proxy
settings used by the BitDefender components to access the Internet.
If your company uses a proxy server to connect to the Internet, you must specify
the proxy settings in order for BitDefender to update itself. Otherwise, it will use
the proxy settings of the administrator that installed the product or of the current
user's default browser, if any. For more information, please refer to “How Do I Find
Out My Proxy Settings?” (p. 244).

Note
The proxy settings can be configured only by users with administrative rights on the
computer or by power users (users who know the password to the product settings).

To manage the proxy settings, click Proxy Settings.
There are three sets of proxy settings:
● Proxy Detected at Install Time - proxy settings detected on the administrator’s
account during installation and which can be configured only if you are logged
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on to that account. If the proxy server requires a username and a password, you
must specify them in the corresponding fields.

●Default Browser Proxy - proxy settings of the current user, extracted from the
default browser. If the proxy server requires a username and a password, you
must specify them in the corresponding fields.

Note
The supported web browsers are Internet Explorer, Mozilla Firefox and Opera. If
you use another browser by default, BitDefender will not be able to obtain the
proxy settings of the current user.

● Custom Proxy - proxy settings that you can configure if you are logged in as an
administrator.
The following settings must be specified:
▶ Address - type in the IP of the proxy server.
▶ Port - type in the port BitDefender uses to connect to the proxy server.
▶ Username - type in a user name recognized by the proxy.
▶ Password - type in the valid password of the previously specified user.

BitDefender will use the proxy settings sets in the following order until it manages
to connect to the Internet:
1. the specified proxy settings.
2. the proxy settings detected at install time.
3. the proxy settings of the current user.
When trying to connect to the Internet, each set of proxy settings is tried at a time,
until BitDefender manages to connect.
First, the set containing your own proxy settings will be used to connect to the
Internet. If it does not work, the proxy settings detected at installation time will be
tried next. Finally, if those do not work either, the proxy settings of the current user
will be taken from the default browser and used to connect to the Internet.
Click OK to save the changes and close the window.
Click Apply to save the changes or click Default to load the default settings.

System Information
BitDefender allows you to view, from a single location, all system settings and the
applications registered to run at startup. In this way, you can monitor the activity
of the system and of the applications installed on it as well as identify possible
system infections.
To obtain system information:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
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2. Go to General > System Info.
The list contains all the items loaded when starting the system as well as the items
loaded by different applications.
Three buttons are available:
● Restore - changes a current file association to default. Available for the File
Associations settings only!

●Go to - opens a window where the selected item is placed (the Registry for
example).

Note
Depending on the selected item, the Go to button may not appear.

● Refresh - re-opens the System Info section.
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15. Antivirus Protection
BitDefender protects your computer from all kinds of malware (viruses, Trojans,
spyware, rootkits and so on). The protection BitDefender offers is divided into two
categories:
● Real-time protection - prevents new malware threats from entering your system.
BitDefender will, for example, scan a word document for known threats when you
open it, and an e-mail message when you receive one.
Real-time protection is also referred to as on-access scanning - files are scanned
as the users access them.

Important
To prevent viruses from infecting your computer keep Real-time protection
enabled.

●On-demand scanning - allows detecting and removing the malware that already
resides in the system. This is the classic scan initiated by the user - you choose
what drive, folder or file BitDefender should scan, and BitDefender scans it -
on-demand. The scan tasks allow you to create customized scanning routines and
they can be scheduled to run on a regular basis.

When it detects a virus or other malware, BitDefender will automatically attempt
to remove the malware code from the infected file and reconstruct the original file.
This operation is referred to as disinfection. Files that cannot be disinfected are
moved to quarantine in order to contain the infection. For more information, please
refer to “Quarantine Area” (p. 81).
If your computer has been infected with malware, please refer to “Removing Malware
from Your System” (p. 228).
Advanced users can configure scan exclusions if they do not want specific files to
be scanned. For more information, please refer to “Configuring Scan Exclusions”
(p. 77).

15.1. Real-time Protection
BitDefender provides continuous, real-time protection against a wide range of
malware threats by scanning all accessed files, e-mail messages and the
communications through Instant Messaging Software applications (ICQ, NetMeeting,
Yahoo Messenger, MSN Messenger).
The default real-time protection settings ensure good protection against malware,
with minor impact on system performance. You can easily change the real-time
protection settings according to your needs by switching to one of the predefined
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protection levels. Or, if you are an advanced user, you can configure the scan settings
in detail by creating a custom protection level.
To learn more, please refer to these topics:
● “Adjusting the Real-time Protection Level” (p. 61)
● “Creating a Custom Protection Level” (p. 62)
● “Changing the Actions Taken on Detected Files” (p. 63)
● “Restoring the Default Settings” (p. 64)
To protect you against unknown malicious applications, BitDefender uses an
advanced heuristic technology (Active Virus Control) and an Intrusion Detection
System, which continuously monitor your system. To learn more, please refer to
these topics:
● “Configuring Active Virus Control” (p. 64)
● “Configuring the Intrusion Detection System” (p. 66)

15.1.1. Adjusting the Real-time Protection Level
The real-time protection level defines the scan settings for real-time protection. You
can easily change the real-time protection settings according to your needs by
switching to one of the predefined protection levels.
To adjust the real-time protection level:
1. Open BitDefender.
2. Depending on the user interface view mode, proceed as follows:

Intermediate View
Go to the Security tab and click Configure Antivirus in the Quick Tasks
area on the left side of the window.
Go to the Shield tab.

Expert View
Go to Antivirus > Shield.

Note
In Basic View and Intermediate View, you can configure a shortcut so that you can
access these settings from your dashboard. For more information, please refer to
“My Tools” (p. 33).

3. Drag the slider along the scale to set the desired protection level. Use the
description on the right side of the scale to choose the protection level that better
fits your security needs.
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15.1.2. Creating a Custom Protection Level
Advanced users might want to take advantage of the scan settings BitDefender
offers. The scanner can be set to scan only specific file extensions, to search for
specific malware threats or to skip archives. This may greatly reduce scanning times
and improve your computer's responsiveness during a scan.
You can configure the real-time protection settings in detail by creating a custom
protection level. To create a custom protection level:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Antivirus > Shield.
3. Click Custom Level.
4. Configure the scan settings as needed. To find out what an option does, keep

the mouse over it and read the description displayed at the bottom of the window.
5. Click OK to save the changes and close the window.
You may find this information useful:
● If you are not familiar with some of the terms, check them in the glossary. You
can also find useful information by searching the Internet.

● Scan accessed files. You can set BitDefender to scan all accessed files,
applications (program files) only or specific file types you consider to be dangerous.
Scanning all accessed files provides best protection, while scanning applications
only can be used for better system performance.
Applications (or program files) are far more vulnerable to malware attacks than
other types of files. This category includes the following file extensions: .exe;
.bat; .com; .dll; .ocx; .scr; .bin; .dat; .386; .vxd; .sys; .wdm; .cla;
.class; .ovl; .ole; .exe; .hlp; .doc; .dot; .xls; .ppt; .wbk; .wiz; .pot;
.ppa; .xla; .xlt; .vbs; .vbe; .mdb; .rtf; .htm; .hta; .html; .xml; .xtp;
.php; .asp; .js; .shs; .chm; .lnk; .pif; .prc; .url; .smm; .pdf; .msi;
.ini; .csc; .cmd; .bas; .eml; .nws.
If you opt for Scan user defined extensions, it is recommended that you include
all application extensions beside other file extensions you consider to be
dangerous.

● Scan only new and changed files. By scanning only new and changed files,
you may greatly improve overall system responsiveness with a minimum trade-off
in security.

● Scan inside archives. Scanning inside archives is a slow and resource-intensive
process, which is therefore not recommended for real-time protection. Archives
containing infected files are not an immediate threat to the security of your
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system. The malware can affect your system only if the infected file is extracted
from the archive and executed without having real-time protection enabled.

● Action options. If you consider changing the actions taken on detected files,
check for tips in “Changing the Actions Taken on Detected Files” (p. 63).

● Scan options for e-mail, web and instant messaging traffic. To prevent
malware from being downloaded to your computer, BitDefender automatically
scans the following malware entry points:
▶ incoming e-mails
▶ web traffic
▶ files received via Yahoo! Messenger and Windows Live Messenger
Scanning the web traffic may slow down web browsing a little, but it will block
malware coming from the Internet, including drive-by downloads.
Though not recommended, you can disable e-mail, web or instant messaging
antivirus scan to increase system performance. If you disable the corresponding
scan options, the e-mails and files received or downloaded from the Internet will
not be scanned, thus allowing infected files to be saved to your computer. This
is not a major threat because real-time protection will block the malware when
the infected files are accessed (opened, moved, copied or executed).

15.1.3. Changing the Actions Taken on Detected Files
Files detected by real-time protection are grouped into two categories:
● Infected files. Files detected as infected match a malware signature in the
BitDefender Malware Signature Database. BitDefender can normally remove the
malware code from an infected file and reconstruct the original file. This operation
is known as disinfection.

Note
Malware signatures are snippets of code extracted from actual malware samples.
They are used by antivirus programs to perform pattern-matching and detect
malware.
The BitDefender Malware Signature Database is a collection of malware signatures
updated hourly by the BitDefender malware researchers.

● Suspicious files. Files are detected as suspicious by the heuristic analysis.
Suspicious files cannot be disinfected, because no disinfection routine is available.

Depending on the type of detected file, the following actions are taken automatically:
● If an infected file is detected, BitDefender will automatically attempt to disinfect
it. If disinfection fails, the file is moved to quarantine in order to contain the
infection.
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Important
For particular types of malware, disinfection is not possible because the detected
file is entirely malicious. In such cases, the infected file is deleted from the disk.

● If a suspicious file is detected, access to that file will be denied to prevent a
potential infection.

You should not change the default actions taken on detected files unless you have
a strong reason to do so.
To change the default actions taken on the infected or suspicious files detected:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Antivirus > Shield.
3. Click Custom Level.
4. Configure the actions to be taken on each category of detected files, as needed.

The second action is taken if the first one fails (for example, if disinfection is not
possible, the infected file is moved to quarantine).

15.1.4. Restoring the Default Settings
The default real-time protection settings ensure good protection against malware,
with minor impact on system performance.
To restore the default real-time protection settings:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Antivirus > Shield.
3. Click Default Level.

15.1.5. Configuring Active Virus Control
The BitDefender Active Virus Control detects potentially harmful applications based
on their behavior.
Active Virus Control continuously monitors the applications running on the computer,
looking for malware-like actions. Each of these actions is scored and an overall score
is computed for each process. When the overall score for a process reaches a given
threshold, the process is considered to be harmful. Depending on the program
settings, the process is blocked automatically or you may prompted to specify the
action to be taken.
Active Virus Control can be configured to alert you and prompt you for action
whenever an application tries to perform a possible malicious action.
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If you know and trust the detected application, click Allow.
If you want to immediately close the application, click OK.
Select the Remember this action for this application check box before making
your choice and BitDefender will take the same action for the detected application
in the future. The rule that is thus created will be listed in the Active Virus Control
configuration window.
To configure Active Virus Control:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Antivirus > Shield.
3. Click Advanced Settings.
4. Go to the AVC tab.
5. Select the corresponding check box to enable Active Virus Control.
6. Drag the slider along the scale to set the desired protection level. Use the

description on the right side of the scale to choose the protection level that better
fits your security needs.

Adjusting the Aggressiveness Level
To configure the Active Virus Control protection level:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Antivirus > Shield.
3. Click Advanced Settings.
4. Go to the AVC tab.
5. Drag the slider along the scale to set the desired protection level. Use the

description on the right side of the scale to choose the protection level that better
fits your security needs.

Configuring the Response to Malicious Behavior
If an application exhibits malicious behavior, you will be prompted whether to allow
or block it.
To configure the response to malicious behavior:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Antivirus > Shield.
3. Click Advanced Settings.
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4. Go to the AVC tab.
5. If you want to be prompted for action when Active Virus Control detects a

potentially harmful application, select the Alert me before taking an action
check box. To automatically block an application that exhibits malicious behavior
(without displaying an alert window), clear this check box.

Managing Trusted / Untrusted Applications
You can add applications you know and trust to the list of trusted applications. These
applications will no longer be checked by the BitDefender Active Virus Control and
will automatically be allowed access.
To manage the applications that are not being monitored by Active Virus Control:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Antivirus > Shield.
3. Click Advanced Settings.
4. Go to the AVC tab.
5. Click the Exclusions tab.
The applications for which rules have been created are listed in the Exclusions
table. The path to the application and the action you have set for it (Allowed or
Blocked) is displayed for each rule.
To change the action for an application, click the current action and select the other
action from the menu.
To manage the list, use the buttons placed above the table:
Add - add a new application to the list.
Remove - remove an application from the list.
Edit - edit an application rule.

15.1.6. Configuring the Intrusion Detection System
The BitDefender Intrusion Detection Systemmonitors network and system activities
for malicious activities or policy violations.
To configure the Intrusion Detection System:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Antivirus > Shield.
3. Click Advanced Settings.
4. Go to the IDS tab.
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5. Select the corresponding check box to enable the Intrusion Detection System.
6. Drag the slider along the scale to set the desired aggressiveness level. Use the

description on the right side of the scale to choose the aggressiveness level that
better fits your security needs.

15.2. On-demand Scanning
The main objective for BitDefender is to keep your computer clean of viruses. This
is first and foremost done by keeping new viruses out of your computer and by
scanning your e-mail messages and any new files downloaded or copied to your
system.
There is a risk that a virus is already lodged in your system, before you even install
BitDefender. This is why it's a very good idea to scan your computer for resident
viruses after you've installed BitDefender. And it's definitely a good idea to frequently
scan your computer for viruses.
On-demand scanning is based on scan tasks. Scan tasks specify the scanning options
and the objects to be scanned. You can scan the computer whenever you want by
running the default tasks or your own scan tasks (user-defined tasks). You can also
schedule them to run on a regular basis or when the system is idle so as not to
interfere with your work. For quick instructions, please refer to these topics:
● “How Do I Scan Files and Folders?” (p. 196)
● “How Do I Create a Custom Scan Task?” (p. 198)
● “How Do I Schedule a Computer Scan?” (p. 199)

15.2.1. Scanning Files and Folders
You should scan files and folders whenever you suspect they might be infected.
Right-click the file or folder you want to be scanned and select Scan with
BitDefender. The Antivirus Scan wizard will appear and guide you through the
scanning process.
If you want to scan specific locations on your computer, you can configure and run
a custom scan task. For more information, please refer to “How Do I Create a Custom
Scan Task?” (p. 198).
To scan your computer or part of it you can run the default scan tasks or your own
scan tasks. To run a scan task, open BitDefender and, depending on the user
interface view mode, proceed as follows:
Basic View

Click the Security button and choose one of the available scan tasks.
Intermediate View

Go to the Security tab. Click Full System Scan in the left-side Quick Tasks
area and choose one of the available scan tasks.
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Expert View
Go to Antivirus > Virus Scan. To run a system or user-defined scan task, click
the corresponding Run Task button.

These are the default tasks you can use to scan your computer:
Full System Scan

Scans the entire system, except for archives. In the default configuration, it
scans for all types of malware other than rootkits.

Quick Scan
Quick Scan uses in-the-cloud scanning to detect malware running in your system.
Running a Quick Scan usually takes less than a minute and uses a fraction of
the system resources needed by a regular virus scan.

Deep System Scan
Scans the entire system. In the default configuration, it scans for all types of
malware threatening your system's security, such as viruses, spyware, adware,
rootkits and others.

Before you initiate a scanning process, you should make sure that BitDefender is
up to date with its malware signatures. Scanning your computer using an outdated
signature database may prevent BitDefender from detecting new malware found
since the last update.
In order for BitDefender to make a complete scanning, you need to shut down all
open programs. Especially your email-client (i.e. Outlook, Outlook Express or Eudora)
is important to shut down.

Scanning Tips
Here are some more scanning tips you may find useful:
● Depending on the size of your hard disk, running a comprehensive scan of your
computer (such as Deep System Scan or System Scan) may take a while (up to
an hour or even more). Therefore, you should run such scans when you do not
need to use your computer for a longer time (for example, during the night).
You can schedule the scan to start when convenient. Make sure you leave your
computer running. With Windows Vista, make sure your computer is not in sleep
mode when the task is scheduled to run.

● If you frequently download files from the Internet to a specific folder, create a
new scan task and set that folder as scan target. Schedule the task to run every
day or more often.

● There is a kind of malware which sets itself to be executed at system startup by
changing Windows settings. To protect your computer against such malware, you
can schedule the Auto-logon Scan task to run at system startup. Please note
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that autologon scanning may affect system performance for a short time after
startup.

15.2.2. Antivirus Scan Wizard
Whenever you initiate an on-demand scan (for example, right-click a folder and
select Scan with BitDefender), the BitDefender Antivirus Scan wizard will appear.
Follow the three-step guided procedure to complete the scanning process.

Note
If the scan wizard does not appear, the scan may be configured to run silently, in the
background. Look for the scan progress icon in the system tray. You can click this
icon to open the scan window and to see the scan progress.

Step 1/3 - Scanning
BitDefender will start scanning the selected objects.
You can see the scan status and statistics (scanning speed, elapsed time, number
of scanned / infected / suspicious / hidden objects and other).
Wait for BitDefender to finish scanning.

Note
The scanning process may take a while, depending on the complexity of the scan.

Password-protected archives. When a password-protected archive is detected,
depending on the scan settings, you may be prompted to provide the password.
Password-protected archives cannot be scanned unless you provide the password.
The following options are available:
● I want to enter the password for this object. If you want BitDefender to
scan the archive, select this option and type the password. If you do not know
the password, choose one of the other options.

● I do not want to enter the password for this object (skip this object).
Select this option to skip scanning this archive.

● I do not want to enter the password for any object (skip all
password-protected objects). Select this option if you do not want to be
bothered about password-protected archives. BitDefender will not be able to scan
them, but a record will be kept in the scan log.

Click OK to continue scanning.
Stopping or pausing the scan. You can stop scanning anytime you want by
clicking Stop&Yes. You will go directly to the last step of the wizard. To temporarily
stop the scanning process, just click Pause. You will have to click Resume to resume
scanning.
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Step 2/3 - Select Actions
When the scanning is completed, a new window will appear, where you can see the
scan results.
If there are no unresolved threats, click Continue. Otherwise, you must configure
new actions to be taken on the unresolved threats in order to protect your system.
The infected objects are displayed in groups, based on the malware they are infected
with. Click the link corresponding to a threat to find out more information about the
infected objects.
You can choose an overall action to be taken for all issues or you can select separate
actions for each group of issues. One or several of the following options can appear
on the menu:
Take No Action

No action will be taken on the detected files. After the scan is completed, you
can open the scan log to view information on these files.

Disinfect
Removes the malware code from infected files.

Delete
Removes detected files from the disk.

Move to quarantine
Moves detected files to quarantine. Quarantined files cannot be executed or
opened; therefore, the risk of getting infected disappears. For more information,
please refer to “Quarantine Area” (p. 81).

Rename files
Changes the name of hidden files by appending .bd.ren to their name. As a
result, you will be able to search for and find such files on your computer, if
any.
Please note that these hidden files are not the files that you deliberately hide
fromWindows. They are the files hidden by special programs, known as rootkits.
Rootkits are not malicious in nature. However, they are commonly used to make
viruses or spyware undetectable by normal antivirus programs.

Click Continue to apply the specified actions.

Step 3/3 - View Results
When BitDefender finishes fixing the issues, the scan results will appear in a new
window. If you want comprehensive information on the scanning process, click Show
Log to view the scan log.
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Important
If required, please restart your system in order to complete the cleaning process.

Click Close to close the window.

BitDefender Could Not Solve Some Issues
In most cases BitDefender successfully disinfects the infected files it detects or it
isolates the infection. However, there are issues that cannot be solved automatically.
For more information and instructions on how to remove malware manually, please
refer to “Removing Malware from Your System” (p. 228).

BitDefender Detected Suspect Files
Suspect files are files detected by the heuristic analysis as potentially infected with
malware the signature of which has not been released yet.
If suspect files were detected during the scan, you will be requested to submit them
to the BitDefender Lab. ClickOK to send these files to the BitDefender Lab for further
analysis.

15.2.3. Viewing Scan Logs
Each time you perform a scan, a scan log is created. The scan log contains detailed
information about the logged scanning process, such as scanning options, the
scanning target, the threats found and the actions taken on these threats.
You can open the scan log directly from the scan wizard, once the scan is completed,
by clicking Show Log.
To check scan logs at a later time:
1. Open BitDefender.
2. Click the View Logs link in the bottom-right corner of the window.
3. Click Antivirus on the left-side menu.
4. In the On-demand Tasks section, you can check what scans have been

performed recently. Double-click the events in the list to see more details. To
open the scan log, click View Scan Log. The scan log will open in your default
web browser.

To delete a log entry, right-click it and select Delete.

15.2.4. Managing Existing Scan Tasks
BitDefender comes with several tasks, created by default, which cover common
security issues. You can also create your own customized scan tasks. For more
information, please refer to “How Do I Create a Custom Scan Task?” (p. 198).
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To manage the existing scan tasks:
1. Open BitDefender.
2. Depending on the user interface view mode, proceed as follows:

Intermediate View
Go to the Security tab and click Configure Antivirus in the Quick Tasks
area on the left side of the window.
Go to the Virus Scan tab.

Expert View
Go to Antivirus > Virus Scan.

Note
In Basic View and Intermediate View, you can configure a shortcut so that you can
access these settings from your dashboard. For more information, please refer to
“My Tools” (p. 33).

There are three categories of scan tasks:
● System tasks - contains the list of default system tasks. The following tasks are
available:
Full System Scan

Scans the entire system, except for archives. In the default configuration, it
scans for all types of malware other than rootkits.

Quick Scan
Quick Scan uses in-the-cloud scanning to detect malware running in your
system. Running a Quick Scan usually takes less than a minute and uses a
fraction of the system resources needed by a regular virus scan.

Auto-logon Scan
Scans the items that are run when a user logs on to Windows. By default, the
autologon scan is disabled.
If you want to use this task, right-click it, select Schedule and set the task
to run at system startup. You can specify how long after the startup the
task should start running (in minutes).

Deep System Scan
Scans the entire system. In the default configuration, it scans for all types of
malware threatening your system's security, such as viruses, spyware, adware,
rootkits and others.

Note
Since the Deep System Scan and Full System Scan tasks analyze the entire
system, the scanningmay take a while. Therefore, we recommend you to run these
tasks on low priority or, better, when your system is idle.
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●User tasks - contains the user-defined tasks.
A task called My Documents is provided. Use this task to scan important current
user folders: My Documents, Desktop and StartUp. This will ensure the safety
of your documents, a safe workspace and clean applications running at startup.

●Misc tasks - contains a list of miscellaneous scan tasks. These scan tasks refer
to alternative scanning types that cannot be run from this window. You can only
modify their settings or view the scan reports. The following tasks are available:
Device Scanning

BitDefender can detect automatically when a new storage device is connected
to the computer and scan it. Use this task to configure the options of the
automatic detection and scanning of storage devices (CDs/DVDs, USB storage
devices or mapped network drives).

Contextual Scan
This task is used when scanning via the Windows contextual menu or using
the scan activity bar. You can modify the scan options to better suit your
needs.

You can manage scan tasks using the buttons or the shortcut menu.
To run a system or user-defined scan task, click the corresponding Run Task button.
The Antivirus Scan wizard will appear and guide you through the scanning process.
To set a scan task to run automatically, at a later moment or regularly, click the
corresponding Schedule button and configure the task schedule as needed.
If you no longer need a scan task that you have created (a user-defined task), you
can delete it by clicking the Delete button, located to the right of the task. You
cannot remove system or miscellaneous tasks.
Each scan task has a Properties window where you can configure its settings and
view the scan logs. To open this window click the Properties button to the left of
the task (or right-click the task and then click Properties).
To learn more, please refer to these topics:
● “Configuring Scan Settings” (p. 74)
● “Setting Scan Target” (p. 76)
● “Scheduling Scan Tasks” (p. 77)

Using Shortcut Menu
A shortcut menu is available for each task. Right-click the selected task to open it.
For system and user-defined tasks, the following commands are available on the
shortcut menu:
● Scan Now - runs the selected task, initiating an immediate scan.
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● Paths - opens the Properties window, Paths tab, where you can change the
scan target of the selected task. In the case of system tasks, this option is replaced
by Show Scan Paths, as you can only see their scan target.

● Schedule - opens the Propertieswindow, Scheduler tab, where you can schedule
the selected task.

● View Logs - opens the Properties window, Logs tab, where you can see the
reports generated after the selected task was run.

● Clone Task - duplicates the selected task. This is useful when creating new tasks,
as you can modify the settings of the task duplicate.

●Delete - deletes the selected task.

Note
Available for user-created tasks only. You cannot remove a default task.

● Properties - opens the Propertieswindow, Overview tab, where you can change
the settings of the selected task.

Due to the particular nature of the Misc Tasks category, only the View Logs and
Properties options are available in this case.

Configuring Scan Settings
To configure the scanning options of a specific scan task, right-click it and select
Properties.
You can easily configure the scanning options by adjusting the scan level. Drag the
slider along the scale to set the desired scan level. Use the description on the right
side of the scale to identify the scan level that better fits your needs.
You can also configure these general options:
● Run the task with Low priority. Decreases the priority of the scan process.
You will allow other programs to run faster and increase the time needed for the
scan process to finish.

●Minimize Scan Wizard to system tray. Minimizes the scan window to the
system tray. Double-click the BitDefender icon to open it.

● Specify the action to be taken if no threats are found.
Advanced users might want to take advantage of the scan settings BitDefender
offers. The scanner can be set to scan only specific file extensions, to search for
specific malware threats or to skip archives. This may greatly reduce scanning times
and improve your computer's responsiveness during a scan.
To configure the scan settings in detail:
1. Click Custom.
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2. Configure the scan settings as needed. To find out what an option does, keep
the mouse over it and read the description displayed at the bottom of the window.

3. Click OK to save the changes and close the window.
You may find this information useful:
● If you are not familiar with some of the terms, check them in the glossary. You
can also find useful information by searching the Internet.

● Scan Level. Specify the type of malware you want BitDefender to scan for by
selecting the appropriate options.

● Scan files. You can set BitDefender to scan all types of files, applications
(program files) only or specific file types you consider to be dangerous. Scanning
all files provides best protection, while scanning applications only can be used to
perform a quicker scan.
Applications (or program files) are far more vulnerable to malware attacks than
other types of files. This category includes the following file extensions: .exe;
.bat; .com; .dll; .ocx; .scr; .bin; .dat; .386; .vxd; .sys; .wdm; .cla;
.class; .ovl; .ole; .exe; .hlp; .doc; .dot; .xls; .ppt; .wbk; .wiz; .pot;
.ppa; .xla; .xlt; .vbs; .vbe; .mdb; .rtf; .htm; .hta; .html; .xml; .xtp;
.php; .asp; .js; .shs; .chm; .lnk; .pif; .prc; .url; .smm; .pdf; .msi;
.ini; .csc; .cmd; .bas; .eml; .nws.
If you opt for Scan user defined extensions, it is recommended that you include
all application extensions beside other file extensions you consider to be
dangerous.

● Scan only new and changed files. By scanning only new and changed files,
you may greatly improve overall system responsiveness with a minimum trade-off
in security.

● Scan inside archives. Archives containing infected files are not an immediate
threat to the security of your system. The malware can affect your system only
if the infected file is extracted from the archive and executed without having
real-time protection enabled. However, it is recommended to use this option in
order to detect and remove any potential threat, even if it is not an immediate
threat.

Note
Scanning archived files increases the overall scanning time and requires more
system resources.

● Action options. Specify the actions to be taken on each category of detected
files using the options in this category. There are three categories of detected
files:
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▶ Infected files. Files detected as infected match a malware signature in the
BitDefender Malware Signature Database. BitDefender can normally remove
the malware code from an infected file and reconstruct the original file. This
operation is known as disinfection.

Note
Malware signatures are snippets of code extracted from actual malware samples.
They are used by antivirus programs to perform pattern-matching and detect
malware.
The BitDefender Malware Signature Database is a collection of malware
signatures updated hourly by the BitDefender malware researchers.

▶ Suspicious files. Files are detected as suspicious by the heuristic analysis.
Suspicious files cannot be disinfected, because no disinfection routine is
available.

▶ Hidden files (rootkits). Please note that these hidden files are not the files
that you deliberately hide from Windows. They are the files hidden by special
programs, known as rootkits. Rootkits are not malicious in nature. However,
they are commonly used to make viruses or spyware undetectable by normal
antivirus programs.

You should not change the default actions taken on detected files unless you have
a strong reason to do so.
To set a new action, click the current First action and select the desired option
from the menu. Specify a Second action that will be taken in case the first one
fails.

Click OK to save the changes and close the window. To run the task, just click Scan.

Setting Scan Target
You cannot modify the scan target of the scan tasks from the System Tasks
category. You can only see their scan target. To view the scan target of a specific
system scan task, right-click the task and select Show Scan Paths.
To set the scan target of a specific user scan task, right-click the task and select
Paths. Alternatively, if you are already in the Properties window of a task, select
the Paths tab.
You can see the list of local, network and removable drives as well as the files or
folders added previously, if any. All checked items will be scanned when running
the task.
The following buttons are available:
● Add Item(s) - opens a browsing window where you can select the file(s) / folder(s)
that you want to be scanned.
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Note
You can also use drag and drop to add files/folders to the list.

●Delete Item(s) - removes the file(s) / folder(s) previously selected from the list
of objects to be scanned.

Besides these buttons, there are some options that allow the fast selection of the
scan locations.
● Local Drives - to scan the local drives.
●Network Drives - to scan all network drives.
● Removable Drives - to scan removable drives (CD-ROM, floppy-disk unit).
● All Entries - to scan all drives, no matter if they are local, in the network or
removable.

Click OK to save the changes and close the window. To run the task, just click Scan.

Scheduling Scan Tasks
With complex tasks, the scanning process will take some time and it will work best
if you close all other programs. That is why it is best for you to schedule such tasks
when you are not using your computer and it has gone into the idle mode.
To see the schedule of a specific task or to modify it, right-click the task and select
Schedule. If you are already in a task's Properties window, select the Scheduler
tab.
You can see the task schedule, if any.
When scheduling a task, you must choose one of the following options:
●No - launches the task only when the user requests it.
●Once - launches the scan only once, at a certain moment. Specify the start date
and time in the Start Date/Time fields.

● Periodically - launches the scan periodically, at certain time intervals(minutes,
hours, days, weeks, months) starting with a specified date and time.

●On system startup - launches the scan at the specified number of minutes after
a user has logged on to Windows.

Click OK to save the changes and close the window. To run the task, just click Scan.

15.3. Configuring Scan Exclusions
There are cases when you may need to exclude certain files from scanning. For
example, you may want to exclude an EICAR test file from on-access scanning or
.avi files from on-demand scanning.
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BitDefender allows excluding objects from on-access or on-demand scanning, or
from both. This feature is intended to decrease scanning times and to avoid
interference with your work.
Two types of objects can be excluded from scanning:
● Paths - the file or the folder (including all the objects it contains) indicated by a
specified path will be excluded from scanning.

● Extensions - all files having a specific extension will be excluded from scanning,
no matter what their location on the hard drive.

The objects excluded from on-access scanning will not be scanned, no matter if
they are accessed by you or by an application.

Note
Exclusions will NOT apply for contextual scanning. Contextual scanning is a type of
on-demand scanning: you right-click the file or folder you want to scan and select
Scan with BitDefender.

15.3.1. Excluding Files or Folders from Scanning
To exclude paths from scanning:
1. Open BitDefender.
2. Depending on the user interface view mode, proceed as follows:

Intermediate View
Go to the Security tab and click Configure Antivirus in the Quick Tasks
area on the left side of the window.
Go to the Exclusions tab.

Expert View
Go to Antivirus > Exclusions.

Note
In Basic View and Intermediate View, you can configure a shortcut so that you can
access these settings from your dashboard. For more information, please refer to
“My Tools” (p. 33).

3. Select the corresponding check box to enable scan exclusions.
4. Start the configuration wizard as follows:

● Right-click in the Files and Folders table and select Add new path.
● Click the Add button, located at the top of the exclusions table.

5. Follow the configuration wizard. You can navigate through the wizard using the
Next and Back buttons. To exit the wizard, click Cancel.
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a. Select the option of excluding a path from scanning. This step appears only
when you start the wizard by clicking the Add button.

b. To specify the paths to be excluded from scanning use either of the following
methods:
● Click Browse, select the file or folder that you want to be excluded from
scanning and then click Add.

● Type the path that you want to be excluded from scanning in the edit field
and click Add.

The paths will appear in the table as you add them. You can add as many paths
as you want.

c. By default, the selected paths are excluded from both on-access and
on-demand scanning. To change when to apply the exception, click on the
right column and select the desired option from the list.

d. It is highly recommended to scan the files in the specified paths to make sure
that they are not infected. Select the check box to scan these files before
excluding them from scanning.
Click Finish to add the scan exclusions.

6. Click Apply to save the changes.

15.3.2. Excluding File Extensions from Scanning
To exclude file extensions from scanning:
1. Open BitDefender.
2. Depending on the user interface view mode, proceed as follows:

Intermediate View
Go to the Security tab and click Configure Antivirus in the Quick Tasks
area on the left side of the window.
Go to the Exclusions tab.

Expert View
Go to Antivirus > Exclusions.

Note
In Basic View and Intermediate View, you can configure a shortcut so that you can
access these settings from your dashboard. For more information, please refer to
“My Tools” (p. 33).

3. Select the corresponding check box to enable scan exclusions.
4. Start the configuration wizard as follows:

● Right-click in the Extensions table and select Add new extensions.
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● Click the Add button, located at the top of the exclusions table.
5. Follow the configuration wizard. You can navigate through the wizard using the

Next and Back buttons. To exit the wizard, click Cancel.
a. Select the option of excluding extensions from scanning. This step appears

only when you start the wizard by clicking the Add button.
b. To specify the extensions to be excluded from scanning use either of the

following methods:
● Select from the menu the extension that you want to be excluded from
scanning and then click Add.

Note
The menu contains a list of all the extensions registered on your system.
When you select an extension, you can see its description, if available.

● Type the extension that you want to be excluded from scanning in the edit
field and click Add.

The extensions will appear in the table as you add them. You can add as many
extensions as you want.

c. By default, the selected extensions are excluded from both on-access and
on-demand scanning. To change when to apply the exception, click on the
right column and select the desired option from the list.

d. It is highly recommended to scan the files with the specified extensions to
make sure that they are not infected.
Click Finish to add the scan exclusions.

6. Click Apply to save the changes.

15.3.3. Managing Scan Exclusions
If the configured scan exclusions are no longer needed, it is recommended that you
delete them or disable scan exclusions.
To manage scan exclusions:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Antivirus > Exclusions.
To remove an entry from the table, select it and click the Delete button.
To edit an entry from the table, select it and click the Edit button. A new window
will appear where you can change the extension or the path to be excluded and the
type of scanning you want them to be excluded from, as needed. Make the necessary
changes and click OK.
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Note
You can also right-click an object and use the options on the shortcut menu to edit
or delete it.

To disable scan exclusions, clear the corresponding check box.

15.4. Quarantine Area
BitDefender allows isolating the infected or suspicious files in a secure area, named
quarantine. By isolating these files in the quarantine, the risk of getting infected
disappears and, at the same time, you have the possibility to send these files for
further analysis to the BitDefender lab.

Note
When a virus is in quarantine it cannot do any harm because it cannot be executed
or read.

In addition, BitDefender scans the quarantined files after each malware signature
update. Cleaned files are automatically moved back to their original location.
To see and manage quarantined files and to configure the quarantine settings:
1. Open BitDefender.
2. Depending on the user interface view mode, proceed as follows:

Intermediate View
Go to the Security tab and click Configure Antivirus in the Quick Tasks
area on the left side of the window.
Go to the Quarantine tab.

Expert View
Go to Antivirus > Quarantine.

Note
In Basic View and Intermediate View, you can configure a shortcut so that you can
access these settings from your dashboard. For more information, please refer to
“My Tools” (p. 33).

Managing Quarantined Files
You can send any selected file from the quarantine to the BitDefender Lab by clicking
Send. By default, BitDefender will automatically submit quarantined files every 60
minutes.
To delete a quarantined file, select it and click the Delete button.
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If you want to restore a quarantined file to its original location, select it and click
Restore.

Configuring Quarantine Settings
To configure the quarantine settings, click Settings. Using the quarantine settings,
you can set BitDefender to automatically perform the following actions:
Delete old files. To automatically delete old quarantined files, check the
corresponding option. You must specify the number of days after which the
quarantined files should be deleted and frequency with which BitDefender should
check for old files.
Automatically submit files. To automatically submit quarantined files, check
the corresponding option. You must specify the frequency with which to submit
files.
Scan quarantined files after update. To automatically scan quarantined files
after each update performed, check the corresponding option. You can choose to
automatically move back the cleaned files to their original location by selecting
Restore clean files.
Click OK to save the changes and close the window.
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16. Antiphishing Protection
BitDefender Antiphishing prevents you from disclosing personal information while
browsing the Internet by alerting you about potential phishing web pages.
BitDefender provides real-time antiphishing protection for:
● Internet Explorer
● Mozilla Firefox
● Yahoo! Messenger
●Windows Live (MSN) Messenger

16.1. Configuring the Antiphishing White List
You can configure and manage a white list of web sites that will not be scanned by
the BitDefender Antiphishing engines. The white list should contain only web sites
you fully trust. For example, add the web sites where you currently shop online.

Note
You can easily add web sites to the white list from the BitDefender Antiphishing
toolbar integrated into your web browser. For more information, please refer to
“Managing the BitDefender Antiphishing Protection in Internet Explorer and Firefox”
(p. 83).

To configure and manage the antiphishing white list:
● If you are using a supported web browser, click the BitDefender toolbar and choose
White List from the menu.

● Alternatively, follow these steps:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Antivirus > Shield.
3. Click White List.

To add a site to the White List, provide its address in the corresponding field and
click Add.
If you want to remove a web site from the white list, click the corresponding Remove
button.
Click Save to save the changes and close the window.

16.2. Managing the BitDefender Antiphishing Protection in
Internet Explorer and Firefox

BitDefender integrates directly through an intuitive and easy-to-use toolbar into the
following web browsers:
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● Internet Explorer
● Mozilla Firefox
You can easily and efficiently manage antiphishing protection and the White List
using the BitDefender Antiphishing toolbar integrated into one of the above web
browsers.
The antiphishing toolbar, represented by the BitDefender icon, is located on the
topside of browser. Click it in order to open the toolbar menu.

Note
If you cannot see the toolbar, open the View menu, point to Toolbars and check
BitDefender Toolbar.

The following commands are available on the toolbar menu:
● Enable / Disable - enables / disables the BitDefender antiphishing protection in
the current web browser.

● Settings - opens a window where you can specify the antiphishing toolbar's
settings. The following options are available:
▶ Real-time Antiphishing Web Protection - detects and alerts you in real-time
if a web site is phished (set up to steal personal information). This option controls
the BitDefender antiphishing protection in the current web browser only.

▶ Ask before adding to whitelist - prompts you before adding a web site to
the White List.

● Add to White List - adds the current web site to the White List.

Important
Adding a site to the White List means that BitDefender will not scan the site for
phishing attempts anymore. We recommend you to add to the White List only sites
that you fully trust.

●White List - opens the White List. For more information, please refer to
“Configuring the Antiphishing White List” (p. 83).

● Report as Phishing - informs the BitDefender Lab that you consider the
respective web site to be used for phishing. By reporting phished web sites you
help protect other people against identity theft.

●Help - opens the help file.
● About - opens a window where you can see information about BitDefender and
where to look for help in case something unexpected appears.

Antiphishing Protection 84

BitDefender Total Security 2011



17. Search Advisor
Search Advisor improves your online threat protection by alerting you about phishing
or untrusted web pages directly from your search results page.
Search Advisor works with any web browser and checks the search results displayed
by the most popular search engines:
● Google
● Yahoo!
● Bing
Search Advisor indicates whether a search result is safe or not by placing a small
status icon before the link.

Green circle with a check mark: You can safely access the link.
Red circle with an exclamation mark: This is a phishing or untrusted web

page. You should avoid opening the link. If you are using Internet Explorer or Firefox
and you try to open the link, BitDefender will automatically block the web page and
display an alert page instead. If you want to ignore the alert and access the web
page, follow the instructions in the alert page.

17.1. Disabling Search Advisor
To disable Search Advisor:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Preferences.
2. Go to Security Settings.
3. Use the switch to turn off Search Advisor.
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18. Antispam
Spam is a term used to describe unsolicited e-mail. Spam is a growing problem,
both for individuals and for organizations. It's not pretty, you wouldn't want your
kids to see it, it can get you fired (for wasting too much time or from receiving porn
in your office mail) and you can't stop people from sending it. The next best thing
to that is, obviously, to stop receiving it. Unfortunately, Spam comes in a wide range
of shapes and sizes, and there's a lot of it.
BitDefender Antispam employs remarkable technological innovations and industry
standard antispam filters to weed out spam before it reaches the user's Inbox. For
more information, please refer to “Antispam Insights” (p. 86).
The BitDefender Antispam protection is available only for e-mail clients configured
to receive e-mail messages via the POP3 protocol. POP3 is one of the most widely
used protocols for downloading e-mail messages from a mail server.

Note
BitDefender does not provide antispam protection for e-mail accounts that you access
through a web-based e-mail service.

The spam messages detected by BitDefender are marked with the [spam] prefix
in the subject line. BitDefender automatically moves spam messages to a specific
folder, as follows:
● In Microsoft Outlook, spam messages are moved to a Spam folder, located in the
Deleted Items folder. The Spam folder is created during the installation of
BitDefender.

● In Outlook Express and Windows Mail, spam messages are moved directly to
Deleted Items.

● In Mozilla Thunderbird, spam messages are moved to a Spam folder, located in
the Trash folder. The Spam folder is created during the installation of BitDefender.

If you use other mail clients, you must create a rule to move the e-mail messages
marked as [spam] by BitDefender to a custom quarantine folder.

18.1. Antispam Insights
18.1.1. Antispam Filters

The BitDefender Antispam Engine incorporates several different filters that ensure
your Inbox to be SPAM-free: Friends list, Spammers list, Charset filter, Image filter,
URL filter, NeuNet (Heuristic) filter and Bayesian filter.
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Friends List / Spammers List
Most people communicate regularly to a group of people or even receive messages
from companies or organizations in the same domain. By using friends or
spammers list, you can easily classify which people you want to receive e-mail
from (friends) no matter what the message contains, or which people you never
want to hear from again (spammers).

Note
We recommend that you add your friends' names and e-mail addresses to the Friends
list. BitDefender does not block messages from those on the list; therefore, adding
friends helps ensure that legitimate messages get through.

Charset Filter
Many spam messages are written in Cyrillic and / or Asian charsets. The Charset
Filter detects this kind of messages and tags them as SPAM.

Image Filter
Since avoiding heuristic filter detection has become quite a challenge, nowadays'
inbox folders are full with more and more messages only containing an image with
unsolicited content. To cope with this growing problem, BitDefender introduced the
Image filter that compares the image signature from the e-mail with those from
the BitDefender database. In case of a match the e-mail will be tagged as SPAM.

URL Filter
Almost all spam messages include links to various web locations. These locations
usually contain more advertising and the possibility to buy things, and, sometimes,
they are used for phishing.
BitDefender maintains a database of such links. The URL filter checks every URL
link in a message against its database. If a match is made, the message is tagged
as SPAM.

NeuNet (Heuristic) Filter
The NeuNet (Heuristic) filter performs a set of tests on all the message
components, (i.e. not only the header but also the message body in either HTML or
text format), looking for words, phrases, links or other characteristics of SPAM. Based
on the results of the analysis, it adds a SPAM score to the message.
The filter also detects messages marked as SEXUALLY-EXPLICIT: in the subject
line and tags them as SPAM.
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Note
Starting May 19, 2004, spam that contains sexually oriented material must include
the warning SEXUALLY-EXPLICIT: in the subject line or face fines for violations
of federal law.

Bayesian Filter
The Bayesian filtermodule classifies messages according to statistical information
regarding the rate at which specific words appear in messages classified SPAM as
compared to those declared NON-SPAM (by you or by the heuristic filter).
This means, for example, if a certain four-letter word is seen to appear more often
in SPAM, it is natural to assume there is an increased probability that the next
incoming message that includes it actually IS SPAM. All relevant words within a
message are taken into account. By synthesizing the statistical information, the
overall probability for the whole message to be SPAM is computed.
This module presents another interesting characteristic: it is trainable. It adapts
quickly to the type of messages received by a certain user, and stores information
about all. To function effectively, the filter must be trained, meaning, to be presented
with samples of SPAM and legitimate messages, much like a hound is primed to
trace a certain scent. Sometimes the filter must be corrected too - prompted to
adjust when it makes a wrong decision.

Important
You can correct the Bayesian filter using the Is Spam and Not Spam buttons
from the Antispam toolbar.

18.1.2. Antispam Operation
The BitDefender Antispam Engine uses all antispam filters combined to determine
whether a certain e-mail message should get into your Inbox or not.
Every e-mail that comes from the Internet is first checked with the Friends
list/Spammers list filter. If the sender's address is found in the Friends list the e-mail
is moved directly to your Inbox.
Otherwise, the Spammers list filter will take over the e-mail to verify if the sender's
address is on its list. If a match is made, the e-mail will be tagged as SPAM and
moved in the Spam folder.
Else, the Charset filter will check if the e-mail is written in Cyrillic or Asian characters.
If so the e-mail will be tagged as SPAM and moved in the Spam folder.
If the e-mail is not written in Asian or Cyrillic it will be passed to the Image filter.
The Image filter will detect all the e-mail messages containing attached images
with spam content.
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The URL filter will compare the links found in the e-mail against the links from the
BitDefender database of known spam links. In case of a match, the e-mail will be
considered SPAM.
The NeuNet (Heuristic) filter will take over the e-mail and will perform a set of tests
on all the message components, looking for words, phrases, links or other
characteristics of SPAM. Based on the results of the analysis, the e-mail will receive
a spam score.

Note
If the e-mail is tagged as SEXUALLY EXPLICIT in the subject line, BitDefender will
consider it SPAM.

The Bayesian filter module will further analyze the message, according to statistical
information regarding the rate at which specific words appear in messages classified
SPAM as compared to those declared NON-SPAM (by you or by the heuristic filter).
A Spam score will be added to the e-mail.
If the aggregate spam score (heuristic score + Bayesian score) exceeds the threshold
level, the e-mail is considered SPAM. The threshhold level is defined by the antispam
protection level. For more information, please refer to “Adjusting the Protection
Level” (p. 94).

18.1.3. Antispam Updates
Every time you perform an update:
● new image signatures will be added to the Image filter.
● new links will be added to the URL filter.
● new rules will be added to the NeuNet (Heuristic) filter.
This will help increase the effectiveness of your Antispam engine.
To protect you against spammers, BitDefender can perform automatic updates.
Keep the Automatic Update option enabled.

18.2. Antispam Optimization Wizard
The first time you run your mail client after you have installed BitDefender, a wizard
will appear helping you to configure the Friends list and the Spammers list and to
train the Bayesian filter in order to increase the efficiency of the Antispam filters.

Note
The wizard can also be launched any time you want by clicking the Wizard button
from the Antispam toolbar.

You can navigate through the wizard using the Next and Back buttons. If you want
to skip a configuration step, select Skip this step. To exit the wizard, click Cancel.
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1. Welcome Window
2. Add Contacts to Friends List

Here you can see all the addresses from your Address Book. Please select those
you want to be added to your Friends list (we recommend to select them all).
You will receive all the e-mail messages from these addresses, regardless of their
content.
To add all your contacts to the Friends list, check Select all.

3. Delete Bayesian Database

Note
The first time you run the wizard, just go to the next step.

You may find that your antispam filter has begun to lose efficiency. This may be
due to improper training. (i.e. you have mistakenly tagged a number of legitimate
messages as spam, or vice versa). If your filter is very inaccurate, you may need
to wipe the filter database and retrain the filter by following the next steps of
this wizard.
Select Wipe antispam filter database if you want to reset the Bayesian
database.
You can save the Bayesian database to a file so that you can use it with another
BitDefender product or after reinstalling BitDefender. To save the Bayesian
database, click the Save Bayes button and save it to the desired location. The
file will have a .dat extension.
To load a previously saved Bayesian database, click the Load Bayes button and
open the corresponding file.

4. Train the Bayesian Filter on Legitimate (Non-Spam) E-mails
Please select a folder that contains legitimate e-mail messages. These messages
will be used to train the antispam filter.
There are two advanced options under the directory list:
● Include all subfolders - to include the subfolders to your selection.
● Automatically add to Friends list - to add the senders to the Friends list.

5. Train the Bayesian Filter on Spam E-mails
Please select a folder that contains spam e-mail messages. These messages will
be used to train the antispam filter.

Important
Please make sure that the folder you choose contains no legitimate e-mail at all,
otherwise the antispam performance will be considerably reduced.
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There are two advanced options under the directory list:
● Include all subfolders - to include the subfolders to your selection.
● Automatically add to Spammers list - to add the senders to the Spammers
list. E-mail messages from these senders will always be marked as SPAM and
processed accordingly.

6. Summary
Here you can view all the settings for the configuration wizard. You can make
any changes, by returning to the previous steps (click Back).
If you do not want to make any modifications, click Finish to end the wizard.

18.3. Using the Antispam Toolbar in Your Mail Client Window
In the upper area of your mail client window you can see the Antispam toolbar. The
Antispam toolbar helps you manage antispam protection directly from your mail
client. You can easily correct BitDefender if it marked a legitimate message as SPAM.

Important
BitDefender integrates into the most commonly used mail clients through an
easy-to-use antispam toolbar. For a complete list of supported mail clients, please
refer to “Software Requirements” (p. 2).

Each button from the BitDefender toolbar will be explained below:
● Is Spam - sends a message to the Bayesian module indicating that the selected
e-mail is spam. The e-mail will be tagged as SPAM and moved to the Spam folder.
The future e-mail messages that fit the same patterns will be tagged as SPAM.

● Not Spam - sends a message to the Bayesian module indicating that the
selected e-mail is not spam and BitDefender should not have tagged it. The e-mail
will be moved from the Spam folder to the Inbox directory.
The future e-mail messages that fit the same patterns will no longer be tagged
as SPAM.

Important
The Not Spam button becomes active when you select a message marked as
SPAM by BitDefender (normally these messages are located in the Spam folder).

● Add Spammer - adds the sender of the selected e-mail to the Spammers list.
You may need to click OK to acknowledge. The e-mail messages received from
addresses in the Spammers list are automatically marked as [spam].

● Add Friend - adds the sender of the selected e-mail to the Friends list. You
may need to click OK to acknowledge. You will always receive e-mail messages
from this address no matter what they contain.
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● Spammers - opens the Spammers list that contains all the e-mail addresses
from which you don't want to receive messages, regardless of their content. For
more information, please refer to “Configuring the Spammers List” (p. 96).

● Friends - opens the Friends list that contains all the e-mail addresses from
which you always want to receive e-mail messages, regardless of their content.
For more information, please refer to “Configuring the Friends List” (p. 95).

● Settings - opens the Settings window where you can specify some options
for the Antispam module.

● Wizard - opens the antispam optimization wizard. This wizard help you train
the Bayesian filter in order to further increase the efficiency of your antispam
protection. You can also add addresses from your Address Book to your Friends
list / Spammers list.

● BitDefender Antispam - opens a window where you can configure the
antispam protection level and the antispam filters.

18.3.1. Indicating Detection Errors
If you are using a supported mail client, you can easily correct the antispam filter
(by indicating which e-mail messages should not have been marked as [spam]).
Doing so will considerably improve the efficiency of the antispam filter. Follow these
steps:
1. Open your mail client.
2. Go to the junk mail folder where spam messages are moved.
3. Select the legitimate message incorrectly marked as [spam] by BitDefender.
4. Click the Add Friend button on the BitDefender antispam toolbar to add the

sender to the Friends list. You may need to click OK to acknowledge. You will
always receive e-mail messages from this address no matter what they contain.

5. Click the Not Spam button on the BitDefender antispam toolbar (normally
located in the upper part of the mail client window). This indicates to the Learning
Engine that the selected message is not spam. The e-mail message will be moved
to the Inbox folder. The next e-mail messages that fit the same patterns will no
longer be marked as [spam].

18.3.2. Indicating Undetected Spam Messages
If you are using a supported mail client, you can easily indicate which e-mail
messages should have been detected as spam. Doing so will considerably improve
the efficiency of the antispam filter. Follow these steps:
1. Open your mail client.
2. Go to the Inbox folder.
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3. Select the undetected spam messages.
4. Click the Is Spam button on the BitDefender antispam toolbar (normally located

in the upper part of the mail client window). This indicates to the Learning Engine
that the selected messages are spam. They are immediately marked as [spam]
and moved to the junk mail folder. The next e-mail messages that fit the same
patterns will be marked as [spam].

18.3.3. Retraining the Learning Engine (Bayesian)
If your antispam filter is very inaccurate, you may need to wipe the Bayesian
database and retrain the Bayesian filter.
Before training the Learning Engine (Bayesian), prepare a folder containing only
SPAMmessages and another one containing only legitimate messages. The Learning
Engine will analyze them and learn the characteristics that define the spam or
legitimate messages that you usually receive. In order for the training to be efficient,
there must be over 50 messages in each category.
To reset the Bayesian database and retrain the Learning Engine, follow these steps:
1. Open your mail client.
2. On the BitDefender antispam toolbar, click the Wizard button to start the

antispam configuration wizard.
3. Click Next.
4. Select Skip this step and click Next.
5. Select Clear antispam filter database and click Next.
6. Select the folder containing legitimate messages and click Next.
7. Select the folder containing SPAM messages and click Next.
8. Click Finish to start the training process.
9. When training is completed, click Close.

18.3.4. Saving and Loading Bayesian Database
You can save the Bayesian database to a file so that you can use it with another
BitDefender product or after reinstalling BitDefender.
Click the Settings button on the BitDefender antispam toolbar.
To save the Bayesian database, click the Save Bayes button and save it to the
desired location. The file will have a .dat extension.
To load a previously saved Bayesian database, click the Load Bayes button and
open the corresponding file.
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18.3.5. Configuring General Settings
To configure general antispam settings for your mail client, click the Settings
button on the BitDefender antispam toolbar.
The following options are available:
●Move message to Deleted Items - moves the spam messages to the Deleted
Items (only for Microsoft Outlook Express / Windows Mail);

●Mark message as 'read' - marks all the spam messages as read so as not to
be disturbing when new spam messages arrive.

Click the Alerts tab if you want to access the section where you can disable the
apparition of the confirmation windows for the Add spammer and Add friend
buttons.
In the Alerts window you can also enable/disable the apparition of the Please
select an email message alert. This alert appears when you select a group instead
of an email message.

18.4. Adjusting the Protection Level
Some of the antispam filters can identify spam e-mails directly, while others add a
spam score to the e-mail, based on the spam characteristics detected.
The antispam protection level is used to determine if an e-mail message can be
considered spam based on its total spam score (received after being checked by
all of the antispam filters).
You should not change the antispam protection level, unless the antispam protection
does not work as expected. However, rather than independently change the
protection level, it is recommended that you first read “Antispam Filter Does Not
Work Properly” (p. 220) and follow the instructions to correct the problem.
To adjust the antispam protection level:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Antispam > Status.
3. Drag the slider along the scale to set the appropriate protection level. To set the

default protection level (Moderate to Aggressive) click Default Level.
Use the description on the right side of the scale to choose the protection level that
better fits your security needs. The description also informs you about any additional
actions you should take in order to avoid potential problems or to increase antispam
detection efficiency.
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18.5. Configuring the Friends List
The Friends list is a list of all the e-mail addresses from which you always want to
receive messages, regardless of their content. Messages from your friends are not
labeled as spam, even if the content resembles spam.

Note
Any mail coming from an address contained in the Friends list, will automatically
be delivered to your Inbox without further processing.

To configure and manage the Friends list:
● If you are using Microsoft Outlook / Outlook Express / Windows Mail / Thunderbird,
click the Friends button on the BitDefender antispam toolbar integrated into
your mail client.

● Alternatively, follow these steps:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Antispam > Status.
3. Click Manage Friends.

To add an e-mail address, select the E-mail address option, enter the address and
click the button next to the edit field. Syntax: name@domain.com.
To add all the e-mail addresses from a specific domain, select the Domain name
option, enter the domain name and click the button next to the edit field. Syntax:
●@domain.com, *domain.com and domain.com - all the received e-mail messages
from domain.com will reach your Inbox regardless of their content;

● *domain* - all the received e-mail messages from domain (no matter the domain
suffixes) will reach your Inbox regardless of their content;

● *com - all the received e-mail messages having the domain suffix com will reach
your Inbox regardless of their content;

It is recommended to avoid adding entire domains, but this may be useful in some
situations. For example, you can add the e-mail domain of the company you work
for, or those of your trusted partners.
To delete an item from the list, select it and click the Remove button. To delete all
entries from the list, click the Clear list button and then Yes to confirm.
You can save the Friends list to a file so that you can use it on another computer or
after reinstalling the product. To save the Friends list, click the Save button and
save it to the desired location. The file will have a .bwl extension.
To load a previously saved Friends list, click the Load button and open the
corresponding .bwl file. To reset the content of the existing list when loading a
previously saved list, select Overwrite the current list.
Click Apply and OK to save and close the Friends list.
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18.6. Configuring the Spammers List
The Spammers list is a list of all the e-mail addresses from which you don't want
to receive messages, regardless of their content. Any e-mail message received from
an address contained in the Spammers list will be automatically marked as SPAM,
without further processing.
To configure and manage the Spammers list:
● If you are using Microsoft Outlook / Outlook Express / Windows Mail / Thunderbird,
click the Spammers button on the BitDefender antispam toolbar integrated
into your mail client.

● Alternatively, follow these steps:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Antispam > Status.
3. Click Manage Spammers.

To add an e-mail address, select the E-mail address option, enter the address and
click the button next to the edit field. Syntax: name@domain.com.
To add all the e-mail addresses from a specific domain, select the Domain name
option, enter the domain name and click the button next to the edit field. Syntax:
●@domain.com, *domain.com and domain.com - all the received e-mail messages
from domain.com will be tagged as SPAM;

● *domain* - all the received e-mail messages from domain (no matter the domain
suffixes) will be tagged as SPAM;

● *com - all the received e-mail messages having the domain suffix com will be
tagged as SPAM.

It is recommended to avoid adding entire domains, but this may be useful in some
situations.

Warning
Do not add domains of legitimate web-based e-mail services (such as Yahoo, Gmail,
Hotmail or other) to the Spammers list. Otherwise, the e-mail messages received
from any registered user of such a service will be detected as spam. If, for example,
you add yahoo.com to the Spammers list, all e-mail messages coming from
yahoo.com addresses will be marked as [spam].

To delete an item from the list, select it and click the Remove button. To delete all
entries from the list, click the Clear list button and then Yes to confirm.
You can save the Spammers list to a file so that you can use it on another computer
or after reinstalling the product. To save the Spammers list, click the Save button
and save it to the desired location. The file will have a .bwl extension.
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To load a previously saved Spammers list, click the Load button and open the
corresponding .bwl file. To reset the content of the existing list when loading a
previously saved list, select Overwrite the current list.
Click Apply and OK to save and close the Spammers list.

18.7. Configuring the Antispam Filters and Settings
As described in “Antispam Insights” (p. 86), BitDefender uses a combination of
different antispam filters to identify spam. The antispam filters are pre-configured
for efficient protection.
You can disable each one of these filters or change their settings, but this is not
recommended. These are some changes you may want to make:
● Depending on whether or not you receive legitimate e-mails written in Asian or
Cyrillic characters, disable or enable the setting that automatically blocks such
e-mails.

Note
The corresponding setting is disabled in the localized versions of the program that
use such charsets (for example, in the Russian or Chinese version).

● If you do not want to automatically add the recipients of your sent mail to the
Friends list, you can disable the corresponding setting. In this case, add your
contacts to the Friends list, as described in “Configuring the Friends List” (p. 95).

● Advanced users can try to adjust the size of the Bayesian dictionary to achieve
better antispam performance. A smaller number of words will result in faster, but
less precise, antispam processing. A larger number of words will increase antispam
detection accuracy, but it will take more time to access your e-mails.

Note
It may take several adjustments of the Bayesian dictionary size to reach the desired
performance level. If the result is not as expected, set back the default and
recommended size of 200.000 words.

To configure the antispam settings and filters:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Antispam > Settings.
3. Configure the settings as needed. To find out what an option does, keep the

mouse over it and read the description displayed at the bottom of the window.
4. Click Apply to save the changes.
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To apply the default settings, click Default.
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19. Parental Control
BitDefender Parental Control enables you to control the access to the Internet and
to specific applications for each user holding a user account on the system.
You can configure Parental Control to block:
● inappropriate web pages.
● Internet access, for specific periods of time (such as when it's time for lessons).
● web pages, e-mail messages and instant messages if they contain specific
keywords.

● applications like games, chat, filesharing programs or others.
● instant messages sent by IM contacts other than those allowed.

Important
Only users with administrative rights on the system (system administrators) can
access and configure Parental Control. To make sure that only you can change the
Parental Control settings for any user, you can protect them with a password. You
will be prompted to configure the password when you enable the Parental Control
for a specific user.

Once you have configured Parental Control, you can easily find out what your children
are doing on the computer.
Even when you are not at home, you can still check on your children's activities and
change the Parental Control settings using Remote Parental Control.

19.1. Configuring Parental Control
Before you configure Parental Control, create separate Windows user accounts for
your children to use. This will allow you to know exactly what each of them is doing
on the computer. You should create limited (standard) user accounts so that they
cannot change the Parental Control settings. For more information, please refer to
“How Do I Create Windows User Accounts?” (p. 203).
If your children can access an administrator account on their computer, you must
configure a password to protect the Parental Control settings. For more information,
please refer to “Protecting Parental Control Settings” (p. 101).
To configure Parental Control:
1. Make sure you are logged on to the computer with an administrator account.

Only users with administrative rights on the system (system administrators) can
access and configure Parental Control.

2. Open BitDefender.
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3. Depending on the user interface view mode, access the Parental Control settings
as follows:
Intermediate View

Go to the Security tab and click Parental Control in the Quick Tasks area
on the left side of the window.

Expert View
Click Parental Control on the left-side menu.

Note
In Basic View and Intermediate View, you can configure a shortcut so that you can
access these settings from your dashboard. For more information, please refer to
“My Tools” (p. 33).

You can see information regarding the Parental Control status for each Windows
user account. The age category is listed below each user name if Parental Control
is enabled. If Parental Control is disabled, the status is not configured.
To configure Parental Control for a specific user account:
1. Use the switch to turn on Parental Control for that user account.
2. You will be prompted to set the Parental Control password. Set a password to

protect your Parental Control settings. For more information, please refer to
“Protecting Parental Control Settings” (p. 101).

3. Set the age category to allow your child to access only websites appropriate for
his/her age. Setting the age of the child will automatically load settings considered
appropriate for that age category, based on child development standards.

4. If you want to configure the Parental Control settings in detail, click Settings.
Click a tab to configure the corresponding Parental Control feature:
●Web - to filter web navigation according to the rules set by you in the Web
section.

● Applications - to block access to the applications specified by you in the
Applications section.

● Keywords - to filter web, mail and instant messaging access according to the
rules set by you in the Keywords section.

●Messaging - to allow or block chat with IM contacts according to the rules set
by you in the Messaging section.

Configure the monitoring options as needed:
● Send me an activity report via e-mail. An e-mail notification is sent every
time BitDefender Parental Control blocks an activity. You must first configure the
notification settings.
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● Save an internet traffic log. Logs the websites visited by users for whom
Parental Control is enabled.

For more information, please refer to “Monitoring Children Activity” (p. 107).
If you want to monitor and control your children's computer and Internet activities
remotely, turn on Remote Parental Control using the switch. For more information,
please refer to “Remote Parental Control” (p. 110).

19.1.1. Protecting Parental Control Settings
If you are not the only person with administrative rights using this computer, it is
recommended that you protect your Parental Control settings with a password. By
setting a password, you will prevent other users with administrative rights from
changing the Parental Control settings that you configured for a specific user.
BitDefender will ask you by default to set a password when enabling Parental Control.
To set the password protection, do the following:
1. Type the password in the Password field.
2. Type the password again in the Retype Password field to confirm it.
3. Click OK to save the password and close the window.
Once you set the password, if you want to change the Parental Control settings,
you will be asked to provide the password. The other system administrators (if any)
will also have to provide this password in order to change the Parental Control
settings.

Note
This password will not protect other BitDefender settings.

In case you do not set a password and you do not want this window to appear again,
check Don't ask for a password when enabling Parental Control.

Important
If you forget the password, you will have to reinstall the program or to contact
BitDefender for support.

To remove the password protection:
1. Open BitDefender and click the Options button in the upper-right corner of the

window.
2. Go to General Settings.
3. Use the switch to turn off the Settings password option.
4. Enter the password.
5. Click OK.
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19.1.2. Web Control
TheWeb Control helps you to block access to web sites with inappropriate content.
A list of candidates for blocking both sites and parts thereof is provided and updated
by BitDefender, as part of the regular update process.

Note
When you enable Parental Control and set the age of your child, Web Control is
automatically enabled and configured to block access to websites considered to be
inappropriate for your child's age.

To configure Web Control for a specific user account:
1. Access the BitDefender Parental Control settings window for that user account.
2. Click the Web tab.
3. Use the switch to turn on Web Control.
4. You can check what web categories are automatically blocked / restricted for the

currently selected age group. If you are not satisfied with the default settings,
you can configure them as needed.
To change the action configured for a specific category of web content, click the
current status and select the desired action from the menu.

5. If you want to, create your own rules to allow or block access to specific websites.
If Parental Control automatically blocks access to a website, you can create a
rule to explicitly allow access to that website.

6. You can set limits on how much time your child spends on the Internet. For more
information, please refer to “Restricting Internet Access By Time” (p. 103).

Creating Web Control Rules
To allow or block access to a website, follow these steps:
1. Click Allow Website or Block Website.
2. Enter the website address in the Website field.
3. Select the desired action for this rule - Allow or Block.
4. Click Finish to add the rule.

Managing Web Control Rules
The Website Control rules that have been configured are listed in the table on the
lower side of the window. The website address and current status are listed for each
Web Control rule.
To delete a rule, select it and click Remove.
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To edit a rule, select it and click Edit or double-click it. Make the necessary changes
in the configuration window.

Restricting Internet Access By Time
In the Schedule Web Access section, you can set limits on howmuch time your child
spends on the Internet.
To completely block access to the Internet, select Block Web Access.
To restrict Internet access to certain times of day:
1. Select Time limit web access.
2. Click Change Schedule.
3. Select from the grid the time intervals during which Internet access is blocked.

You can click individual cells, or you can click and drag to cover longer periods.
4. Click Save.

Note
BitDefender will perform updates every hour no matter if web access is blocked.

19.1.3. Application Control
The Applications Control helps you to block any application from running. Games,
media and messaging software, as well as other categories of software and malware
can be blocked this way. Applications blocked in this manner are also protected
from modifications, and cannot be copied or moved. You can block applications
permanently or just during certain time intervals, such as those when your children
should be doing their homework.
To configure Application Control for a specific user account:
1. Access the BitDefender Parental Control settings window for that user account.
2. Click the Applications tab.
3. Use the switch to turn on Application Control.
4. Create rules for the applications you want to block or restrict access to.

Creating Application Control Rules
To block or restrict access to an application, follow these steps:
1. Click Block Application or Restrict Application.
2. Click Browse to locate the application to which you want to block/restrict access.

Installed applications are usually located in the C:\Program Files folder.
3. Select the action of the rule:
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● Block permanently to block access to the application completely.
● Block based on this schedule to restrict access to certain time intervals.
If you choose to restrict access rather than block the application completely, you
must also select from the grid the days and the time intervals during which access
is blocked.

4. Click Save to add the rule.

Managing Application Control Rules
The Application Control rules that have been configured are listed in the table on
the lower side of the window. The name of the application, the path and the current
status are listed for each Application Control rule.
To delete a rule, select it and click Remove.
To edit a rule, select it and click Edit or double-click it. Make the necessary changes
in the configuration window.

19.1.4. Keywords Control
Keywords Control helps you block users' access to e-mail messages, web pages and
instant messages that contain specific words. Using Keywords Control, you can
prevent your children from seeing inappropriate words or phrases when they are
online.

Note
The instant messaging Keywords Control is only available for Yahoo Messenger and
Windows Live (MSN) Messenger.

To configure Keywords Control for a specific user account:
1. Access the BitDefender Parental Control settings window for that user account.
2. Click the Keywords tab.
3. Use the switch to turn on Keywords Control.
4. Create Keywords Control rules to block inappropriate keywords.
5. To prevent your children from giving out personal information (such as the home

address or phone number) to people they met on the Internet, you must create
Identity Control rules. For more information, please refer to “Creating Identity
Control Rules” (p. 105).

Creating Keywords Control Rules
To block a word or phrase, follow these steps:
1. Click Block Keyword.

Parental Control 104

BitDefender Total Security 2011



2. Type the word or phrase you want to block in the edit field. If you want only whole
words to be detected, select the Match whole words check box.

3. Select the traffic type BitDefender should scan for the specified word.

DescriptionOption
Web pages that contain the keyword are blocked.HTTP
E-mail messages that contain the keyword are blocked.POP3
Instant messages that contain the keyword are blocked.InstantMessaging

4. Click Finish to add the rule.

Managing Keywords Control Rules
The Keywords Control rules that have been configured are listed in the table. Detailed
information is provided for each rule.
To delete a rule, select it and click Remove.
To edit a rule, select it and click Edit or double-click it. Make the necessary changes
in the configuration window.

Creating Identity Control Rules
To create an Identity Control rule, click the corresponding Block Keyword button
and follow the configuration wizard. You can navigate through the wizard using the
Next and Back buttons. To exit the wizard, click Cancel.
1. Welcome Window
2. Set Rule Type and Data

You must set the following parameters:
● Rule Name - type the name of the rule in this edit field.
● Rule Type - choose the rule type (address, name, credit card, PIN, SSN etc).
● Rule Data - type the data you want to protect in this edit field. For example,
if you want to protect your credit card number, type all or part of it here.

Important
If you enter less than three characters, you will be prompted to validate the
data. We recommend you to enter at least three characters in order to avoid
the mistaken blocking of messages and web pages.

All of the data you enter is encrypted. For extra safety, do not enter all of the
data you wish to protect.
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3. Select Scanning Options
Select the type of traffic you want BitDefender to scan.
● Scan Web (HTTP traffic) - scans the HTTP (web) traffic and blocks the
outgoing data that matches the rule data.

● Scan e-mail (SMTP traffic) - scans the SMTP (mail) traffic and blocks the
outgoing e-mail messages that contain the rule data.

● Scan IM (Instant Messaging) traffic - scans the Instant Messaging traffic
and blocks the outgoing chat messages that contain the rule data.

You can choose to apply the rule only if the rule data matches whole words or if
the rule data and the detected string case match.

4. Describe Rule
Enter a short description of the rule in the edit field. Since the blocked data
(character string) is not displayed in plain text when accessing the rule, the
description should help you easily identify it.
Click Finish. The rule will appear in the table.

From now on, any attempt to send the specified data (through e-mail, instant
messaging or over a web page) will fail. An alert message will be displayed indicating
that BitDefender has blocked identity specific content from being sent.

19.1.5. Instant Messaging (IM) Control
The Instant Messaging (IM) Control allows you to specify the IM contacts your children
are allowed to chat with.

Note
The IM Control is only available for Yahoo Messenger and Windows Live (MSN)
Messenger.

To configure IM Control for a specific user account:
1. Access the BitDefender Parental Control settings window for that user account.
2. Click the Messaging tab.
3. Use the switch to turn on Instant Messaging Control.
4. Select the preferred filtering method and, depending on your choice, create

appropriate rules.
● Allow IM with all contacts, except the ones in the list
In this case, you must specify the IM IDs to be blocked (people who your child
should not talk to).

● Block IM with all contacts, except the ones in the list
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In this case, you must specify the IM IDs your child is explicitly allowed to
instant message with. For example, you can allow instant messaging with
family members, friends from school or neighbours.
This second option is recommended if your child is under 14 years old.

Creating Instant Messaging (IM) Control Rules
To allow or block instant messaging with a contact, follow these steps:
1. Click Block IM ID or Allow IM ID.
2. Type the e-mail address or the user name used by the IM contact in the E-mail

or IM ID field.
3. Choose the IM program the contact associates with.
4. Select the desired action for this rule - Allow or Block.
5. Click Finish to add the rule.

Managing Instant Messaging (IM) Control Rules
The IM Control rules that have been configured are listed in the table on the lower
side of the window.
To delete a rule, select it and click Remove.
To edit a rule, select it and click Edit or double-click it. Make the necessary changes
in the configuration window.

19.2. Monitoring Children Activity
BitDefender helps you keep track of what your children are doing on the computer
even when you are away.
By default, when Parental Control is enabled, your children's activities are logged.
In this way, you can always find out exactly what websites they have visited, what
applications they have used, what activities have been blocked by Parental Control
etc.
You can also configure BitDefender to send you e-mail notifications when Parental
Control blocks an activity.

19.2.1. Checking the Parental Control Logs
To check what your children have been doing recently on the computer, access the
Parental Control logs. Follow these steps:
1. Open BitDefender.
2. Click the View Logs link in the bottom-right corner of the window.
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3. Click Parental Control on the left-side menu.

Note
You can also open these logs from the Parental Control window by clicking View
Logs.

If you do not share the computer with your children, you can configure the
BitDefender home network so that you can access the Parental Control logs remotely
(from your computer). For more information, please refer to “Home Network” (p.
187).
The Parental Control logs provide detailed information about your children's computer
and Internet activities. Information is organized under several tabs:
General

Provides general information about your children's recent activities, such as
the most visited websites and the most used applications.
You can filter information by user and time period.

Application Log
Helps you find out what applications your children have been using recently.
Double-click the events in the list to see more details. To delete a log entry,
right-click it and select Delete.

Internet Log
Helps you find out what websites your children have been visiting recently.
You can filter information by user and time period.

Other Events
Helps you find out detailed information about the Parental Control activity (for
example, when Parental Control was enabled / disabled, what events have been
blocked).
Double-click the events in the list to see more details. To delete a log entry,
right-click it and select Delete.

19.2.2. Configuring E-mail Notifications
To receive e-mail notifications when Parental Control blocks an activity:
1. Open BitDefender.
2. Depending on the user interface view mode, access the Parental Control settings

as follows:
Intermediate View

Go to the Security tab and click Parental Control in the Quick Tasks area
on the left side of the window.
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Expert View
Click Parental Control on the left-side menu.

Note
In Basic View and Intermediate View, you can configure a shortcut so that you can
access these settings from your dashboard. For more information, please refer to
“My Tools” (p. 33).

3. In the Settings section, select Send me an activity report via e-mail.
4. You will be prompted to configure your e-mail account settings. Click Yes to open

the configuration window.

Note
You can open the configuration window later by clicking Notifications Settings.

5. Enter the e-mail address where the e-mail notifications are to be sent.
6. Configure the e-mail settings of the server used to send the e-mail notifications.
There are three options to configure the e-mail settings:
Use the current mail client settings

This option is selected by default when BitDefender manages to import the mail
server settings from your mail client.
Click Test Settings to validate the settings. If any issues are found during
validation, you will be informed what you have to do to correct them.

Select from one of the known servers
Select this option if you have an e-mail account with one of the web-based
e-mail services in the list.
Click Test Settings to validate the settings. If any issues are found during
validation, you will be informed what you have to do to correct them.

I want to configure the server settings myself
If you know the mail server settings, select this option and configure the settings
as follows:
●Outgoing SMTP Server - type the address of the mail server used to send
e-mail messages.

● If the server uses a different port than the default port 25, type it in the
corresponding field.

● If the server requires authentication, select the My SMTP server requires
authentication check box and type your user name and password in the
corresponding fields.

Parental Control 109

BitDefender Total Security 2011



Click Test Settings to validate the settings. If any issues are found during
validation, you will be informed what you have to do to correct them.

Click OK to save the changes and close the window.

19.3. Remote Parental Control
Remote Parental Control enables you to monitor your children's activities and to
change the Parental Control settings, even when you are not at home. All you need
is a computer with Internet access and a web browser.
Remote Parental Control offers a discreet way to check what your children are doing
online, without being intrusive.

19.3.1. Prerequisites for Using Remote Parental Control
In order to use Remote Parental Control, the following prerequisites must be met:
1. Install either BitDefender Internet Security 2011 or BitDefender Total Security

2011 on your children's computer.
2. Activate the product using a BitDefender account.
3. Enable Remote Parental Control.
4. The computer from which you want to access Remote Parental Control must be

connected to the Internet.

19.3.2. Enabling Remote Parental Control
To enable Remote Parental Control:
1. Log on to the computer on which BitDefender is installed using an administrator

account. You can use the same account that you have used to install the program.
2. Open BitDefender.
3. Depending on the user interface view mode, access the Parental Control settings

as follows:
Intermediate View

Go to the Security tab and click Parental Control in the Quick Tasks area
on the left side of the window.

Expert View
Click Parental Control on the left-side menu.

Note
In Basic View and Intermediate View, you can configure a shortcut so that you can
access these settings from your dashboard. For more information, please refer to
“My Tools” (p. 33).

Parental Control 110

BitDefender Total Security 2011



4. Use the switch to turn on Remote Parental Control. Remote Parental Control will
be enabled for all user accounts on the system.

19.3.3. Accessing Remote Parental Control
You can access Remote Parental Control from your BitDefender Account.
1. On a computer with Internet access, open a web browser and go to:

http://myaccount.bitdefender.com
2. Log in to your BitDefender account using your username and password.
3. Click the Parental Control tab to access the Remote Parental Control dashboard.
4. You can see all user accounts for which Remote Parental Control is enabled.

To check what activities have been blocked on a specific user account since your
last login, click the link indicating existing alerts.
To check on your children's recent activities, click the Recent Activity link
corresponding to their account.
To change the Parental Control settings for a specific user account, click the
corresponding Settings link.

19.3.4. Monitoring Your Children Activities Remotely
Before you can remotely monitor your children's computer and Internet activities,
you must enable Remote Parental Control on their computer. For more information,
please refer to “Enabling Remote Parental Control” (p. 110).
To check remotely what your children are doing on their computer:
1. On a computer with Internet access, open a web browser and go to:

http://myaccount.bitdefender.com
2. Log in to your BitDefender account using your username and password.
3. Click the Parental Control tab to access the Remote Parental Control dashboard.
4. To check what activities have been blocked on a specific user account since your

last login, click the link indicating existing alerts. To check on your children's
recent activities, click the Recent Activity link corresponding to their account.

On the Alerts page, you can find out what websites, applications or instant messaging
contacts have been blocked since your last login.
On the Recent Activity page, you can find out useful information about your children's
recent activities:
● which are the most accessed and the most blocked websites.
● which are the most accessed and the most blocked applications.
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●which are the most contacted and the most blocked instant messaging IDs.
You can directly block a website, an application or an instant messaging ID by
clicking the corresponding Block link.
To remove a restriction, click the corresponding Allow link.

19.3.5. Changing Parental Control Settings Remotely
Before you can remotely change the Parental Control settings configured for your
children, you must enable Remote Parental Control on their computer. For more
information, please refer to “Enabling Remote Parental Control” (p. 110).
To change the Parental Control settings remotely:
1. On a computer with Internet access, open a web browser and go to:

http://myaccount.bitdefender.com
2. Log in to your BitDefender account using your username and password.
3. Click the Parental Control tab to access the Remote Parental Control dashboard.
4. You can see all user accounts for which Remote Parental Control is enabled. To

change the Parental Control settings for a specific user account, click the
corresponding Settings link.

The Settings page displays the websites, applications and instant messaging IDs
that are explicitly blocked by Parental Control. To remove a restriction, click the
corresponding Allow link.
To find out how to set restrictions, please refer to these topics:
“Restricting Internet Access By Time” (p. 112)
“Blocking Websites” (p. 113)
“Blocking Applications” (p. 113)
“Blocking IM Contacts” (p. 113)

Restricting Internet Access By Time
Choose an option from the menu to specify when your child is allowed to access
the Internet. To restrict Internet access to certain times of day:
1. Select Schedule Internet Access.
2. Select from the grid the time intervals during which Internet access is blocked.

You can click individual cells, or you can click and drag to cover longer periods.
To start a new selection, click Block All or Allow All.

3. Click Submit Changes. Changes will be configured and applied on your child's
computer after the next synchronization with the Remote Parental Control website
(within maximum 10 minutes).
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Blocking Websites
To block a website:
1. Click Block another Website.
2. Enter the website in the corresponding field. Alternatively, if you want to block

one of the most viewed websites, select it from the menu.
3. Click Block. The website will be added to the list of blocked websites. The rule

will be configured and applied on your child's computer after the next
synchronization with the Remote Parental Control website (within maximum 10
minutes).

If you change your mind, click the corresponding Allow link.

Blocking Applications
To block an application:
1. Click Block another Application.
2. Select the application to be blocked from the list of most accessed applications.
3. Click Block. The application will be added to the list of blocked applications. The

rule will be configured and applied on your child's computer after the next
synchronization with the Remote Parental Control website (within maximum 10
minutes).

If you change your mind, click the corresponding Allow link.

Blocking IM Contacts
To block instant messaging with a specific contact:
1. Click Block another Contact.
2. Enter the instant messaging ID in the corresponding field. Alternatively, if you

want to block one of the most contacted instant messaging IDs, select it from
the menu.

3. Click Block. The instant messaging ID will be added to the list of blocked instant
messaging IDs. The rule will be configured and applied on your child's computer
after the next synchronization with the Remote Parental Control website (within
maximum 10 minutes).

If you change your mind, click the corresponding Allow link.
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20. Privacy Control
BitDefender monitors dozens of potential “hotspots” in your system where spyware
might act, and also checks any changes made to your system and software. It is
effective in blocking Trojan horses and other tools installed by hackers, who try to
compromise your privacy and send your personal information, like credit card
numbers, from your computer to the hacker.
Privacy Control includes these components:
● Identity Control - helps you make sure that your personal information is not sent
from your computer without your consent. It scans the e-mail and instant messages
sent from your computer, as well as any data sent via web pages, and blocks any
piece of information protected by the Identity Control rules you have created.

● Registry Control - asks for your permission whenever a program tries to modify
a registry entry in order to be executed at Windows start-up.

● Cookie Control - asks for your permission whenever a new website tries to set a
cookie.

● Script Control - asks for your permission whenever a website tries to activate a
script or other active content.

By default, only Identity Control is enabled. You must configure appropriate Identity
Control rules to prevent the unauthorized sending of confidential information. For
more information, please refer to “Configuring Identity Control” (p. 116).
The other components of Privacy Control are interactive. If you enable them, you
will be prompted, through alert windows, to allow or block specific actions when
you browse new web sites or install new software. This is why they are usually used
by advanced users.

20.1. Configuring Protection Level
The protection level helps you easily enable or disable the Privacy Control
components.
To configure the protection level:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Privacy Control > Status.
3. Make sure Privacy Control is enabled.
4. There are two options:

● Drag the slider along the scale to set the appropriate protection level. Click
Default Level to position the slider at the default level.

Privacy Control 114

BitDefender Total Security 2011



Use the description on the right side of the scale to choose the protection level
that better fits your security needs.

● You can customize the protection level by clicking Custom level. In the window
that will appear, select the protection controls you want to enable and click
OK.

20.2. Identity Control
Identity Control protects you against the theft of sensitive data when you are online.
Consider a simple example: you have created an Identity Control rule that protects
your credit card number. If a spyware software somehowmanages to install on your
computer, it cannot send your credit card number via e-mail, instant messages or
web pages. Moreover, your children cannot use it to buy online or reveal it to people
they met on the Internet.
To learn more, please refer to these topics:
● “About Identity Control” (p. 115).
● “Configuring Identity Control” (p. 116).
● “Managing Rules” (p. 118).

20.2.1. About Identity Control
Keeping confidential data safe is an important issue that bothers us all. Data theft
has kept pace with the development of Internet communications and it makes use
of new methods of fooling people into giving away private information.
Whether it is your e-mail or your credit card number, when they fall into the wrong
hands such information may cause you damage: you may find yourself drowning
in spam messages or you might be surprised to access an emptied account.
Identity Control protects you against the theft of sensitive data when you are online.
Based on the rules you create, Identity Control scans the web, e-mail and instant
messaging traffic leaving your computer for specific character strings (for example,
your credit card number). If there is a match, the respective web page, e-mail or
instant message is blocked.
You can create rules to protect any piece of information you might consider personal
or confidential, from your phone number or e-mail address to your bank account
information. Multiuser support is provided so that users logging on to different
Windows user accounts can configure and use their own identity protection rules.
If your Windows account is an administrator account, the rules you create can be
configured to also apply when other users of the computer are logged on to their
Windows user accounts.
Why use Identity Control?
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● Identity Control is very effective in blocking keylogger spyware. This type of
malicious applications records your keystrokes and sends them over the Internet
to a malicious person (hacker). The hacker can find out sensitive information from
the stolen data, such as bank account numbers and passwords, and use it to gain
personal benefits.
Supposing such an application manages to avoid antivirus detection, it cannot
send the stolen data by e-mail, web or instant messages if you have created
appropriate identity protection rules.

● Identity Control can protect you from phishing attempts (attempts to steal personal
information). The most common phishing attempts make use of a deceiving e-mail
to trick you into submitting personal information on a fake web page.
For example, you may receive an e-mail claiming to be from your bank and
requesting you to urgently update your bank account information. The e-mail
provides you with a link to the web page where you must provide your personal
information. Although they seem to be legitimate, the e-mail and the web page
the misleading link directs you to are fake. If you click the link in the e-mail and
submit your personal information on the fake web page, you will disclose this
information to the malicious persons who organized the phishing attempt.
If appropriate identity protection rules are in place, you cannot submit personal
information (such as your credit card number) on a web page unless you have
explicitly defined an exception for the respective web page.

● Using Identity Control rules, you can prevent your children from giving out personal
information (such as the home address or phone number) to people they met on
the Internet. Moreover, if you create rules to protect your credit card, they cannot
use it to buy things online without your consent.

20.2.2. Configuring Identity Control
If you want to use Identity Control, follow these steps:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Privacy Control > Identity.
3. Make sure Identity Control is enabled.

Note
If the option cannot be configured, go to the Status tab and enable Privacy Control.

4. Create rules to protect your sensitive data. For more information, please refer to
“Creating Identity Protection Rules” (p. 117).
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5. If needed, define specific exclusions from the rules you have created. For example,
if you have created a rule to protect your credit card number, add the web sites
where you usually use your credit card to the exclusions list. For more information,
please refer to “Defining Exclusions” (p. 118).

Creating Identity Protection Rules
To create an identity protection rule, click the Add button and follow the
configuration wizard. You can navigate through the wizard using theNext and Back
buttons. To exit the wizard, click Cancel.
1. Welcome Window
2. Set Rule Type and Data

You must set the following parameters:
● Rule Name - type the name of the rule in this edit field.
● Rule Type - choose the rule type (address, name, credit card, PIN, SSN etc).
● Rule Data - type the data you want to protect in this edit field. For example,
if you want to protect your credit card number, type all or part of it here.

Important
If you enter less than three characters, you will be prompted to validate the
data. We recommend you to enter at least three characters in order to avoid
the mistaken blocking of messages and web pages.

All of the data you enter is encrypted. For extra safety, do not enter all of the
data you wish to protect.

3. Select Traffic Types and Users
a. Select the type of traffic you want BitDefender to scan.

● Scan Web (HTTP traffic) - scans the HTTP (web) traffic and blocks the
outgoing data that matches the rule data.

● Scan e-mail (SMTP traffic) - scans the SMTP (mail) traffic and blocks the
outgoing e-mail messages that contain the rule data.

● Scan IM (Instant Messaging) traffic - scans the Instant Messaging traffic
and blocks the outgoing chat messages that contain the rule data.

You can choose to apply the rule only if the rule data matches whole words or
if the rule data and the detected string case match.

b. Specify the users for which the rule applies.
●Only for me (current user) - the rule will apply only to your user account.
● Limited user accounts - the rule will apply to you and all limited Windows
accounts.
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● All users - the rule will apply to all Windows accounts.
4. Describe Rule

Enter a short description of the rule in the edit field. Since the blocked data
(character string) is not displayed in plain text when accessing the rule, the
description should help you easily identify it.
Click Finish. The rule will appear in the table.

From now on, any attempt to send the specified data (through e-mail, instant
messaging or over a web page) will fail. An alert message will be displayed indicating
that BitDefender has blocked identity specific content from being sent.

Defining Exclusions
There are cases when you need to define exceptions to specific identity rules. Let's
consider the case when you create a rule that prevents your credit card number
from being sent over HTTP (web). Whenever your credit card number is submitted
on a website from your user account, the respective page is blocked. If you want,
for example, to buy footwear from an online shop (which you know to be secure),
you will have to specify an exception to the respective rule.
To open the window where you can manage exceptions, click Exclusions.
To add an exception, follow these steps:
1. Click the Add button to add a new entry in the table.
2. Double-click Specify excluded item and provide the web site, the e-mail address

or the IM contact that you want to add as exception.
3. Double-click Traffic type and choose from the menu the option corresponding

to the type of address previously provided.
● If you have specified a web address, select HTTP.
● If you have specified an e-mail address, select E-mail (SMTP).
● If you have specified an IM contact, select IM.

To remove an exception from the list, select it and click the Remove button.
Click OK to save the changes.

20.2.3. Managing Rules
To manage the Identity Control rules:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Privacy Control > Identity.
You can see the rules created so far listed in the table.
To delete a rule, select it and click the Delete button.
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To edit a rule select it and click the Edit button or double-click it. A new window
will appear. Here you can change the name, description and parameters of the rule
(type, data and traffic). Click OK to save the changes.

20.3. Registry Control
A very important part of the Windows operating system is called the Registry. This
is where Windows keeps its settings, installed programs, user information and so
on.
The Registry is also used to define which programs should be launched
automatically when Windows is started. Viruses often use this in order to be
automatically launched when the user restarts his computer.
Registry Control keeps an eye on the Windows Registry - this is again useful for
detecting Trojan horses. It will alert you whenever a program will try to modify a
registry entry in order to be executed at Windows start-up. For more information,
please refer to “Registry Alerts” (p. 40).
To configure Registry Control:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Privacy Control > Registry.
3. Select the corresponding check box to enable Registry Control.

Note
If the option cannot be configured, go to the Status tab and enable Privacy Control.

Managing Rules
To delete a rule, select it and click the Delete button.

20.4. Cookie Control
Cookies are a very common occurrence on the Internet. They are small files stored
on your computer. Websites create these cookies in order to keep track of specific
information about you.
Cookies are generally made to make your life easier. For example they can help
the website remember your name and preferences, so that you don't have to enter
them on every visit.
But cookies can also be used to compromise your privacy, by tracking your surfing
patterns.
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This is where Cookie Control helps. When enabled, Cookie Control will prompt you
for permission whenever a new web site tries to set or request a cookie. For more
information, please refer to “Cookie Alerts” (p. 41).
To configure Cookie Control:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Privacy Control > Cookie.
3. Select the corresponding check box to enable Cookie Control.

Note
If the option cannot be configured, go to the Status tab and enable Privacy Control.

4. You can configure rules for the web sites you visit regularly, but it is not really
necessary. Rules are automatically created through the alert window, based on
your answer.

Note
Because of the great number of cookies used on the Internet today, Cookie Control
can be quite bothersome to begin with. At first, it will ask a lot of questions about
sites trying to place cookies on your computer. As soon as you add your regular sites
to the rule-list, surfing will become as easy as before.

Creating Rules Manually
To manually create a rule, click the Add button and configure the rule parameters
in the configuration window. You can set the parameters:
●Domain address - type in the domain on which the rule should apply.
● Action - select the action of the rule.

DescriptionAction
The cookies on that domain will execute.Allow
The cookies on that domain will not execute.Deny

●Direction - select the traffic direction.

DescriptionType
The rule applies only for the cookies that are sent out back
to the connected site.

Outgoing

The rule applies only for the cookies that are received from
the connected site.

Incoming
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DescriptionType
The rule applies in both directions.Both

Note
You can accept cookies but never return them by setting the action to Deny and the
direction to Outgoing.

Click Finish.

Managing Rules
To delete a rule, select it and click the Delete button. To modify the rule
parameters, select the rule and click the Edit button or double-click it. Make the
desired changes in the configuration window.

20.5. Script Control
Scripts and other codes such as ActiveX controls and Java applets, which are used
to create interactive web pages, can be programmed to have harmful effects. ActiveX
elements, for example, can gain total access to your data and they can read data
from your computer, delete information, capture passwords and intercept messages
while you're online. You should only accept active content from sites you fully know
and trust.
If you enable Script Control, you will be prompted for permission whenever a new
web site tries to run a script or other active content. For more information, please
refer to “Script Alerts” (p. 40).
To configure Script Control:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Privacy Control > Script.
3. Select the corresponding check box to enable Script Control.

Note
If the option cannot be configured, go to the Status tab and enable Privacy Control.

4. You can configure rules for the web sites you visit regularly, but it is not really
necessary. Rules are automatically created through the alert window, based on
your answer.
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Creating Rules Manually
To manually create a rule, click the Add button and configure the rule parameters
in the configuration window. You can set the parameters:
●Domain address - type in the domain on which the rule should apply.
● Action - select the action of the rule.

DescriptionAction
The scripts on that domain will execute.Allow
The scripts on that domain will not execute.Deny

Click Finish.

Managing Rules
To delete a rule, select it and click the Delete button. To modify the rule
parameters, select the rule and click the Edit button or double-click it. Make the
desired changes in the configuration window.
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21. Firewall
The Firewall protects your computer from inbound and outbound unauthorized
connection attempts. It is quite similar to a guard at your gate - it will keep a watchful
eye on your Internet connection and keep track of who to allow access to the Internet
and who to block.

Note
A firewall is essential if you have a broadband or DSL connection.

In Stealth Mode your computer is “hidden” from malicious software and hackers.
The firewall module is capable of automatically detecting and protecting against
port scans (streams of packets sent to a machine in order to find “access points”,
often in preparation for an attack).

21.1. Protection Settings
To enable/disable and configure firewall protection, open BitDefender and, depending
on the user interface view mode, proceed as follows:
Intermediate View

Go to the Security tab and click Configure Firewall in the Quick Tasks area
on the left side of the window. Select the Settings tab in the new window that
appears.

Expert View
Go to Firewall > Settings.

Important
To be protected against Internet attacks keep the Firewall enabled.

At the top of the section, you can see various statistics regarding detected activity.
At the bottom of the section you can see the BitDefender statistics regarding
incoming and outgoing traffic. The graph shows the Internet traffic volume over the
last two minutes.

Note
The graph is displayed only in Expert View.

21.1.1. Setting the Default Action
By default, BitDefender automatically allows all known programs from its white list
to access network services and the Internet. For all the other programs, BitDefender
prompts you through an alert window to specify the action to be taken. The action
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you specify is applied every time the respective application requests network/Internet
access.

Note
To view the BitDefender white list, click the corresponding button located in the
Settings tab in Expert View or the Programs tab in Intermediate View.

You can drag the slider along the scale to set the default action to be taken on the
applications requiring network/Internet access.
● Allow All
● Allow Known Programs
● Report
● Deny All
When you select an action a brief explanation is displayed for it.

21.1.2. Configuring Advanced Firewall Settings
In Expert View, you can configure the advanced firewall settings by clicking
Advanced Settings.
The following options are available:
● Enable Internet Connection Sharing(ICS) support - enables support for
Internet Connection Sharing(ICS).

Note
This option does not automatically enable ICS on your system, but only allows this
type of connection in case you enable it from your operating system.

●Detect applications that changed since the firewall rule has been created
- checks each application attempting to connect to the Internet to see if it has
been changed since the rule controlling its access was added. If the application
has been changed, an alert will prompt you to allow or to block the access of the
application to the Internet.

Note
Applications might be changed by malware. We recommend you to keep this option
selected and to allow access only to those applications that you expect to have
changed after the rule controlling their access was created.

Signed applications are supposed to be trusted and have a higher degree of
security. You can checkDon't detect changes in digitally signed applications
in order to allow changed signed applications to connect to the Internet without
your receiving an alert about this event.
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● Show Wi-Fi Notifications - if you are connected to a wireless network, displays
informative windows regarding specific network events (for example, when a new
computer has joined the network).

● Block port scans - detects and blocks attempts to find out which ports are open.
Port scans are frequently used by hackers to find out which ports are open on
your computer. They might then break into your computer if they find a less
secure or vulnerable port.

● Enable strict automatic rules - creates strict rules using the firewall alert
window. With this option selected, BitDefender will prompt you for action and
create rules for each different process that opens the application requesting
network or Internet access.

21.2. Application Access Rules
To manage the firewall rules controlling applications' access to network resources
and Internet, open BitDefender and, depending on the user interface view mode,
proceed as follows:
Intermediate View

Go to the Security tab and click Configure Firewall in the Quick Tasks area
on the left side of the window. Select the Programs tab in the new window
that appears.

Expert View
Go to Firewall > Programs.

Intermediate View gives you access to basic configuration settings. To have more
customization options, use Expert View.

21.2.1. Viewing Current Rules
You can see the programs (processes) for which firewall rules have been created
in the table.
In Expert View, you can learn detailed information about each rule, as indicated by
the table columns. To see the rules created for a specific application, click the +
box next to the respective application. Clear the Hide system rules check box if
you want to also see the rules regarding the system or the BitDefender processes.
● Process/Network Types - the process and the network adapter types the rule
applies to. Rules are automatically created to filter network or Internet access
through any adapter. You can manually create rules or edit existing rules to filter
an application's network or Internet access through a specific adapter (for example,
a wireless network adapter).

● Command Line - the command used to start the process in the Windows
command line interface (cmd).
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● Protocol - the IP protocol the rule applies to. You may see one of the following:

DescriptionProtocol
Includes all IP protocols.Any
Transmission Control Protocol - TCP enables two hosts to establish
a connection and exchange streams of data. TCP guarantees

TCP

delivery of data and also guarantees that packets will be delivered
in the same order in which they were sent.
User Datagram Protocol - UDP is an IP-based transport designed
for high performance. Games and other video-based applications
often use UDP.

UDP

Represents a specific IP protocol (other than TCP and UDP). You
can find the complete list of assigned IP protocol numbers at
www.iana.org/assignments/protocol-numbers.

A number

●Network Events - the network events the rule applies to. The following events
may be taken into account:

DescriptionEvent
Preliminary exchange of standard messages used by
connection-oriented protocols (such as TCP) to establish a

Connect

connection. With connection-oriented protocols, data traffic
between two computers occurs only after a connection is
established.
Flow of data between two computers.Traffic
State in which an application monitors the network awaiting to
establish a connection or to receive information from a peer
application.

Listen

● Local Ports - the ports on your computer the rule applies to.
● Remote Ports - the ports on the remote computers the rule applies to.
● Local - whether the rule applies only to computers in the local network.
● Action - whether the application is allowed or denied access to network or Internet
under the specified circumstances.

21.2.2. Adding Rules Automatically
With Firewall enabled, BitDefender monitors all applications and automatically
creates a rule whenever an application tries to connect to the Internet. Depending
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on the application and the BitDefender firewall settings, this is done with or without
your intervention.
If you are using Basic View or Intermediate View, connection attempts coming from
unknown applications will be automatically blocked.
If you are using Expert View, you will be prompted for action, through an alert
window, whenever an unknown application tries to connect to the Internet.
You can see the following: the application that is trying to access the Internet, the
path to the application file, the destination, the protocol used and the port on which
the application is trying to connect.
Click Allow to allow all traffic (inbound and outbound) generated by this application
from the local host to any destination, over the respective IP protocol and on all
ports. If you click Block, the application will be denied access to the Internet over
the respective IP protocol completely.

Important
Allow inbound connection attempts only from IPs or domains you are sure to trust.

Based on your answer, a rule will be created, applied and listed in the table. The
next time the application tries to connect, this rule will be applied by default.

21.2.3. Adding Rules Manually
Creating rules manually differs depending on the user interface viewmode you use.
Intermediate View

1. Click Browse under Add New Program.
2. Locate the program for which you want to create a rule and click Open.
3. Click Add rule.

Notice that the rule is now displayed in the table.
4. Select an action from the Action column: allow or deny access.

The action will be applied to all rule parameters.
Expert View

1. Click the Add rule button. The configuration window will appear.
2. Configure the main and the advanced parameters as needed.
3. Click OK to add the new rule.

Rules can be modified only when configuring the firewall in Expert View. To modify
an existing rule, follow these steps:
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1. Click the Edit rule button or double-click the rule. The configuration window will
appear.

2. Configure the main and the advanced parameters as needed.
3. Click OK to save the changes.

Configuring Main Parameters
The Main tab of the configuration window allows configuring the main rule
parameters.
You can configure the following parameters:
● Program Path. Click Browse and select the application the rule applies to. If
you want the rule to apply to all applications, select Any.

● Command line. If you want the rule to apply only when the selected application
is opened with a specific command in the Windows command line interface, clear
the Any check box and type the respective command in the edit field.

● Protocol. Select from the menu the IP protocol the rule applies to.
▶ If you want the rule to apply to all protocols, select Any.
▶ If you want the rule to apply to TCP, select TCP.
▶ If you want the rule to apply to UDP, select UDP.
▶ If you want the rule to apply to a specific protocol, select Other. An edit field
will appear. Type the number assigned to the protocol you want to filter in the
edit field.

Note
IP protocol numbers are assigned by the Internet Assigned Numbers Authority
(IANA). You can find the complete list of assigned IP protocol numbers at
www.iana.org/assignments/protocol-numbers.

● Events. Depending on the selected protocol, choose the network events the rule
applies to. The following events may be taken into account:

DescriptionEvent
Preliminary exchange of standard messages used by
connection-oriented protocols (such as TCP) to establish a

Connect

connection. With connection-oriented protocols, data traffic
between two computers occurs only after a connection is
established.
Flow of data between two computers.Traffic
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DescriptionEvent
State in which an application monitors the network awaiting to
establish a connection or to receive information from a peer
application.

Listen

● Adapter Types. Select the adapter types the rule applies to.
● Action. Select one of the available actions:

DescriptionAction
The specified application will be allowed network / Internet access
under the specified circumstances.

Allow

The specified application will be denied network / Internet access
under the specified circumstances.

Deny

Configuring Advanced Parameters
The Advanced tab of the configuration window allows configuring advanced rule
parameters.
You can configure the following advanced parameters:
●Direction. Select from the menu the traffic direction the rule applies to.

DescriptionDirection
The rule applies only for the outgoing traffic.Outbound
The rule applies only for the incoming traffic.Inbound
The rule applies in both directions.Both

● IP version. Select from the menu the IP version (IPv4, IPv6 or any) the rule
applies to.

● Local Address. Specify the local IP address and port the rule applies to as
follows:
▶ If you have more than one network adapters, you can clear the Any check box
and type a specific IP address.

▶ If you have selected TCP or UDP as protocol you can set a specific port or a
range between 0 and 65535. If you want the rule to apply to all ports, select
Any.
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● Remote Address. Specify the remote IP address and port the rule applies to as
follows:
▶ To filter traffic between your computer and a specific computer, clear the Any
check box and type its IP address.

▶ If you have selected TCP or UDP as protocol you can set a specific port or a
range between 0 and 65535. If you want the rule to apply to all ports, select
Any.

● Apply this rule only to directly connected computers. Select this option
when you want the rule to apply only to the local traffic attempts.

● Check process parent chain for the original event. You can only modify
this parameter if you have selected Strict automatic rules (go to the Settings
tab and click Advanced Settings). Strict rules mean that BitDefender prompts
you for action when an application request network/Internet access every time
the parent process is different.

21.2.4. Advanced Rule Management
If you need to see and edit the rules controlling applications in detail, click the
Advanced button available when configuring the firewall in Expert View.
You can see the firewall rules listed by the order they are checked in. The table
columns provide comprehensive information about each rule.

Note
When a connection attempt is made (whether incoming or outgoing), BitDefender
applies the action of the first rule matching the respective connection. Therefore, the
order by which rules are checked is very important.

To delete a rule, select it and click the Delete Rule button.
To edit an existing rule, select it and click the Edit Rule button or double-click it.
You can increase or decrease the priority of a rule. Click the Move Up In List
button to increase the priority of the selected rule by one level, or click the Move
Down In List button to decrease the priority of the selected rule by one level. To
assign a rule the highest priority, click the Move First button. To assign a rule
the lowest priority, click the Move Last button.
Click Close to close the window.

21.2.5. Deleting and Reseting Rules
Deleting and reseting rules is possible only when configuring the firewall in Expert
View.
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To delete a rule, select it and click the Remove rule button. You can select and
delete several rules at once.
If you want to delete all the rules created for a specific application, select the
application from the list and click the Remove rule button.
If you want to load the default rule set for the selected trust level, click Reset Rules.

21.3. Network Settings
To configure the network connection settings, open BitDefender and, depending on
the user interface view mode, proceed as follows:
Intermediate View

Go to the Security tab and click Configure Firewall in the Quick Tasks area
on the left side of the window. Select the Network tab in the new window that
appears.

Expert View
Go to Firewall > Network.

The columns in the Network Configuration table provide detailed information on
the network you are connected to and allow you to configure the connection settings:
● Adapter - the network adapter your computer uses to connect to the network or
the Internet.

●Network Type - the type of network the adapter connects to. Depending on the
network adapter configuration, BitDefender may automatically select a network
type or prompt you for more information.
Change the type by clicking the arrow from the Network Type column and
selecting one of the available types from the list.

DescriptionNetwork Type
Disable the firewall for the respective adapter.Trusted (Allow

All)
Allow all traffic between your computer and computers in
the local network.

Home/Office

All traffic is filtered.Public
Completely block network and Internet traffic through the
respective adapter.

Untrusted (Block
All)

● VPN - whether the connection is a VPN.
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Traffic going through VPN connections is filtered differently than traffic going
through other network connections. If the connection is a VPN, click the arrow
from the VPN column and select Yes.

In Expert View, two additional columns are displayed:
● Stealth Mode - whether you can be detected by other computers.
To configure the Stealth Mode, click the arrow from the Stealth Mode column
and select the desired option.

DescriptionStealth option
Stealth Mode is on. Your computer is not visible from
both the local network and the Internet.

On

Stealth Mode is off. Anyone from the local network
or the Internet can ping and detect your computer.

Off

Your computer cannot be detected from the Internet.
Local network users can ping and detect your
computer.

Remote

●Generic - whether generic rules are applied to this connection.
If the IP address of a network adapter is changed, BitDefendermodifies the network
type accordingly. If you want to keep the same type, click the arrow from the
Generic column and select Yes.

21.3.1. Network Zones
You can add allowed or blocked computers for a specific adapter.
A trusted zone is a computer that you fully trust. All traffic between your computer
and a trusted computer is allowed. To share resources with specific computers in
an unsecured wireless network, add them as allowed computers.
A blocked zone is a computer that you do not want to communicate at all with your
computer.
The Network Zones table displays the current network zones per adapter.
To add a zone, select the adapter and click Add Zone. A new window will appear.
Proceed as follows:
1. Select the IP address of the computer you want to add.
2. Select the action:

● Allow - to allow all traffic between your computer and the selected computer.
●Deny - to block all traffic between your computer and the selected computer.

Firewall 132

BitDefender Total Security 2011



3. Click OK.

21.4. Devices
To manage devices connected to the network, open BitDefender and, depending
on the user interface view mode, proceed as follows:
Intermediate View

Go to the Security tab and click Configure Firewall in the Quick Tasks area
on the left side of the window. Select the Devices tab in the new window that
appears.

Expert View
Go to Firewall > Devices.

The printers, faxes and scanners detected in the network and the default actions
set for them are listed in the table. To change the status of a device, double-click
it in the table and select an action in the window that appears: allow or block
communication with the device.
Use the provided buttons to manage the device list:
● Add - add a device which does not appear in the list.
● Remove - remove a selected device from the list.
● Refresh Devices - initiate a new scan of the network to update the device list.

21.5. Connection Control
To monitor the current network / Internet activity (over TCP and UDP) sorted by
application and to open the BitDefender Firewall log, follow these steps:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Firewall > Activity.
You can see the total traffic sorted by application. For each application, you can see
the connections and the open ports, as well as statistics regarding the outgoing &
incoming traffic speed and the total amount of data sent / received.
If you want to see the inactive processes too, clear the Hide inactive processes
check box.
The meaning of the icons is as follows:
● Indicates an outgoing connection.
● Indicates an incoming connection.
● Indicates an open port on your computer.
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The window presents the current network / Internet activity in real-time. As
connections or ports are closed, you can see that the corresponding statistics are
dimmed and that, eventually, they disappear. The same thing happens to all statistics
corresponding to an application which generates traffic or has open ports and which
you close.
For a comprehensive list of events regarding the Firewall module usage
(enabling/disabling firewall, traffic blocking, modifying settings) or generated by
the activities detected by this module (scanning ports, blocking connection attempts
or traffic according to the rules) view the BitDefender Firewall log file by clicking
Show Log. The file is located in the Common Files folder of the current Windows
user, under the path: ...BitDefender\BitDefender
Firewall\bdfirewall.txt.
If you want the log to contain more information, select Increase log verbosity.

21.6. Troubleshooting Firewall
In case you experience an issue you suspect is caused by the BitDefender Firewall,
a Troubleshoot Wizard is available to help you solve it.
To start the wizard, open BitDefender and, depending on the user interface view
mode, proceed as follows:
Intermediate View

Go to the Security tab and click Configure Firewall in the Quick Tasks area
on the left side of the window. Select the Settings tab in the new window that
appears and click Troubleshoot.

Expert View
Go to Firewall > Settings and click Troubleshoot.

The wizard can help you quickly solve the following connectivity problems commonly
associated with the firewall configuration:
● I am trying to print and the action fails.
● I am trying to access a computer in my network and the action fails.
● I am trying to access the Internet and the action fails.
If none of the situations describes the problem you are experiencing, select Other
Firewall Problem to open the Support Tool window.
For more information on this wizard, please refer to the Troubleshooting section of
this guide
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22. Vulnerability
An important step in protecting your computer against malicious persons and
applications is to keep up to date the operating system and the applications you
regularly use. Moreover, to prevent unauthorized physical access to your computer,
strong passwords (passwords that cannot be easily guessed) must be configured
for each Windows user account.
BitDefender regularly checks your system for vulnerabilities and notifies you about
the existing issues.

22.1. Checking for Vulnerabilities
You can check for vulnerabilities and fix them step by step by using the
Vulnerability Scan wizard. To start the wizard, open BitDefender and, depending
on the user interface view mode, proceed as follows:
Intermediate View

Go to the Security tab and click Vulnerability Scan in the Quick Tasks area
on the left side of the window.

Expert View
Go to Vulnerability > Status and click Check Now.

Follow the six-step guided procedure to remove vulnerabilities from your system.
You can navigate through the wizard using the Next button. To exit the wizard,
click Cancel.
1. Protect your PC

Select vulnerabilities to check.
2. Scan selected issues...

Wait for BitDefender to finish checking your system for vulnerabilities.
3. Windows Updates

You can see the list of critical and non-critical Windows updates that are not
currently installed on your computer. Select the updates you want to install.

4. Application Updates
If an application is not up to date, click the provided link to download the latest
version.

5. Weak Passwords
You can see the list of the Windows user accounts configured on your computer
and the level of protection their password provides. Click Fix to modify the weak
passwords.

6. Summary
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This is where you can view the operation result.

22.2. Status
To see the current vulnerability status and enable/disable automatic vulnerability
scanning, follow these steps:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Vulnerability > Status.
The table displays the issues covered in the last vulnerability check and their status.
You can see the action you have to take to fix each vulnerability, if any. If the action
is None, then the respective issue does not represent a vulnerability.

Important
To be automatically notified about system or application vulnerabilities, keep the
Automatic Vulnerability Scanning enabled.

Depending on the issue, to fix a specific vulnerability proceed as follows:
● If Windows updates are available, click Install in the Action column to install
them.

● If an application is outdated, clickMore info to view version information and find
a link to the vendor web page from where you can install the latest version of
that application.

● If a Windows user account has a weak password, click View & Fix to force the
user to change the password at the next logon or change the password yourself.
For a strong password, use a combination of uppercase and lowercase letters,
numbers and special characters (such as #, $ or @).

● If the Media Autorun feature is enabled in Windows, click Fix to disable it.

22.3. Settings
To configure the settings of the automatic vulnerability checking, follow these steps:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Vulnerability > Settings.
3. Select the check boxes corresponding to the system vulnerabilities you want to

be regularly checked.
● Critical Windows Updates
● Regular Windows Updates
● Application Updates
●Weak Passwords
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●Media Autorun

Note
If you clear the check box corresponding to a specific vulnerability, BitDefender
will no longer notify you about the related issues.
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23. Backup
BitDefender comes with a Backup module that helps you make reserve copies of
any valuable data on your system. You can backup your data on your computer,
removable disks or a network location to make sure you can restore them when
necessary. The restoration of your data is an easy process.
The following tasks help you easily backup and restore your data:
● Local Backup - an easy five-step procedure to back your data up locally.
● Local Restore - an easy four-step procedure to restore your data backed-up locally.
You can set up and execute backup operations in detail by using BitDefender Backup
Settings.

23.1. Backing Up Data Locally
The Local Backup Wizard will guide you through the process of creating a local
backup task. At the end of this process, you will be able to back your files up on the
spot or schedule the product to back them up at a later moment.
To start the wizard, open BitDefender and, depending on the user interface view
mode, proceed as follows:
Intermediate View

Go to the File Storage tab, click Backup Locally in the Quick Tasks area on
the left side of the window and select Local Backup.

Expert View
Go to Backup and click Backup Locally.

Note
You can also add a shortcut to My Tools.

You can navigate through the wizard using the Next and Back buttons. To exit the
wizard, click Cancel.
1. Welcome Window
2. Choose what to Backup

You can choose either Quick Backup (your music, videos, pictures, emails,
applications settings, etc.) or Full Backup (all partitions).
Click Other files, to add other files from your Desktop to Quick Backup. Full
Backup can also be easily customized by selecting what directories to backup
from a certain partition.

3. Choose where to Backup
Here you can select the location of the backed-up data.
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If you decide to back your data up on your computer, your USB drive or on a
network location, click Choose location and select where to save the data to.
If you want to back your data up on an FTP server, click Choose location and
add the FTP server. A new window will appear.
You must configure the FTP server connection settings as follows:
a. Type the FTP server name in the corresponding field.
b. If the FTP server uses a different port than default port 21, type it in the

corresponding field.
c. To use passive mode (the FTP server initiates the connection), select the

Passive Mode check box.
d. If the FTP server allows anonymous access, you can leave the Anonymous

option selected. Otherwise, select User Name and type the user name and
password of an account recognized by the FTP server.

e. Click OK.
4. Choose when to Backup

Here you can select when to back up your data.
To back your files up on the spot click Only backup the data this time, to
schedule the product to backup your files at a later moment, click Backup the
data on a schedule I specify.
If you select Backup the data on a schedule I specify, you can specify how
often the scheduled task runs: daily or weekly. You can also specify the start date
and time.

5. Summary
Here you can review the backup job settings and start the backup.
You must type a task name into the corresponding field.
Click Start backup if you are satisfied with your settings. Wait for BitDefender
to complete the backup and then click Finish.

Note
The first time you create a scheduled backup job, you will be prompted to specify
the Windows account used to run the job.
To use the current user account, just type its password in the corresponding field.
If you want to run the backup under a different account, select The following
Windows user and fill in the fields.
●User name - type the name of the Windows account.
● Password - type the password of the previously specified user account.
● Server - type the domain server name.
Click OK to continue.
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23.2. Restoring Locally Backed-Up Data
The Local Restore Wizard helps you restore data that you backed up on a local
storage medium. At the end of this process, you will be able to back your files up
on the spot or schedule the product to back them up at a later moment.

Note
Before restoring any data, make sure that the device where you backed the data up
is available. Depending on the device you used, you may need to take one of these
actions:
● Insert the backup USB stick into a USB port.
● Insert the backup CD/DVD into the drive.
● Check if you can connect to the network location or FTP server where the backup
is stored.

To start the wizard, open BitDefender and, depending on the user interface view
mode, proceed as follows:
Intermediate View

Go to the File Storage tab, click Backup Locally in the Quick Tasks area on
the left side of the window and select Local Restore.

Expert View
Go to Backup and click Local Restore.

You can navigate through the wizard using the Next and Back buttons. To exit the
wizard, click Cancel.
1. Welcome Window
2. Choose where to Backup from

Here you can select a location where you want to restore files from.
After selecting an option, click Choose location and select the backup file that
you want to restore.

3. Choose the Restore Location and Files
Here you can choose which specific files to restore and where to restore them
to.
If you want to restore data to another location or specific files only, select the
location and data by clicking the corresponding button.
To avoid overwriting the existing file when restoring, clear theOverwrite existing
files when restoring check box.

4. Summary
Here you can review the restore job settings and start the restoring process.
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Click Restore if you are satisfied with your settings. Wait for BitDefender to
restore the selected data and then click Finish.

23.3. Backup Settings
If you need to perform more complex backup and restore operations, you can use
the fully-featured BitDefender Backup solution. BitDefender Backup offers:
● a variety of backup options, such as compression, encryption, filtering files to
back up or setting backup speed.

● refined control when restoring files (for example, you can restore the data you
backed up at a specific point in time).

● advanced scheduling capabilities (for example, you can choose to start the backup
job at system start or when the computer is idle).

● a log viewer that helps you keep track of the backup and restore operations you
perform and troubleshoot eventual errors.

To open BitDefender Backup, follow these steps:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Backup and click Settings .
There are two ways you can set up and execute backup operations. You either
access the upper Menu Bar or click a certain tab from the Navigator Bar.
The Navigator Bar, displayed at the top of the main window and under theMenu
Bar, gives access to four sections:
●Get Started
● Job Manager
● Log Viewer
● Toolbox

23.3.1. Get Started
Get Started helps you easily back up e-mails, chat records and data.
You can change to Get Started by doing one of the following:
● Click Get Started in Navigator Bar.
● Click View in the Menu Bar and select Get Started.
● Use a shortcut by pressing CTRL+Alt+S.
To backup your key documents, photos, emails and chatting records during the
same job, click the Backup My Data button and follow the three step procedure.
To backup your emails only, click the Backup My Emails button and follow the
three step procedure.
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To backup your chat records only, click the Backup My Chat Records button and
follow the three step procedure.

Note
The three step procedure is described in the “Create New Job” (p. 142) section.

23.3.2. Job Manager
Job Manager is used to view and manage backup jobs, view job properties and job
reports as well as to monitor the job execution speed. Job Manager allows checking
the job properties and current state, modifying job settings as well as performing
job backup or restore.
You can change to Job Manager by doing one of the following:
● Click Job Manager in Navigator Bar.
● Click View in the Menu Bar and select Job Manager.
● Use a shortcut by pressing CTRL+Alt+M.
On the left, you will see a list of quick operation links, as follows:
Job Management

● Create New Job
● Backup Job
● Scheduled Job
●Delete Job Schedule
●Modify Job Options
●Modify Job Properties

Job Restoration
● Restore File
● Restore Time-Point Data

Job Control
● Pause Job
● Stop Job
● Stop All

Create New Job
To backup your key documents, photos, emails and chatting records during the
same job, click the Create New Job button and follow the next three steps.
1. Click the check box to select partitions, directories, or files to backup.

When you select an item in the left side window, its content will be displayed on
the right side window to help you refine your selection.

2. Type a name for your backup job or accept the default job name.
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Default job name is automatically generated when files or directories are selected
to be backed up, but it can be modified.

3. Click Browse to choose where to save your backup job.

Note
Do not forget to click Backup to begin or Cancel to stop.
To refine your settings, click Options.

Backup Options Dialog Box
There are several sub-options in the Options dialog box.
Backup Type

BitDefender Backup supports two backup types.
● Full Backup: Completely backs up the selected data source to the backup
set on the specified destination. When executing full backup, BitDefender
Backup will not back up only the changed data but the whole data source.

● Incremental Backup: When first executing it, Incremental Backup is the
same as Full Backup in that it completely backs up the data source to the
backup set on the specified destination. Later on, it only backs up newly
created or changed files. Whenever an Incremental Backup is executed, a
backup catalog set is created.

Incremental and Full Backup can also combine into a Rotation Backup. For
example, you can set an Incremental Backup of the job while setting a Full
Backup once a week, let's say on Sunday. This is how it is done: SelectWeekly
from the drop-down menu, 1 from the Every week field and check Sunday.
This Sunday Full Backup will replace all prior backup and it will be the basis the
new Incremental Backup starts on.

Catalog Set
It is used to index the file information of every backup, and it is the basis of the
Incremental Backup and Restore process. The catalog set (*.ecs) contains a
series of catalogs that represent an index of all files and directories in the
backup set. Such index includes data on the backup time, backup directory,
file name and properties. Data can be restored from the catalog set.
A catalog set file name is generated automatically by job destination. To modify
the catalog set of a job do the following:
1. Click Catalog Set.
2. Type a file name into the corresponding field.
3. Click Browse to select the directory to save Catalog set files.
4. Click OK.

Data Compression
BitDefender Backup allows compressing and saving data to the backup set
when executing backup to save space. It supports Quick Compression, Standard
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Compression, High Intensity Compression. For example, to start standard
compression at a medium compression rate and speed, follow these steps:
1. Click Data Compression.
2. Click Standard Compression.
3. Click OK.

Destination Span
BitDefender Backup allows distributing the backup set to a different destination.
In this case, even if a certain destination does not have enough free space,
data backup execution will continue.
You can add one or more destinations to continue backup, modify or even
remove them, in one of the following ways:
1. Click Destination Span.
2. Click Add to select a new destination to save backup data.
3. Click Edit to modify the selected backup destination.
4. Click Delete to delete the selected backup destination.
5. Click Delete All to delete all backup destinations.
6. Click OK.

Encryption
BitDefender Backup keeps backed-up data safer by encrypting them before
saving it to the backup set. The security settings of a job include password
protection.
To encrypt data before backup, follow these steps:
1. Click Encryption.
2. Choose an encryption type from the drop-down menu.
3. Type your password into the corresponding field.
4. Retype your password into the corresponding field.
5. Click OK.

External Program
The job can run other command before or after backup, and the command can
be .exe, .com or .bat, or a specific type of event such as "shut down computer
after backup finished".
To execute the command when backup begins, follow these steps:
1. Click External Program
2. Select Before Job Execution option.
3. Click Browse to select command files to execute.
4. Click OK.
To execute command after backup finished, follow these steps:
1. Click External Program
2. Select the After Job Execution option.
3. Click Browse to select the command files to execute.
4. Or click Shut down computer when backup finishes.
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5. Or click Restart computer when backup finishes.
6. Or click Logoff the current user when backup finishes.
7. Click OK.

Note
If you want the configuration to work even in case of backup failure, check box
Run External Application even job Execution failed.

File Filter
BitDefender Backup provides a powerful filtering function to exclude or include
specified files, file types or directories, to save storage space and to improve
backup speed.
Specified file type can be filtered by following these steps:
1. Click File Filter.
2. Click Filter Type.
3. Exclude or include file types in the pop-up dialog box by checking the Include

only selected file types or Exclude selected file types options.
4. If necessary, type another file type into the Custom type field but make

sure to use the .abc format. Use , (coma) as separator when typing more
than one custom type. Add a short description into the corresponding field.

5. Click OK.
Specified file can be filtered by following these steps:
1. Click File Filter.
2. Click Filter File.
3. Exclude or include specific files in the pop-up dialog box by checking the

Include only the rule-specified files or Exclude the rule-specified files
options.

4. Click Browse and select the file. The path to the file location will be
automatically added in the Applied to the following directories field. To
include or exclude the file irrespective of its location, click Applied to all
directories.

5. Click OK.
Specified directory can be filtered by following these steps:
1. Click File Filter.
2. Click Filter Directory.
3. Exclude or include specific directories in the pop-up dialog box by checking

the Include only the rule-specified directories or Exclude the
rule-specified directories options.

4. Click Browse and select the directory. The path to the directory location will
be automatically added in the Applied to the following directories field.
To include or exclude directories irrespective of their location, click Applied
to all directories.

5. Click OK.

Backup 145

BitDefender Total Security 2011



Filters can be modified by following these steps:
1. Click File Filter.
2. Click the filter you wish to modify and click Edit.
3. Modify your options in the dialog box.
4. Click OK.
Filters can be deleted by following these steps:
1. Click File Filter.
2. Click the filter you wish to remove and click Delete.
3. Or click Delete All directly, to delete all filters.
4. Click OK.

Network Transfer
BitDefender Backup allows backing up and restoring shared data on workgroup
networks thoroughly. If the network is not accessible, it will retry to back the
data up from time to time. To specify how often and how many times to retry
backup, follow these steps.
1. Click Network Transfer.
2. Click When failed to read network files for disconnection, try to

reconnect.
3. Type how often you want to retry data backup (in seconds).
4. Type how many times to retry backup.
5. Click OK.

Note
To avoid being overwhelmed by information on network errors, click No error
report is generated when network is not available.

Split Backup Set
The generated backup set can be split into several other backup sets, so that
backup can be executed normally even when the destination or file system is
limited. BitDefender Backup provides two splitting methods: auto-split and
sized-split.
The backup splitting settings of the job can be modified as follows:
1. Click Split Backup Set.
2. Select Automated Split by Destination Space.
3. Or select Specify size to split and choose the desired size from the drop

down menu.
4. Click OK.

Speed
BitDefender Backup supports three kinds of speed. The higher the speed, the
more CPU will be taken.
Backup Speed can be specified by following these steps.
1. Click Speed.
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2. Select Fastest, Medium or Lowest speed.
3. Click OK.

Data Verification
To make sure your backup data is always safe, follow these steps.
1. Click Data Verification.
2. Click Verify data in backup process.
3. Click OK.

Backup Job
Once the job was created , backup is automatically executed. However, you can
enter Job Manager to execute backup by selecting the created job and clicking
Backup Job in the menu.
In order to receive backup details when restoring files, you must type a short
description in the pop-up window that opens. Click Cancel to ignore the pop-up
window or OK to go on. The backup job can also be canceled by clicking the Cancel
Backup button.

Note
For detailed information, a good idea would be to see Properties, Reports and
Execution Info of the job from the state bar window.

Schedule Job
This is where you can schedule the backup job at a convenient time. You can
schedule job to be executed daily, weekly, monthly or at any specified time (for
example at system startup). Schedule Job is the basis of automated backup.
If your computer is a member of a domain network, a series of extra steps are
necessary to add a job scheduler.
1. Select the job and click Schedule Job.
2. The Running User dialog box will appear. If you are the domain user, please

enter the domain password.
3. Otherwise select Run as the following Windows user.
4. Type the user name, password and the domain server name.
5. Click OK.
Once you set the running user, BitDefender Backup will display the Schedule dialog
box so that you can set a convenient time to execute the job.
This is where you can specify how often the scheduled task runs: daily, weekly,
monthly, once, at system start, at logon, when the computer is idle. If the task is
scheduled daily, weekly, monthly or only once, you can also specify the start time.
You can also select how often the scheduled task is to run (expressed as the number
of days or weeks, the day of the month or the date). Another possible setting is the
length (in minutes) of the idle period after which the scheduled task starts.
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It is also possible to configure multiple schedules for a task by clicking Show
multiple schedules. By clicking Advanced you can set additional scheduling
options. For example, you can define the task start and end date.
To further refine the job schedule, click the Settings tab. Three sub-options are
available.
● Scheduled Task Completed
▶ Delete the task if it is not scheduled to run again.
This task is useful for tasks scheduled to run only once.

▶ Stop the task if it runs for:
Specify how long after the task has begun it should be stopped.

● Idle Time
▶ Only start the task if the computer has been idle for at least:
Specify how long (in minutes) must pass without mouse or keyboard use before
the scheduled task starts.

▶ If the computer has not been idle that long, retry for up to:
Specify how long (in minutes) the task should keep checking to see if the
computer is idle.

▶ Stop the task if the computer ceases to be idle.
Specify whether the task should be stopped if you start to use the computer
while the task is running.

● Power Management
▶ Don't start the task if the computer is running on batteries.
Specify whether the task should be prevented from starting while your computer
is running on batteries. By selecting this check box you can extend the life of
your batteries.

▶ Stop the task if battery mode begins.
Specify whether the task should be stopped when your computer starts running
on batteries.

▶ Wake the computer to run this task.
Specify whether the computer should run the scheduled task even when in the
Sleep mode.

Delete Job Schedule
To delete a job schedule, select it and then click Delete Job Schedule in the Job
Management section.
If the job is not scheduled,Delete Job Schedulewill be displayed in grey, meaning
it is unusable.
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Modify Job Options
To modify job options, select the job and then clickModify Job Options in the Job
Management section.
The selected job can be either a backup job or a burn job.
For more information on how to modify backup jobs, please refer to “Backup Options
Dialog Box” (p. 143).
Let's take a look at how burn job options can be modified.

Modify Options of Burn Job
Several sub-options are available in the burn job dialog box.
Burn

This is where you can set the disk to be ejected after burn, finalized (if you plan
to share it with others) or written on using the Joliet file system (less filename
restrictions).
If you want to schedule the job, click Set Schedule.
This is where you can schedule the backup job at a convenient time. You can
schedule job to be executed daily, weekly, monthly or at any specified time
(for example at system startup). Schedule Job is the basis of automated
backup.
If your computer is a member of a domain network, a series of extra steps are
necessary to add a job scheduler.
1. Select the job and click Schedule Job.
2. The Running User dialog box will appear. If you are the domain user, please

enter the domain password.
3. Otherwise select Run as the following Windows user.
4. Type the user name, password and the domain server name.
5. Click OK.
Once you set the running user, BitDefender Backup will display the Schedule
dialog box so that you can set a convenient time to execute the job.
This is where you can specify how often the scheduled task runs: daily, weekly,
monthly, once, at system start, at logon, when the computer is idle. If the task
is scheduled daily, weekly, monthly or only once, you can also specify the start
time. You can also select how often the scheduled task is to run (expressed as
the number of days or weeks, the day of the month or the date). Another
possible setting is the length (in minutes) of the idle period after which the
scheduled task starts.
It is also possible to configure multiple schedules for a task by clicking Show
multiple schedules. By clicking Advanced you can set additional scheduling
options. For example, you can define the task start and end date.
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To further refine the job schedule, click the Settings tab. Three sub-options
are available.
● Scheduled Task Completed
▶ Delete the task if it is not scheduled to run again.
This task is useful for tasks scheduled to run only once.

▶ Stop the task if it runs for:
Specify how long after the task has begun it should be stopped.

● Idle Time
▶ Only start the task if the computer has been idle for at least:
Specify how long (in minutes) must pass without mouse or keyboard use
before the scheduled task starts.

▶ If the computer has not been idle that long, retry for up to:
Specify how long (in minutes) the task should keep checking to see if the
computer is idle.

▶ Stop the task if the computer ceases to be idle.
Specify whether the task should be stopped if you start to use the computer
while the task is running.

● Power Management
▶ Don't start the task if the computer is running on batteries.
Specify whether the task should be prevented from starting while your
computer is running on batteries. By selecting this check box you can
extend the life of your batteries.

▶ Stop the task if battery mode begins.
Specify whether the task should be stopped when your computer starts
running on batteries.

▶ Wake the computer to run this task.
Specify whether the computer should run the scheduled task even when
in the Sleep mode.

External Program
The job can run other command before or after backup, and the command can
be .exe, .com or .bat, or a specific type of event such as "shut down computer
after backup finished".
To execute the command when backup begins, follow these steps:
1. Click External Program
2. Select Before Job Execution option.
3. Click Browse to select command files to execute.
4. Click OK.
To execute command after backup finished, follow these steps:
1. Click External Program
2. Select the After Job Execution option.
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3. Click Browse to select the command files to execute.
4. Or click Shut down computer when backup finishes.
5. Or click Restart computer when backup finishes.
6. Or click Logoff the current user when backup finishes.
7. Click OK.

Note
If you want the configuration to work even in case of backup failure, check box
Run External Application even job Execution failed.

File Filter
BitDefender Backup provides a powerful filtering function to exclude or include
specified files, file types or directories, to save storage space and to improve
backup speed.
Specified file type can be filtered by following these steps:
1. Click File Filter.
2. Click Filter Type.
3. Exclude or include file types in the pop-up dialog box by checking the Include

only selected file types or Exclude selected file types options.
4. If necessary, type another file type into the Custom type field but make

sure to use the .abc format. Use , (coma) as separator when typing more
than one custom type. Add a short description into the corresponding field.

5. Click OK.
Specified file can be filtered by following these steps:
1. Click File Filter.
2. Click Filter File.
3. Exclude or include specific files in the pop-up dialog box by checking the

Include only the rule-specified files or Exclude the rule-specified files
options.

4. Click Browse and select the file. The path to the file location will be
automatically added in the Applied to the following directories field. To
include or exclude the file irrespective of its location, click Applied to all
directories.

5. Click OK.
Specified directory can be filtered by following these steps:
1. Click File Filter.
2. Click Filter Directory.
3. Exclude or include specific directories in the pop-up dialog box by checking

the Include only the rule-specified directories or Exclude the
rule-specified directories options.

4. Click Browse and select the directory. The path to the directory location will
be automatically added in the Applied to the following directories field.
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To include or exclude directories irrespective of their location, click Applied
to all directories.

5. Click OK.
Filters can be modified by following these steps:
1. Click File Filter.
2. Click the filter you wish to modify and click Edit.
3. Modify your options in the dialog box.
4. Click OK.
Filters can be deleted by following these steps:
1. Click File Filter.
2. Click the filter you wish to remove and click Delete.
3. Or click Delete All directly, to delete all filters.
4. Click OK.

Data Verification
To make sure your backup data is always safe, follow these steps.
1. Click Data Verification.
2. Click Verify data in backup process.
3. Click OK.

Modify Job Properties
To modify the job properties, select the concerned job and then click Modify Job
Properties in the Job Management section.
1. Click the check box to select partitions, directories, or files to backup.

When you select an item in the left side window, its content will be displayed on
the right side window to help you refine your selection.

2. Type a name for your backup job or accept the default job name.
Default job name is automatically generated when files or directories are selected
to be backed up, but it can be modified.

3. Click Browse to choose where to save your backup job.

Note
Do not forget to click Backup to begin or Cancel to stop.
To refine your settings, click Options.

Restore File
To restore your backed-up data, select the job you want to restore data from, click
Restore File in the Job Restoration menu and then follow these steps.
1. Check the boxes next to the partitions, directories, or files selected to be restored.
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When you select an item in the left side window, its content will be displayed in
the right side window to help you refine your selection.

2. In the Select Restore Locationwindow, you can use the original location without
any changes, or specify another location to restore the file to.
Click Browse to choose where to save your backup job.

Note
Do not forget to click Restore to begin or Cancel to stop.
To refine your settings, click Options.

Restore Options Dialog Box
The restore options allow specifying whether the files to be restored already exist
at destination at restoration time, and whether to update the modified date of each
restored file.
When files to restore already exist

● Skip over the files BitDefender skips the respective files.
● Ask user whether or not to replace the files BitDefender asks you
whether or not to replace the existing files.

● Always replace the files directly BitDefender replaces the files without
asking.

●Only replace file older than backup file BitDefender replaces older files
only. Older files are determined based on the date they were modified on.

File Modified Date
If the option is selected, BitDefender uses the current date to indicate the date
when the files and directories were restored. If not, BitDefender uses as file or
directory modification date the date when they were backed up.

Directory Structure
It only becomes active when you choose another location to restore data to.
You can also preserve the directory structure of your data.

Restore Time-Point Data
To restore the data you backed up at a specific point in time, select the job you
want to restore data from, click Restore Time-Point Data in the Job Restoration
menu and then follow these steps.
1. Select the backup set of a specified time point from the list. Remarks will be

displayed under it.
2. In the Select Restore Locationwindow, you can use either the original location,

without any changes, or specify another location to restore the file to.
Click Browse to choose where to save your backup job.
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Note
Do not forget to click Restore to begin or Cancel to stop.
To refine your settings, click Options.

Restore Options Dialog Box
The restore options allow specifying whether the files to be restored already exist
at destination at restoration time, and whether to update the modified date of each
restored file.
When files to restore already exist

●Only replace file older than backup file BitDefender replaces older files
only. Older files are determined based on the date they were modified on.

File Modified Date
If the option is selected, BitDefender uses the current date to indicate the date
when the files and directories were restored. If not, BitDefender uses as file or
directory modification date the date when they were backed up.

Directory Structure
It only becomes active when you choose another location to restore data to.
You can also preserve the directory structure of your data.

Job Control
There are three ways to monitor a job: pause job, stop job and stop all.
Pause

To pause an ongoing backup or restoration job, click the Pause Job button in
the Job Control menu.

Stop
To stop an ongoing backup or restoration job, click the Stop Job button in the
Job Control menu.

Stop All
If there are more than one backup or restore job running, there is no need to
stop them one by one. Click the Stop All button in the Job Control menu to
stop them all at once.

23.3.3. Log Viewer
This section shows how to view, import, export and clear logs. The Logs option helps
you remember what you backed-up or restored and when you did it and also it
displays warnings or errors of operations. For example, if an error occurred when a
file was read during the execution, BitDefender logged it as a warning message.
You can change to Log Viewer by doing one of the following:
● Click Log Viewer in the Navigator Bar.
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● Click View in the Menu Bar and select Log Viewer.
● Use a shortcut by pressing CTRL+Alt+L.

View Logs
The log viewing option allows tracing back your operation, and finding out the reason
of the operation failure.
The description of a log item on BitDefender Backup contains the following elements:
Type

A classification of the log item severity. There are four degrees of severity on
BitDefender Backup:
● Fatal: A significant problem that prevents BitDefender Backup from running
normally. For example, the configuration file of BitDefender Backup has been
damaged.

● Error: A problem that leads an operation failure. For example, a job is backed
up to a server, but the server cannot be accessed.

●Warning: A problem that does not affect an operation, but may later classify
as an event. For example, a file cannot be read at back up.

● Information: It describes a successful operation. For example, a job was
successfully deleted.

Date
The date the log item occurred on.

Time
The local time when the logged item occurred.

Source
The source that logged the respective item, which can be a job or the
BitDefender Backup application. For example, a System marked item indicates
that it was logged by the BitDefender Backup application. Other possible marks
are the names of the BitDefender Backup jobs having logged the respective
item.

User
The name of the user pursuant to whose action the item was logged.

Description
Presents the detailed content of the logged item.

Clear Logs
BitDefender Backup provides two ways to clear logs: automatically and manually.

Important
Once the log record has been cleared, it cannot be recovered again. Therefore, it is
better to export all logs to a file and preserve them for future consultation.
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Automatically Clear
When BitDefender Backup starts, it compares the existing log size to the default
log size. BitDefender Backup will automatically clear all log files exceeding the
default log size.

Note
To find out or modify the default log size follow these steps:

Click Tool in the Menu Bar.1.
2. Click Options and then select Reports & Log.
3. Type the desired size limitation (in MB) into the corresponding field. When

the size of the log has reached this limit, BitDefender Backup will clear all
logs.

Manually Clear
Follow these steps to clear logs manually.
1. Click Clear All in the Log Management menu.
2. Click Yes to export all logs before clearing them, or click No if you do not

want to preserve the logs.

Import and Export Logs
BitDefender Backup currently supports file import and export in two formats: .TXT
and .XML

Note
We recommend you to export and save the log to a file before clearing it.

To export logs to specified file, follow these steps:
1. Click Export to .TXT file or Export to .XML file in the Log Management

menu.
2. Type the file name and select a location for save your file to.
3. Click Save.
To import logs from a specific file, follow these steps:
1. Click Import from .TXT file or Import from .XML file from the Log

Management menu.
2. Find your file.
3. Click Open.

Note
Click the Refresh button in the Log Management menu to make sure you see the
latest logs.
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23.3.4. Toolbox
This section shows how to use BitDefender Backup to burn data to a CD/DVD or to
burn an ISO Image file. It covers subjects such as burning a CD-R/RW,
DVD-R/RW/RAM, DVD+R/RW/DL and preserving backed-up data offline.
You can change to Toolbox by doing one of the following:
● Click Toolbox in Navigator Bar.
● Click View in the Menu Bar and select Toolbox.
● Use a shortcut by pressing CTRL+Alt+T.

Burn to CD/DVD
To burn data to a CD/DVD manually, follow these steps:
1. Click Burn data to CD/DVD.
2. Click Erase if you want to reuse a rewritable disk. If you want to erase it quickly,

click Fast. If you need to erase the information track record completely, click
Complete, but this will take some time.

3. Click Burn with Dialog.
This is where you can set the disk to be ejected after burn, finalized (if you plan
to share it with others) or written on using the Joliet file system (less filename
restrictions).

4. Click File or Directory in the pop-up dialog box to add data you want to burn.
5. After the data has been added, select burner and the input disc name to burn

the data on, and then click Burn.

Burn ISO Image File to CD/DVD
To burn an ISO Image file to a CD/DVD follow these steps:
1. Click Burn ISO Image File to CD/DVD.
2. Click Erase if you want to reuse a rewritable disk. If you want to erase it quickly,

click Fast. If you need to erase the information track record completely, click
Complete, but this will take some time.

3. Click Burn with Dialog.
This is where you can set to eject disc after burn, to finalize disc (if you plan to
share it with others) or write the data using the Joliet file system (less filename
restrictions).

4. Click Add.
5. Select an ISO Image file to burn and click Open.
6. Click Burn.
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Manage My Burner
This helps you manage and view the recording device and media on the current
system. It contains the following links:
● Eject Device Ejects the selected recording device.
● Close Device Closes the selected recording device.
●Media Info Allows viewing the Media information of the recording device.
●Device info Allows viewing the recording device information.
● Capabilities Allows viewing the media recording capabilities.
● Erase Media Erases the content of the disc.

23.3.5. Menu Bar
There are six menus you can use to perform all the functions offered by the
BitDefender backup solution.
File

● Create New Job: Displays a dialog box in order to create a new backup job
or other job.

●Open Backup Set: Displays a dialog box in order to open the backup set or
the catalog set for restoration.

● Exit: Allows exiting the BitDefender backup section.
Job

● Backup: Performs the backup of the selected job. If there are more than one
selected jobs, execute all the selected jobs.

● Restore File: Restore the selected job. If there are more than one selected
jobs, execute all of the selected jobs.

● Restore Time-Point Data: Restores the selected job to a certain time-point.
If there are more than one selected jobs, it executes all of the selected jobs.

● Schedule: Creates the job schedule or modifies the existing one.
●Delete Schedule: Deletes the schedule of the selected job.
●Delete: Deletes the selected job. If there are more than one selected jobs,
it executes all of them.

●Delete All: Deletes all jobs in job manager.
● Browse Destination: Allows viewing the backup data of the selected job
destination.

●Modify Options: Modifies options of the selected job.
● Properties: Allows modifying properties of the selected job, including data
source, name, destination etc. of the job.

Report
● View Reports: If the selected job has security settings, this option allows
viewing the contents of the job report.

● Save as: Saves the selected report contents to a specified file.
● Print: Prints the content of the selected report.
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● Clear All: Clears the content of the selected job report.
● Refresh: Refreshes the content of the selected job report.

View
●Get Started: If the get started window is not already on display, this option
allows opening it.

● Job Manager: If the job manager window is not already on display, this
option allows opening it.

● Log Viewer: If the log viewer window is not already on display, this option
allows opening it.

● Toolbox: If the window is not already on display, this option allows opening
it.

●Display Menu Bar: Hides the Menu Bar. To display it, just press ALT.
●Display Grid Line: Displays or hides the grid line. It applies to the log viewer
and job manager windows.

Tool
● Backup Wizard: Starts the backup wizard.
● Restore Wizard: Starts the restore wizard.
● Burn: Starts CD/DVD/ISO burn tool or a burner management tool.
▶ CD/DVD Burn
▶ Burn ISO Files
▶ View Burner Info

● Export All Jobs: Exports all created jobs to a specified file.
● Import Jobs: Imports jobs from a .JOB file, a .TXT file, or an .XML file.
● Export Logs: Exports logs to a .TXT file or an .XML file.
▶ To a TXT file
▶ To an XML file

● Import Logs: Imports logs from a .TXT file or an .XML file.
▶ From a TXT file
▶ From an XML file

●Options: Modifies your global backup options.
▶ General
▶ Report & Log
▶ Job Schedule

Help
●Help Topic: Displays help topics.
● Search: Allows searching help topics based on the entered or selected
keyword.

● BitDefender on Website: Allows access to the BitDefender Internet home
page to browse BitDefender news and online support.

● Support Information: Provides information on how to contact BitDefender
for help and support.

● About BitDefender Backup: Displays the copyright, version, and
edition-related info of BitDefender Backup.
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24. Chat Encryption
The contents of your instant messages should remain between you and your chat
partner. By encrypting your conversations, you can make sure anyone trying to
intercept them on their way to and from your contacts will not be able to read their
contents.
By default, BitDefender encrypts all your instant messaging chat sessions provided
that:
● Your chat partner has a BitDefender version installed that supports IM Encryption
and IM Encryption is enabled for the instant messaging application used for
chatting.

● You and your chat partner use either Yahoo Messenger or Windows Live (MSN)
Messenger.

Important
BitDefender will not encrypt a conversation if a chat partner uses a web-based
chat application such as Meebo, or if one of the chat partners uses Yahoo! and the
other Windows Live (MSN).

To configure instant messaging encryption:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Encryption > Chat Encryption.

Note
You can easily configure instant messaging encryption for each chat partner using
the BitDefender toolbar in the chat window.

By default, IM Encryption is enabled for both Yahoo Messenger and Windows Live
(MSN) Messenger. You can choose to disable IM Encryption for a specific chat
application only or completely.
Two tables are displayed:
● Encryption Exclusions - lists the user IDs and the associated IM program for
which encryption is disabled. To remove a contact from the list, select it and click
the Remove button.

● Current Connections - lists the current instant messaging connections (user ID
and associated IM program) and whether or not they are encrypted. A connection
may not be encrypted for these reasons:
▶ You explicitly disabled encryption for the respective contact.
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▶ Your contact does not have installed a BitDefender version that supports IM
encryption.

24.1. Disabling Encryption for Specific Users
To disable encryption for a specific user, follow these steps:
1. Click the Add button to open the configuration window.
2. Type in the edit field the user ID of your contact.
3. Select the instant messaging application associated with the contact.
4. Click OK.

24.2. BitDefender Toolbar in the Chat Window
You can easily configure instant messaging encryption using the BitDefender toolbar
from the chat window.
The toolbar should be located in the bottom-right corner of the chat window. Look
for the BitDefender logo to find it.

Note
The toolbar indicates that a conversation is encrypted by displaying a small key
next to the BitDefender logo.

By clicking the BitDefender toolbar you are provided with the following options:
● Permanently disable encryption for contact.
● Invite contact to use encryption. To encrypt your conversations, your contact
must install BitDefender and use a compatible IM program.

● Add contact to Parental Control blacklist. If you add the contact to the
Parental Control blacklist and Parental Control is enabled, you will no longer see
the instant messages sent by that contact. To remove the contact from the
blacklist, click the toolbar and select Remove contact from Parental Control
blacklist.

Chat Encryption 161

BitDefender Total Security 2011



25. File Encryption
BitDefender File Encryption enables you to create encrypted, password-protected
logical drives (or vaults) on your computer where you can securely store your
confidential and sensitive documents. The data stored on the vaults can only be
accessed by users who know the password.
The password allows you to open, store data on and close a vault while maintaining
its security. While a vault is open, you can add new files, access current files or
change them.
Physically, the vault is a file stored on the local hard drive having the .bvd extension.
Although the physical files representing the vaulted drives can be accessed from a
different operating system (such as Linux), the information stored on them cannot
be read because it is encrypted.
File Encryption is enabled by default. To disable it, follow these steps:
1. Right-click the BitDefender icon in the system tray and select Basic Settings.
2. In the Preferences window that appears, click the switch corresponding to File

Encryption.
If you disable File Encryption, all file vaults will be locked and you will no longer be
able to access the files they contain.
File vaults can be managed from the BitDefender window or by using the Windows
contextual menu and logical drive associated with the vault.

25.1. Managing File Vaults From the BitDefender Interface
The way in which you can access and manage your file vaults differs depending on
the interface view mode you use. The following section detail how you can manage
file vaults.

25.1.1. Create Vault
To create a new vault, go to Encryption > File Encryption in Expert View and do
one of the following:
● Click Create vault.
● Right-click in the vaults table and select Create.
To create a new vault, open BitDefender and, depending on the user interface view
mode, proceed as follows:
Intermediate View

Go to File Storage and click Create File Vault in the File Encryption area.
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Expert View
Go to Encryption > File Encryption in Expert View and do one of the following:
● Click Create vault.
● Right-click in the vaults table and select Create.

A new window will appear. Proceed as follows:
1. Specify the location and the name of the vault file.

● Click Browse, select the location of the vault and save the vault file under the
desired name.

● Type the name and the path of the vault file on the disk in the corresponding
fields .

2. Choose a drive letter from the menu. When you open the vault, a virtual disk
drive labeled with the selected letter appears in My Computer.

3. If you want to change the default size (50 MB) of the vault, type the desired value
in the Vault size field.

4. Type the desired password to the vault in the Password and Confirm fields.
Anyone trying to open the vault and access its files must provide the password.

5. Click Create if you only want to create the vault at the selected location. To
create and display the vault as a virtual disk drive in My Computer, click
Create&Open.

BitDefender will immediately inform you about the result of the operation. If an error
has occurred, use the error message to troubleshoot the error. Click OK to close
the window.

Note
It may be convenient to save all file vaults to the same location. In this way, you can
find them quicker.

25.1.2. Open Vault
In order to access and work with the files stored in a vault, you must open the vault.
When you open the vault, a virtual disk drive appears in My Computer. The drive is
labeled with the drive letter assigned to the vault.
To open a vault, follow these steps:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Encryption > File Encryption and do one of the following:

● Select the vault from the table and click Open vault.
● Right-click the vault in the table and select Open.
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Note
If a previously created vault does not appear in the table, click Search vault
and browse to its location first.

A new window will appear.
3. Choose a drive letter from the menu.
4. Type the vault password in the Password field.
5. Click Open.
BitDefender will immediately inform you about the result of the operation. If an error
has occurred, use the error message to troubleshoot the error. Click OK to close
the window.

25.1.3. Lock Vault
When you are done with your work in a file vault, you must lock it in order to protect
your data. By locking the vault, the corresponding virtual disk drive disappears from
My Computer. Consequently, access to the data stored in the vault is completely
blocked.
To lock a vault, open BitDefender and, depending on the user interface view mode,
proceed as follows:
Intermediate View

Go to File Storage and do one of the following:
● Click Lock File Vault in the Quick Tasks area.
● Click the file vault in the File Encryption area and select Lock in the menu
that appears.

A wizard will appear to help you lock a vault. You can navigate through the
wizard using the Next and Back buttons. To exit the wizard, click Cancel.
1. Select File Vault

Here you can specify the vault to lock.
2. Confirm

This is where you can review chosen operations.
3. Finish

This is where you can view operation result.
Expert View

Go to Encryption > File Encryption and do one of the following:
● Select the vault from the table and click Lock vault.
● Right-click the vault in the table and select Lock.

File Encryption 164

BitDefender Total Security 2011



BitDefender will immediately inform you about the result of the operation. If an error
has occurred, use the error message to troubleshoot the error. Click OK to close
the window.

25.1.4. Change Vault Password
The vault must be locked before you can change its password. To change the
password of a vault, go to Encryption > File Encryption in Expert View and do
one of the following:
● Select the vault from the table and click Change password.
● Right-click the vault in the table and select Change password.
A new window will appear. Proceed as follows:
1. Type the current password of the vault in the Old password field.
2. Type the new password of the vault in the New password and Confirm new

password fields.

Note
The password must have at least 8 characters. For a strong password, use a
combination of uppercase and lowercase letters, numbers and special characters
(such as #, $ or @).

3. Click OK to change the password.
BitDefender will immediately inform you about the result of the operation. If an error
has occurred, use the error message to troubleshoot the error. Click OK to close
the window.

25.1.5. Add Files to Vault
To add files to a vault, open BitDefender and, depending on the user interface view
mode, proceed as follows:
Intermediate View

Go to File Storage and click Add File to Vault in the Quick Tasks area.
A wizard will appear to help you add files to a vault. You can navigate through
the wizard using the Next and Back buttons. To exit the wizard, click Cancel.
1. Select files & folders

Click Add target to select the files/folders that will be added to the vault.
2. Select File Vault

You can select an existing vault, browse for a previously created vault or
create a new one in which to add the files.
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3. Create File Vault
If you have chosen to create a new vault, this is where you specify the
necessary information about it. For more information, please refer to “Create
Vault” (p. 162)

4. Enter password
If you have selected a locked vault, you must enter the password to open it.

5. Confirm
This is where you can review chosen operations.

6. File Vault Content
This is where you can view the vault content.

Expert View
1. Go to Encryption > File Encryption.
2. Select from the vaults table the vault you want to add files in.
3. If the vault is locked, you must first open it (right-click it and select Open

vault).
4. Click Add file. A new window will appear.
5. Select the files / folders you want to add to the vault.
6. Click OK to copy the selected objects into the vault.

25.1.6. Remove Files from Vault
To remove a file from a vault, open BitDefender and, depending on the user interface
view mode, proceed as follows:
Intermediate View

Go to File Storage and click Remove Vault Files in the Quick Tasks area.
A wizard will appear to help you remove files from a vault. You can navigate
through the wizard using the Next and Back buttons. To exit the wizard, click
Cancel.
1. Select File Vault

Here you can specify the vault to remove files from.
2. Enter password

If you have selected a locked vault, you must enter the password to open it.
3. File Vault Content

Select the files/folders that will be removed from the vault.
4. Confirm
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This is where you can review chosen operations.
5. Finish

This is where you can view the operation result.
Expert View

Go to Encryption > File Encryption and follow these steps:
1. Select from the vaults table the vault containing the file to be removed.
2. If the vault is locked, you must first open it (right-click it and select Open

vault).
3. Select the file to be removed from the table that displays the vault content.
4. Click Delete files/folders.

25.1.7. View Vault Contents
To view the contents of a file vault, open BitDefender and, depending on the user
interface view mode, proceed as follows:
Intermediate View

Go to File Storage and do one of the following:
● Click View File Vault in the Quick Tasks area.
● Click the file vault in the File Encryption area and select View in the menu
that appears.

A wizard will appear to help you view the files in the vault. You can navigate
through the wizard using the Next and Back buttons. To exit the wizard, click
Cancel.
1. Select File Vault

Here you can specify the vault to view files from.
2. Enter password

If you have selected a locked vault, you must enter the password to open it.
3. Confirm

This is where you can review chosen operations.
4. File Vault Content

This is where you can view the operation result.
Expert View

Go to Encryption > File Encryption and follow these steps:
1. Select from the vaults table the vault whose contents you want to see.
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2. If the vault is locked, you must first open it (right-click it and select Open
vault).

3. The table at the bottom displays the content of the selected vault.

25.1.8. Delete File Vault
To delete a file vault, follow these steps:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Intermediate View.
2. Go to File Storage.
3. Click the file vault in the File Encryption area.
4. If the vault is open, select Lock in the menu that appears and then click the vault

again. If the vault is locked, move to the next step.
5. Select Delete in the menu that appears.

Important
When you delete a file vault all its contents are also deleted.

25.2. Managing File Vaults From Windows
BitDefender integrates into Windows to help you manage your file vaults more
easily.
The Windows contextual menu appears whenever you right-click a file or folder on
your computer or objects on your desktop. Simply point to BitDefender File Vault
in this menu and you gain access to all available vault operations.
Additionally, whenever you open (mount) a vault a new logical partition (a new
drive) will appear. Just open My Computer and you will see a new drive based on
your file vault. You will be able to do file operations on it (copy, delete, change, etc).
The files are protected as long as they reside on this drive (because a password is
required for the mounting operation). When finished, lock (unmount) your vault in
order to start protecting its content.
You can easily identify the BitDefender file vaults on your computer by the
BitDefender icon and the .bvd extension.

25.2.1. Create Vault
Keep in mind that a vault is actually just a file with the .bvd extension. Only when
you open the vault, a virtual disk drive appears in My Computer and you can safely
store files inside it. When creating a vault, you must specify where and under which
name to save it on your computer. You must also specify a password to protect its
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content. Only users who know the password can open the vault and access the
documents and data stored inside it.
To create a vault, follow these steps:
1. Right-click on your Desktop or in a folder on your computer, point to BitDefender

File Vault and select Create File Vault. A new window will appear.
2. Specify the location and the name of the vault file.

● Click Browse, select the location of the vault and save the vault file under the
desired name.

● Type the name and the path of the vault file on the disk in the corresponding
fields .

3. Choose a drive letter from the menu. When you open the vault, a virtual disk
drive labeled with the selected letter appears in My Computer.

4. Type the desired password to the vault in the Password and Confirm fields.
Anyone trying to open the vault and access its files must provide the password.

5. Select Format drive to format the virtual drive assigned to the vault. You must
format the drive before you can add files to the vault.

6. If you want to change the default size (50 MB) of the vault, type the desired value
in the Vault size field.

7. Click Create if you only want to create the vault at the selected location. To
create and display the vault as a virtual disk drive in My Computer, click
Create&Open.

BitDefender will immediately inform you about the result of the operation. If an error
has occurred, use the error message to troubleshoot the error. Click OK to close
the window.

Note
It may be convenient to save all file vaults to the same location. In this way, you can
find them quicker.

25.2.2. Open Vault
In order to access and work with the files stored in a vault, you must open the vault.
When you open the vault, a virtual disk drive appears in My Computer. The drive is
labeled with the drive letter assigned to the vault.
To open a vault, follow these steps:
1. Locate on your computer the .bvd file representing the vault you want to open.
2. Right-click the file, point to BitDefender File Vault and select Open. Quicker

alternatives would be to double-click the file, or to right-click it and select Open.
A new window will appear.
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3. Choose a drive letter from the menu.
4. Type the vault password in the Password field.
5. Click Open.
BitDefender will immediately inform you about the result of the operation. If an error
has occurred, use the error message to troubleshoot the error. Click OK to close
the window.

25.2.3. Lock Vault
When you are done with your work in a file vault, you must lock it in order to protect
your data. By locking the vault, the corresponding virtual disk drive disappears from
My Computer. Consequently, access to the data stored in the vault is completely
blocked.
To lock a vault, follow these steps:
1. OpenMy Computer (click the Windows Startmenu and thenMy Computer).
2. Identify the virtual disk drive corresponding to the vault you want to close. Look

for the drive letter you assigned to the vault when you opened it.
3. Right-click the respective virtual disk drive, point to BitDefender File Vault

and click Close.
You can also right-click the .bvd file representing the vault, point to BitDefender
File Vault and click Close.
BitDefender will immediately inform you about the result of the operation. If an error
has occurred, use the error message to troubleshoot the error. Click OK to close
the window.

Note
If several vaults are open, you may want to use the BitDefender Expert View interface.
If you go to Encryption, File Encryption tab, you can see a table which provides
information on the existing vaults. This information includes whether the vault is open
and, if so, the drive letter it was assigned.

25.2.4. Add to File Vault
Before you can add files or folders to a vault, you must open the vault. Once a vault
is open, you can easily store files or folders inside it using the contextual menu.
Right-click the file or folder you want to copy to a vault, point to BitDefender File
Vault and click Add to File Vault.
● If only one vault is open, the file or folder is copied directly to that vault.
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● If several vaults are open, you will be prompted to choose the vault to copy the
item to. Select from the menu the drive letter corresponding to the desired vault
and click OK to copy the item.

You can also use the virtual disk drive corresponding to the vault. Follow these
steps:
1. OpenMy Computer (click the Windows Startmenu and thenMy Computer).
2. Enter the virtual disk drive corresponding to the vault. Look for the drive letter

you assigned to the vault when you opened it.
3. Copy-paste or drag&drop files and folders directly to this virtual disk drive.

25.2.5. Remove from File Vault
In order to remove files or folders from a vault, the vault must be open. To remove
files or folders from a vault, follow these steps:
1. OpenMy Computer (click the Windows Startmenu and thenMy Computer).
2. Enter the virtual disk drive corresponding to the vault. Look for the drive letter

you assigned to the vault when you opened it.
3. Remove files or folders as you normally do in Windows (for example, right-click

a file you want to delete and select Delete).

25.2.6. Change Vault Password
The password protects the content of a vault from unauthorized access. Only users
who know the password can open the vault and access the documents and data
stored inside it.
The vault must be locked before you can change its password. To change the
password of a vault, follow these steps:
1. Locate on your computer the .bvd file representing the vault.
2. Right-click the file, point to BitDefender File Vault and select Change Vault

Password. A new window will appear.
3. Type the current password of the vault in the Old Password field.
4. Type the new password of the vault in the New Password and Confirm New

Password fields.

Note
The password must have at least 8 characters. For a strong password, use a
combination of uppercase and lowercase letters, numbers and special characters
(such as #, $ or @).
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5. Click OK to change the password.
BitDefender will immediately inform you about the result of the operation. If an error
has occurred, use the error message to troubleshoot the error. Click OK to close
the window.
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26. Tune-Up
BitDefender comes with a Tune-Up module that helps you maintain the integrity of
your system. The maintenance tools offered are critical for the improvement of your
system's responsiveness and the efficient management of the hard drive space.
BitDefender provides the following PC tune-up tools:
● Disk Defragmenter physically reorganizes the data on the hard disk so that the
pieces of each file are stored close together and continuously.

● PC Clean-Up removes the temporary Internet files and cookies, unused system
files and recent documents shortcuts.

● Duplicate Finder finds and deletes files that are duplicated in your system.
● Registry Cleaner identifies and deletes invalid or outdated references in the
Windows Registry. In order to keep the Windows Registry clean and optimized,
it is recommended to run the Registry Cleaner monthly.

● Registry Recovery can retrieve registry keys previously deleted from theWindows
Registry using BitDefender Registry Cleaner.

● File Shredder permanently erases files and their traces from your system.
● Performance Monitor monitors your system hardware and software configuration
in order to make sure you are fully protected from malware.

26.1. Defragmenting Hard Disk Volumes
When copying a file exceeding the largest block of free space on the hard disk, file
fragmentation occurs. Because there is not enough free space to store the entire
file continuously, it will be stored in several blocks. When the fragmented file is
accessed, its data must be read from several different locations.
It is recommended to defragment the hard disk in order to:
● access files faster.
● improve overall system performance.
● extend hard disk life.
The Disk Defragmentation Wizard will help you defragment your hard drive. To start
the wizard, open BitDefender and, depending on the user interface view mode,
proceed as follows:
Intermediate View

Go to the Tune-Up tab and click Disk Defragmenter in the Quick Tasks area
on the left side of the window.

Expert View
Go to Tune-Up and click Run Now corresponding to Disk Defragmenter.
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Follow the five-step guided procedure to perform the defragmentation.
1. Choose disks to analyze

Select the partitions you want to check for fragmentation.
2. Analyzing selected partitions

Wait for BitDefender to finish analyzing the partitions.
3. Select disk to defragment

The fragmentation status of the analyzed partitions is displayed. Select the
partitions you want to be defragmented.

4. Defragmenting
Wait for BitDefender to finish defragmenting the partitions.

5. Display Results

Note
Defragmentation may take a while since it involves moving portions of stored data
from a place to another on the hard disk. We recommend you to perform
defragmentation when you are not using your computer.

26.2. Cleaning Up Your PC
Every time you visit a web page, temporary Internet files are created in order to
allow you to access it quicker next time.
Cookies are also stored on your computer when you visit a web page.
The PC Clean-up Wizard helps you free disk space and protect your privacy by
deleting files that may no longer be useful.
● Internet Explorer temporary Internet files and cookies.
● Mozilla Firefox temporary Internet files and cookies.
● temporary system files Windows creates during its operation.
● recent documents shortcuts Windows creates when you open a file.
To start the wizard, open BitDefender and, depending on the user interface view
mode, proceed as follows:
Intermediate View

Go to the Tune-Up tab and click PC Clean-Up in the Quick Tasks area on the
left side of the window.

Expert View
Go to Tune-Up and click Run Now corresponding to Clean-up PC
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Note
You can also add a shortcut to My Tools.

Follow the three-step guided procedure to perform the clean-up. You can navigate
through the wizard using the Next button. To exit the wizard, click Cancel.
1. Configure

Select a typical clean (clean all) or custom clean (choose what to clean).
2. Perform Cleaning

Wait for BitDefender to finish the clean-up.
3. Results

26.3. Deleting Files Permanently
When you delete a file, it can no longer be accessed through normal means. However,
the file continues to be stored on the hard disk until it is overwritten when copying
new files.
The File Shredder Wizard will help you permanently delete data by physically
removing it from your hard disk. To start the wizard, open BitDefender and,
depending on the user interface view mode, proceed as follows:
Intermediate View

Go to the Tune-Up tab and click File Shredder in the Quick Tasks area on the
left side of the window.

Expert View
Go to Tune-Up and click Run Now corresponding to File Shredder.

Follow the three-step guided procedure to perform the clean-up. You can navigate
through the wizard using the Next button. To exit the wizard, click Cancel.
1. Select file/folder

Add the files or folders you want to be permanently removed.

Warning
You will not be able to recover any files that have been run through the File
Shredder.

2. Shredding files
Wait for BitDefender to finish shredding the files.

3. Results
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26.4. Cleaning Windows Registry
Many applications write keys in the Windows Registry at installation time. When
removing such applications, some of their associated registry keys might not be
deleted and continue to remain in the Windows Registry, slowing down your system
and even causing system instability. The same happens when you delete shortcuts
to or certain files of applications installed on your system, as well as in the case of
corrupt drivers.
The Registry Cleaner Wizard will help you clean the Windows Registry and improve
the performance of your system. To start the wizard, open BitDefender and,
depending on the user interface view mode, proceed as follows:
Intermediate View

Go to the Tune-Up tab and click Registry Cleaner in the Quick Tasks area
on the left side of the window.

Expert View
Go to Tune-Up and click Run Now corresponding to Clean Registry.

Note
You can also add a shortcut to My Tools.

Follow the four-step guided procedure to clean the registry. You can navigate through
the wizard using the Next button. To exit the wizard, click Cancel.
1. Welcome screen
2. Perform Scan

Wait for BitDefender to finish scanning the registry.
3. Select Keys

You can see all the invalid or orphan registry keys detected. Detailed information
is provided about each registry key (name, value, priority, category).
The registry keys are grouped based on their location in the Windows Registry:

DescriptionCategory
Registry keys that contain information about the
path to applications installed on your computer.

Software Locations

The invalid keys are assigned a low priority, which
means that you can delete themwithout almost any
risk.
Registry keys that contain information about the file
extensions registered on your computer. These

Custom Controls

registry keys are commonly used to maintain file
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DescriptionCategory
associations (to ensure that the correct program
opens when you open a file using Windows
Explorer). For example, such a registry key allows
Windows to open a .doc file in Microsoft Word.
The invalid keys are assigned a low priority, which
means that you can delete themwithout almost any
risk.
Registry keys that contain information on the
location of shared DLLs (Dynamic Link Libraries).

Shared DLLs

DLLs store functions that are used by installed
applications to perform certain tasks. They can be
shared by multiple applications to reduce memory
and disk space requirements.
These registry keys become invalid when the DLL
they point to is moved to another location or
completely removed (this usually happens when
you uninstall a program).
The invalid keys are assigned a medium priority,
which means that deleting them may negatively
affect the system.

By default, all the keys are marked for deletion. You can choose to delete
individual invalid keys from a selected category.

Note
You can recover the deleted registry keys at any time using Registry Recovery.

4. Results

26.5. Recovering Cleaned Registry
Sometimes, after registry clean up, you might notice that your system does not
work well or that some applications fail to operate properly due to missing registry
keys. This may be caused by shared registry keys that were deleted during registry
cleaning or by other deleted keys. To solve this problem, you must recover the
cleaned registry.
The Registry Recovery Wizard will help you recover the cleaned registry. To start
the wizard, open BitDefender and, depending on the user interface view mode,
proceed as follows:
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Intermediate View
Go to the Tune-Up tab and click Registry Recovery in the Quick Tasks area
on the left side of the window.

Expert View
Go to Tune-Up and click Run Now corresponding to Registry Recovery.

Follow the two-step guided procedure to recover the cleaned registry. You can
navigate through the wizard using theNext button. To exit the wizard, click Cancel.
1. Select the recovery point

You can see a list of time points when the Windows Registry was cleaned. Select
the time point to restore the Windows Registry to.

Warning
The recovery of the cleaned registry might overwrite the registry keys edited since
the last registry clean up.

2. Task results

26.6. Finding Duplicate Files
Duplicate files eat up your hard disk space. Just think about having the same .mp3
file stored in three different locations.
The Duplicate Finder Wizard will help you detect and delete duplicate files on your
computer. To start the wizard, open BitDefender and, depending on the user interface
view mode, proceed as follows:
Intermediate View

Go to the Tune-Up tab and click Duplicate Finder in the Quick Tasks area on
the left side of the window.

Expert View
Go to Tune-Up and click Run Now corresponding to Duplicate Finder.

Note
You can also add a shortcut to My Tools.

Follow the four-step guided procedure to identify and remove duplicates. You can
navigate through the wizard using theNext button. To exit the wizard, click Cancel.
1. Select target files

Add the folders where to search for duplicate files. By default, 0 KB files, files in
the Program Files and Windows folders are ignored as it is highly recommended
not to delete files from these folders. Click Options if you want to add any such
files to the search.
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2. Search for Duplicates
Wait for BitDefender to finish searching for duplicates.

3. Mark files for deletion
Identical files are listed in groups. You can choose an action to take on all groups
or on each separate group: keep newest, keep oldest or take no action. You can
also select actions for each individual file.

Note
If no duplicated files are found, this step will be skipped.

4. Results

26.7. Performance Monitor
The Performance Monitor consists in a table that lists the running processes and
applications, the amount of CPU and memory they are using and a rating based on
this information.
To access the Performance Monitor module, proceed as follows:
Intermediate View

Go to the Tune-Up tab and click Performance Optimizer in the Quick Tasks
area on the left side of the window.

Expert View
Go to Tune-Up > Monitor / Optimization.

The Performance Monitor module constantly monitors the system load, allowing
you to see the running applications and the impact they have on the general behavior
of the system. In Intermediate View, when clicking on an application a history of
the CPU and memory usage is displayed along the name and installation path.
These are its main functions:
● To offer a perspective on the system hardware configuration
● To present the system CPU and memory usage by using a set of indicators
● To determine the applications resource usage
● To help you close any high resource usage application which causes the system
to perform poorly

Note
In the Optimization tab from Expert View, when the system is in idle state for a certain
amount of time you can launch different types of scan.
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System configuration is evaluated by using a system rating based on the amount
of installed RAM memory, CPU frequency, and the hard disk's free space.
In case you encounter a slow down issue, the problem may be caused by some
applications running on your system. To solve the problem, identify the application
which causes the issue and close it by using the link provided.

Warning
If you suspect the application (or the process) you want to close is part of the Windows
operating system and your action could affect the system, contact BitDefender
Customer Care for more information.
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27. Game / Laptop Mode
The Game / Laptop Mode module allows you to configure the special operation
modes of BitDefender:
● Game Mode temporarily modifies the product settings so as to minimize the
resource consumption when you play.

● Laptop Mode prevents scheduled tasks from running when the laptop is running
on battery in order to save battery power.

● Silent Mode temporarily modifies the product settings so as to minimize the
interruptions when you watch movies or presentations.

27.1. Game Mode
Game Mode temporarily modifies protection settings so as to minimize their impact
on system performance. While in Game Mode, the following settings are applied:
● All BitDefender alerts and pop-ups are disabled.
● The BitDefender real-time protection level is set to Permissive.
● The BitDefender firewall is set to Allow all. This means that all new connections
(both incoming and outgoing) are automatically allowed, regardless of the port
and protocol being used.

● Updates are not performed by default.

Note
To change this setting, go to Update>Settings and clear the Don't update if
Game Mode is on check box.

● Scheduled backup tasks are by default disabled.
By default, BitDefender automatically enters Game Mode when you start a game
from the BitDefender's list of known games or when an application goes to full
screen. You can manually enter Game Mode using the default Ctrl+Alt+Shift+G
hotkey. It is strongly recommended that you exit Game Mode when you finished
playing (you can use the same default Ctrl+Alt+Shift+G hotkey).

Note
While in Game Mode, you can see the letter G over the BitDefender icon.

To configure Game Mode:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Game/Laptop Mode > Game Mode.
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At the top of the section, you can see the status of the Game Mode. You can click
Game Mode is enabled or Game Mode is turned off to change the current
status.

27.1.1. Configuring Automatic Game Mode
Automatic Game Mode allows BitDefender to automatically enter Game Mode when
a game is detected. You can configure the following options:
●Use the default list of games provided by BitDefender - to automatically
enter Game Mode when you start a game from the BitDefender's list of known
games. To view this list, click Manage Games and then Games List.

● Full screen action - you can choose to automatically enter Game Mode or Silent
Mode when an application goes to full screen.

● Ask if the full screen application should be added to the game list - to be
prompted to add a new application to the game list when you leave full screen.
By adding a new application to the game list, the next time you start it BitDefender
will automatically enter Game Mode.

Note
If you do not want BitDefender to automatically enter Game Mode, clear the
Automatic Game Mode is enabled check box.

27.1.2. Managing the Game List
BitDefender automatically enters Game Mode when you start an application from
the game list. To view and manage the game list, click Manage Games. A new
window will appear.
New applications are automatically added to the list when:
● You start a game from the BitDefender's list of known games. To view this list,
click Games List.

● After leaving full screen, you add the application to the game list from the prompt
window.

If you want to disable Automatic Game Mode for a specific application from the list,
clear its corresponding check box. You should disable Automatic Game Mode for
regular applications that go to full screen, such as web browsers and movie players.
To manage the game list, you can use the buttons placed at the top of the table:
● Add - add a new application to the game list.
● Remove - remove an application from the game list.
● Edit - edit an existing entry in the game list.
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27.1.3. Adding or Editing Games
When you add or edit an entry from the game list, a new window will appear.
Click Browse to select the application or type the full path to the application in the
edit field.
If you do not want to automatically enter Game Mode when the selected application
is started, select Disable.
Click OK to add the entry to the game list.

27.1.4. Configuring Game Mode Settings
To configure the behaviour on scheduled tasks, use these options:
● Enable this module to modify Antivirus scan tasks schedules - to prevent
scheduled scan tasks from running while in Game Mode. You can choose one of
the following options:

DescriptionOption
Do not run the scheduled task at all.Skip Task
Run the scheduled task immediately after you exit Game
Mode.

Postpone Task

● Enable this module to modify Backup tasks schedules - to prevent scheduled
backup tasks from running while in Game Mode. You can choose one of the
following options:

DescriptionOption
Do not run the scheduled task at all.Skip Task
Run the scheduled task immediately after you exit Game
Mode.

Postpone Task

To automatically disable the BitDefender firewall while in Game Mode, follow these
steps:
1. Click Advanced Settings. A new window will appear.
2. Select the Set Firewall on Allow All (Game Mode) when in Game Mode

check box.
3. Click OK to save the changes.
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27.1.5. Changing Game Mode Hotkey
You can manually enter Game Mode using the default Ctrl+Alt+Shift+G hotkey.
If you want to change the hotkey, follow these steps:
1. Click Advanced Settings. A new window will appear.
2. Under the Use HotKey option, set the desired hotkey:

● Choose themodifier keys you want to use by checking one the following: Control
key (Ctrl), Shift key (Shift) or Alternate key (Alt).

● In the edit field, type the letter corresponding to the regular key you want to
use.

For example, if you want to use the Ctrl+Alt+D hotkey, you must check only
Ctrl and Alt and type D.

Note
Removing the check mark next to Use HotKey will disable the hotkey.

3. Click OK to save the changes.

27.2. Laptop Mode
Laptop Mode is especially designed for laptop and notebook users. Its purpose is to
minimize BitDefender's impact on power consumption while these devices are
running on battery.
While in Laptop Mode, scheduled tasks are by default not performed.
BitDefender detects when your laptop has switched to battery power and it
automatically enters Laptop Mode. Likewise, BitDefender automatically exits Laptop
Mode, when it detects the laptop is no longer running on battery.
To configure Laptop Mode:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Game/Laptop Mode > Laptop Mode.
You can see whether Laptop Mode is enabled or not. If Laptop Mode is enabled,
BitDefender will apply the configured settings while the laptop is running on battery.

27.2.1. Configuring Laptop Mode Settings
To configure the behaviour on scheduled tasks, use these options:
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● Enable this module to modify Antivirus scan tasks schedules - to prevent
scheduled scan tasks from running while in Laptop Mode. You can choose one of
the following options:

DescriptionOption
Do not run the scheduled task at all.Skip Task
Run the scheduled task immediately after you exit Laptop
Mode.

Postpone Task

● Enable this module to modify Backup tasks schedules - to prevent scheduled
backup tasks from running while in Laptop Mode. You can choose one of the
following options:

DescriptionOption
Do not run the scheduled task at all.Skip Task
Run the scheduled task immediately after you exit Laptop
Mode.

Postpone Task

27.3. Silent Mode
Silent Mode temporarily modifies protection settings so as to minimize their impact
on system performance. While in Silent Mode the following settings are applied:
● All BitDefender alerts and pop-ups are disabled.
● The BitDefender firewall is set to Allow all. This means that all new connections
(both incoming and outgoing) are automatically allowed, regardless of the port
and protocol being used.

● Scheduled scan tasks are by default disabled.
● Scheduled backup tasks are by default disabled.
By default, BitDefender automatically enters Silent Mode when you watch a movie
or a presentation or when an application goes to full screen. It is strongly
recommended that you exit Silent Mode when you finished watching the movie or
the presentation.

Note
While in Silent Mode, you can see a slight modification of the little BitDefender icon
located next to your computer clock.

To configure Silent Mode:
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1. Open BitDefender, click Options in the upper-right corner of the window and
choose Expert View.

2. Go to Game/Laptop Mode > Silent Mode.
At the top of the section, you can see the status of the Silent Mode. You can click
Silent Mode is enabled or Silent Mode is disabled to change the current status.

27.3.1. Configuring Full Screen Action
You can configure the following options:
● Full screen action - you can choose to automatically enter Game Mode or Silent
Mode when an application goes to full screen.

Note
If you do not want BitDefender to automatically enter Silent Mode, clear the Full
Screen Action check box.

27.3.2. Configuring Silent Mode Settings
To configure the behaviour on scheduled tasks, use these options:
● Enable this module to modify Antivirus scan tasks schedules - to prevent
scheduled scan tasks from running while in Silent Mode. You can choose one of
the following options:

DescriptionOption
Do not run the scheduled task at all.Skip Task
Run the scheduled task immediately after you exit Silent
Mode.

Postpone Task

● Enable this module to modify Backup tasks schedules - to prevent scheduled
backup tasks from running while in Silent Mode. You can choose one of the
following options:

DescriptionOption
Do not run the scheduled task at all.Skip Task
Run the scheduled task immediately after you exit Silent
Mode.

Postpone Task
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28. Home Network
The Network module allows you to manage the BitDefender products installed on
your home computers from a single computer. To access the Home Networkmodule,
open BitDefender and, depending on the user interface view mode, proceed as
follows:
Intermediate View

Go to the Network tab.
Expert View

Go to Home Network.

Note
You can also add a shortcut to My Tools.

To be able to manage the BitDefender products installed on your home computers,
you must follow these steps:
1. Enable the BitDefender home network on your computer. Set your computer as

Server.
2. Go to each computer you want to manage and join the network (set the password).

Set each computer as Regular.
3. Go back to your computer and add the computers you want to manage.

28.1. Enabling the BitDefender Network
To enable the BitDefender home network, follow these steps:
1. Click Enable Network. You will be prompted to configure the homemanagement

password.
2. Type the same password in each of the edit fields.
3. Set the role of the computer in the BitDefender home network:

● Server Computer - select this option on the computer that will be used to
manage all the other ones.

● Regular Computer - select this option on the computers that will be managed
by the Server Computer.

4. Click OK.
You can see the computer name appearing in the network map.
The Disable Network button appears.
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28.2. Adding Computers to the BitDefender Network
Any computer will be automatically added to the network if it meets the following
criteria:
● the BitDefender home network was enabled on it.
● the role was set to Regular Computer.
● the password set when enabling the network is the same as the password set on
the Server Computer.

Note
In Expert View, you can scan the home network for computers meeting the criteria
at any time by clicking the Auto discover button.

To manually add a computer to the BitDefender home network from the Server
Computer, follow these steps:
1. Click Add Computer.
2. Type the home management password and click OK. A new window will appear.

You can see the list of computers in the network. The icon meaning is as follows:

Indicates an online computer with no BitDefender products installed.
Indicates an online computer with BitDefender installed.
Indicates an offline computer with BitDefender installed.

3. Do one of the following:
● Select from the list the name of the computer to add.
● Type the IP address or the name of the computer to add in the corresponding
field.

4. Click Add. You will be prompted to enter the home management password of
the respective computer.

5. Type the home management password configured on the respective computer.
6. ClickOK. If you have provided the correct password, the selected computer name

will appear in the network map.

28.3. Managing the BitDefender Network
Once you have successfully created a BitDefender home network, you can manage
all BitDefender products from a single computer.
If you move the mouse cursor over a computer from the network map, you can see
brief information about it (name, IP address, number of issues affecting the system
security, BitDefender registration status).
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If you click a computer name in the network map, you can see all the administrative
tasks you can run on the remote computer.
● Register BitDefender on this computer
Allows you to register BitDefender on this computer by entering a license key.

● Set a settings password on a remote PC
Allows you to create a password to restrict access to BitDefender settings on this
PC.

● Run an on-demand scan task
Allows you to run an on-demand scan on the remote computer. You can perform
any of the following scan tasks: My Documents Scan, System Scan or Deep System
Scan.

● Fix all issues on this PC
Allows you to fix the issues that are affecting the security of this computer by
following the Fix All Issues wizard.

● View History/Events
Allows you access to the History&Events module of the BitDefender product
installed on this computer.

●Update Now
Intitiates the Update process for the BitDefender product installed on this
computer.

● Set Parental Control Profile
Allows you to set the age category to be used by the Parental Control web filter
on this computer.

● Run a Tune-Up task on this computer
Allows you to run a tune-up task on the remote PC. You can perform one of the
following tasks: defragment disks or clean temporary internet files.

● Set as Update Server for this network
Allows you to set this computer as update server for all BitDefender products
installed on the computers in this network. Using this option will reduce internet
traffic, because only one computer in the network will connect to the internet to
download updates.

● Remove PC from home network
Allows you to remove a PC from the network.

When the BitDefender interface is in Intermediate View, you can run several tasks
on all managed computers at the same time by clicking the corresponding buttons.

Home Network 189

BitDefender Total Security 2011



● Scan All - allows you to scan all managed computers at the same time.
●Update All allows you to update all managed computers at the same time.
● Register All allows you to register all managed computers at the same time.
Before running a task on a specific computer, you will be prompted to provide the
local home management password. Type the home management password and
click OK.

Note
If you plan to run several tasks, you might want to select Don't show this message
again this session. By selecting this option, you will not be prompted again for this
password during the current session.
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29. Update
New malware is found and identified every day. This is why it is very important to
keep BitDefender up to date with the latest malware signatures.
If you are connected to the Internet through broadband or DSL, BitDefender takes
care of this itself. By default, it checks for updates when you turn on your computer
and every hour after that.
If an update is detected, you may be asked to confirm the update or the update is
performed automatically, depending on the automatic update settings.
The update process is performed on the fly, meaning that the files to be updated
are replaced progressively. In this way, the update process will not affect product
operation and, at the same time, any vulnerability will be excluded.

Important
To be protected against the latest threats keep the Automatic Update enabled.

Updates come in the following ways:
●Updates for the antivirus engines - as new threats appear, the files containing
virus signatures must be updated to ensure permanent up-to-date protection
against them. This update type is also known as Virus Definitions Update.

●Updates for the antispam engines - new rules will be added to the heuristic
and URL filters and new images will be added to the Image filter. This will help
increase the effectiveness of your Antispam engine. This update type is also
known as Antispam Update.

●Updates for the antispyware engines - new spyware signatures will be added
to the database. This update type is also known as Antispyware Update.

● Product upgrades - when a new product version is released, new features and
scan techniques are introduced to the effect of improving the product's
performance. This update type is also known as Product Update.

29.1. Performing an Update
The automatic update can be done anytime you want by clicking Update Now.
This update is also known as Update by user request.
To update BitDefender, depending on the user interface mode, proceed as follows:
Basic View

Click the Update Now icon in the Protect your PC area.
Intermediate View

Go to the Security tab and click Update Now in the Quick Tasks area on the
left side of the window.
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Expert View
Go to Update > Update.

The Update module will connect to the BitDefender update server and will verify
if any update is available. If an update was detected, depending on the options set
in the Manual Update Settings section, you will be asked to confirm the update or
the update will be made automatically.

Important
It may be necessary to restart the computer when you have completed the update.
We recommend doing it as soon as possible.

Note
If you are connected to the Internet through a dial-up connection, then it is
recommended to regularly update BitDefender by user request. For more information,
please refer to “How to Update BitDefender on a Slow Internet Connection” (p. 218).

29.2. Configuring Update Settings
The updates can be performed from the local network, over the Internet, directly
or through a proxy server. By default, BitDefender will check for updates every hour,
over the Internet, and install the available updates without alerting you.
To configure the update settings:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Update > Settings.
3. Configure the settings as needed. To find out what an option does, keep the

mouse over it and read the description displayed at the bottom of the window.
4. Click Apply to save the changes.
To apply the default settings, click Default.
The update settings are grouped into 4 categories (Update Location Settings,
Automatic Update Settings,Manual Update Settings andAdvanced Settings).
Each category will be described separately.

29.2.1. Setting Update Locations
To set the update locations, use the options from the Update Location Settings
category.

Note
Configure these settings only if you are connected to a local network that stores
BitDefender malware signatures locally or if you connect to the Internet through a
proxy server.
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For more reliable and faster updates, you can configure two update locations: a
Primary update location and an Alternate update location. By default, these
locations are the same: http://upgrade.bitdefender.com.
To modify one of the update locations, provide the URL of the local mirror in the
URL field corresponding to the location you want to change.

Note
We recommend you to set as primary update location the local mirror and to leave
the alternate update location unchanged, as a fail-safe plan in case the local mirror
becomes unavailable.

In case the company uses a proxy server to connect to the Internet, check Use
proxy and then click Proxy Settings to configure the proxy settings. For more
information, please refer to “Connection Settings” (p. 57)

29.2.2. Configuring Automatic Update
To configure the update process performed automatically by BitDefender, use the
options in the Automatic Update Settings category.
You can specify the number of hours between two consecutive checks for updates
in the Update every field. By default, the update time interval is set to 1 hour.
To specify how the automatic update process should be performed, select one of
the following options:
● Silent update - BitDefender automatically downloads and implements the update.
● Prompt before downloading updates - every time an update is available, you
will be prompted before downloading it.

● Prompt before installing updates - every time an update was downloaded,
you will be prompted before installing it.

29.2.3. Configuring Manual Update
To specify how the manual update (update by user request) should be performed,
select one of the following options in the Manual Update Settings category:
● Silent update - the manual update will be performed automatically in the
background, without user intervention.

● Prompt before downloading updates - every time an update is available, you
will be prompted before downloading it.

29.2.4. Configuring Advanced Settings
To prevent the BitDefender update process from interfering with your work, configure
the options in the Advanced Settings category:
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●Wait for reboot, instead of prompting - If an update requires a reboot, the
product will keep working with the old files until the system is rebooting. The user
will not be prompted for rebooting, therefore the BitDefender update process will
not interfere with the user’s work.

●Do not update if a scan is in progress - BitDefender will not update if a scan
process is running. This way, the BitDefender update process will not interfere
with the scan tasks.

Note
If BitDefender is updated while a scan is in progress, the scan process will be
aborted.

●Do not update if Game Mode is on - BitDefender will not update if the Game
Mode is turned on. In this way, you canminimize the product’s influence on system
performance during games.

● Enable update sharing - If you want to minimize the influence of the network
traffic on system performance during updates, use the update sharing option.

●Upload BitDefender files from this PC - BitDefender lets you share the latest
antivirus signatures available on your PC with other BitDefender users.
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30. How Do I Scan Files and Folders?
Scanning is easy and flexible with BitDefender. There are several ways to set
BitDefender to scan files and folders for viruses and other malware:
● Using Windows Contextual Menu
● Using Scan Tasks
● Using Scan Activity Bar
Once you initiate a scan, the Antivirus Scan wizard will appear and guide you through
the process. For detailed information about this wizard, please refer to “Antivirus
Scan Wizard” (p. 69).

Note
To find out how to scan with BitDefender in Windows Safe Mode, please refer to “How
Do I Scan My Computer in Safe Mode?” (p. 231).

30.1. Using Windows Contextual Menu
This is the easiest and recommended way to scan a file or folder on your computer.
Right-click the object you want to scan and select Scan with BitDefender from
the menu. Follow the Antivirus Scan wizard to complete the scan.
Typical situations when you would use this scanning method include the following:
● You suspect a specific file or folder to be infected.
●Whenever you download from the Internet files that you think they might be
dangerous.

● Scan a network share before copying files to your computer.

30.2. Using Scan Tasks
If you want to scan your computer or specific folders regularly, you should consider
using scan tasks. Scan tasks instruct BitDefender what locations to scan, and which
scanning options and actions to apply. Moreover, you can schedule them to run on
a regular basis or at a specific time.
To scan your computer using scan tasks, you must open the BitDefender interface
and run the desired scan task. Depending on the user interface viewmode, different
steps are to be followed to run the scan task.

Running Scan Tasks in Basic View
In Basic View, you can run a number of pre-configured scan tasks. Click the Security
button and choose the desired scan task. Follow the Antivirus Scan wizard to
complete the scan.
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Running Scan Tasks in Intermediate View
In Intermediate View, you can run a number of pre-configured scan tasks. You can
also configure and run custom scan tasks to scan specific locations on your computer
using custom scanning options. Follow these steps to run a scan task in Intermediate
View:
1. Click the Security tab.
2. On the left-side Quick Tasks area, click Full System Scan and choose the desired

scan task. To configure and run a custom scan, click Custom Scan.
3. Follow the Antivirus Scan wizard to complete the scan. If you chose to run a

custom scan, you must complete instead the Custom Scan wizard.

Running Scan Tasks in Expert View
In Expert View, you can run all of the pre-configured scan tasks, and also change
their scanning options. Moreover, you can create customized scan tasks if you want
to scan specific locations on your computer. Follow these steps to run a scan task
in Expert View:
1. Click Antivirus on the left-side menu.
2. Click the Virus Scan tab. Here you can find a number of default scan tasks and

you can create your own scan tasks.
3. Double-click the scan task you want to run.
4. Follow the Antivirus Scan wizard to complete the scan.

30.3. Using Scan Activity Bar

Scan Activity Bar

The Scan activity bar is a graphic visualization of the
scanning activity on your system. This small window is by
default available only in Expert View.
You can use the Scan activity bar to quickly scan files and
folders. Drag & drop the file or folder you want to be
scanned onto the Scan activity bar. Follow the Antivirus
Scan wizard to complete the scan.

Note
For more information, please refer to “Scan Activity Bar” (p. 20).
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31. How Do I Create a Custom Scan Task?
To create a scan task, open BitDefender and depending on the user interface view
mode, proceed as follows:
Intermediate View

Go to the Security tab and click Custom Scan in the Quick Tasks area on the
left side of the window.
A wizard will appear to help you create a scan task. You can navigate through
the wizard using the Next and Back buttons. To exit the wizard, click Cancel.
1. Welcome
2. Choose Target

Click Add Target to select the files or folders to be scanned.
Click Advanced Settings. In theOverview tab, adjust the scanning options
by moving the cursor on the slider. If you want to configure the scanning
options in detail, click Custom. Go to the Scheduler tab to select when the
task will run.

3. Finish
This is where you can enter the task name and optionally add the scan to
the Quick Tasks area.
Click Start Scan to create the task and launch the scan wizard.

Expert View
1. Go to Antivirus > Virus Scan.
2. Click New Task. A new window will appear.

Note
You can also right-click a pre-defined scan task, such as Deep System Scan
and choose Clone Task. This is useful when creating new tasks, as you can
modify the settings of the task you have duplicated.

3. In the Overview tab, enter the task name and adjust the scanning options
by moving the cursor on the slider.
If you want to configure the scanning options in detail, click Custom.

4. Go to the Paths tab to select the scan target. Click Add Item(s) to select
the files or folders to be scanned.

5. Go to the Scheduler tab to select when the task will run.
6. Click Ok to save the task. The new task will appear under the User defined

tasks and can be edited, removed or run at any moment from this window.
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32. How Do I Schedule a Computer Scan?
Scanning your computer periodically is a best practice to keep your computer free
from malware. BitDefender allows you to schedule scan tasks so that you can
automatically scan your computer.
To schedule BitDefender to scan your computer, follow these steps:
1. Open BitDefender.
2. Depending on the user interface view mode, proceed as follows:

Intermediate View
Go to the Security tab and click Configure Antivirus in the Quick Tasks
area on the left side of the window.

Expert View
Click Antivirus on the left-side menu.

3. Click the Virus Scan tab. Here you can find a number of default scan tasks and
you can create your own scan tasks.
● System tasks are available and can run on every Windows user account.
● User tasks are only available to and can only be run by the user who created
them.

These are the default scan tasks that you can schedule:
Full System Scan

Scans the entire system, except for archives. In the default configuration, it
scans for all types of malware other than rootkits.

Quick Scan
Quick Scan uses in-the-cloud scanning to detect malware running in your
system. Running a Quick Scan usually takes less than a minute and uses a
fraction of the system resources needed by a regular virus scan.

Auto-logon Scan
Scans the items that are run when a user logs on to Windows. To use this
task, you must schedule it to run at system startup. By default, the autologon
scan is disabled.

Deep System Scan
Scans the entire system. In the default configuration, it scans for all types
of malware threatening your system's security, such as viruses, spyware,
adware, rootkits and others.

My Documents
Use this task to scan important current user folders: My Documents,
Desktop and StartUp. This will ensure the safety of your documents, a
safe workspace and clean applications running at startup.
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If none of these scan tasks suit your needs, you can create a new scan task, which
you can then schedule to run as needed.

4. Right-click the desired scan task and select Schedule. A new window will appear.
5. Schedule the task to run as needed:

● To run the scan task one-time only, select Once and specify the start date and
time.

● To run the scan task after the system startup, select On system startup. You
can specify how long after the startup the task should start running (in minutes).

● To run the scan task on a regular basis, select Periodically and specify the
frequency and the start date and time.

Note
For example, to scan your computer every Saturday at 2 AM, you must configure
the schedule as follows:
a. Select Periodically.
b. In the At every field, type 1 and then selectweeks from the menu. In this way,

the task is run once every week.
c. Set as start date the first Saturday to come.
d. Set as start time 2:00:00 AM.

6. Click OK to save the schedule. The scan task will run automatically according to
the schedule you have defined. If the computer is shut down when the schedule
is due, the task will run the next time you start your computer.
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33. How Do I Back Up Data?
With BitDefender Total Security 2011, you can make reserve copies of your valuable
data (documents, images etc) on various storage media:
● your computer
● a USB storage device
● a network location
● CD/DVD
● an FTP server
Backing data up helps protect against data loss. If you make regular backups of
your data, you can restore them whenever necessary. In this way, you can recover
lost files or go back to a previous version of a document.

Important
BitDefender Total Security 2011 is not designed to back up and restore Windows.
You cannot create an image of the operating system and of the installed applications
so that you can later restore your system to that state, if needed.

To back up data on a local storage media, follow these steps:
1. Open BitDefender.
2. Start the local backup wizard.

● In Intermediate View, go to the File Storage tab and click Backup Locally
and select Backup Locally.

● In Expert View, go to Backup and click Backup Locally.
3. Follow the wizard steps to configure and create the backup. For detailed

information, please refer to “Backing Up Data Locally” (p. 138).
a. Click Next.
b. Select the data you want to back up and click Next.
c. Specify where you want to back up the selected data: select a storagemedium,

click Choose location and choose the backup location (except when you back
up data on a CD/DVD). Click Next.

d. Configure a backup schedule, if needed, and click Next.
e. Type the name of the backup job and click Start Backup.
f. Wait for the backup to be completed and click Finish.

If you need more backup options, or if you want to manage the backup jobs you
have created, open BitDefender in Expert View, go to Backup and click Settings.
For detailed information, please refer to “Backup Settings” (p. 141).
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34. How Do I Restore Backed Up Data?
You can easily recover lost data that you previously backed up with BitDefender.
Before restoring any data, make sure that the device where you backed the data
up is available. Depending on the device you used, you may need to take one of
these actions:
● Insert the backup USB stick into a USB port.
● Insert the backup CD/DVD into the drive.
● Check if you can connect to the network location or FTP server where the backup
is stored.

To restore data backed up on a local storage medium, follow these steps:
1. Open BitDefender.
2. Start the local restore wizard.

● In Intermediate View, go to the File Storage tab and click Backup Locally
and select Local Restore.

● In Expert View, go to Backup and click Local Restore.
3. Follow the wizard steps to restore the data. For detailed information, please refer

to “Restoring Locally Backed-Up Data” (p. 140).
a. Click Next.
b. Specify the backup file you want to restore data from: select the storage

medium, click Choose location and locate the .ecs backup file. Click Next.
c. Specify the data restore conditions and click Next. You can choose to restore

data to a different location or to restore only specific data.
d. Click Restore.
e. Wait for the data to be restored and click Finish.

If you need more data restore options, or if you want to manage the restore jobs
you have created, open BitDefender in Expert View, go to Backup and click
Settings. For detailed information, please refer to “Backup Settings” (p. 141).
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35. How Do I Create Windows User Accounts?
A Windows user account is a unique profile that includes all the settings, privileges
and personal files for each user.
Windows accounts let the home PC administrator control access for each user.
Setting up user accounts comes in handy when the PC is used by both parents and
children – a parent can set up accounts for each child.
Choose which operating system you have to find out how to create Windows
accounts.
●Windows XP:
1. Log on to your computer as an administrator.
2. Click Start, click Control Panel, and then click User Accounts.
3. Click Create a new account.
4. Type the name for the user. You can use the person's full name, first name, or

a nickname. Then click Next.
5. For the account type, choose Limited, and then Create Account. Limited

accounts are appropriate for children because they cannot make system-wide
changes or install certain applications.

6. Your new account will have been created and you will see it listed in the Manage
Accounts screen.

●Windows Vista or Windows 7:
1. Log on to your computer as an administrator.
2. Click Start, click Control Panel, and then click User Accounts.
3. Click Create a new account.
4. Type the name for the user. You can use the person's full name, first name, or

a nickname. Then click Next.
5. For the account type, click Standard, and then Create Account. Limited accounts

are appropriate for children because they cannot make system-wide changes
or install certain applications.

6. Your new account will have been created and you will see it listed in the Manage
Accounts screen.

Note
Now that you have added new user accounts, you can create passwords for the
accounts.
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36. How Do I Update BitDefender Using a Proxy Server?
Normally, BitDefender automatically detects and imports the proxy settings from
your system. If you connect to the Internet through a proxy server, you may need
to find the proxy settings and configure BitDefender accordingly. To find out how
to do this, please refer to “How Do I Find Out My Proxy Settings?” (p. 244).
After finding the proxy settings, follow these steps:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to General > Settings.
3. Click Proxy Settings from Connection Settings.
4. Enter the proxy settings in the corresponding fields.
5. Click OK.

Note
If this information was not helpful, you can contact BitDefender for support as
described in section “Support” (p. 236).
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37. How Do I Upgrade to Another BitDefender 2011
Product?

With BitDefender 2011 you can easily upgrade from one BitDefender 2011 product
to another.
All you need to do is purchase a license key for the BitDefender 2011 product you
want to upgrade to and enter it in the registration window of the BitDefender 2011
product you are currently using.
Follow these steps:
1. Open BitDefender.
2. Click the License Info link on the bottom of the window. The registration window

will appear.
3. Enter the license key and click Register Now.
4. BitDefender will inform you that the license key is for a different product and will

give you the option to install it. Click the corresponding link and follow the
three-step guided procedure to perform the upgrade.
a. Confirm Action
b. Upgrade in progress

Wait for BitDefender to complete the upgrade process. This will take a few
minutes.

c. Upgrade completed
The process has completed. A system reboot may be required.
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38. How Can I Improve the Speed of My System?
The system speed depends not only on the hardware configuration, such as the
CPU load, memory usage and hard disk space. It is also directly connected to your
software configuration and to your data management.
These are the main actions you can take with BitDefender to improve your system's
speed and performance:
● Disk Defragmenter physically reorganizes the data on the hard disk in order to
access files faster and improve overall system performance.

● PC Clean-Up improves the system performance by removing those files which are
no longer useful, such as: temporary Internet files, cookies and the system
temporary files.

● Registry Cleaner scans the Windows Registry and deletes the invalid registry keys
improving the performance of your system.

● Scan Your System Periodically at least once a week to make sure your system
speed and its general behavior is not affected by malware.
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39. How Do I Use File Vaults?
The BitDefender File Vault enables you to create encrypted, password-protected
logical drives (or vaults) on your computer where you can securely store your
confidential and sensitive documents. Physically, the vault is a file stored on the
local hard drive having the .bvd extension.
When you create a file vault, two aspects are important: the size and the password.
The default 50 MB size should be enough for your private documents, Excel files
and others the like. However, for videos or other large files you may need more
space.
To securely store your confidential or sensitive files or folders in BitDefender file
vaults, follow these steps:
● Create a file vault and set a strong password for it.
To create a vault, right-click an empty area of the Desktop or in a folder on your
computer, point to BitDefender File Vault and select Create vault.
A new window will appear. Proceed as follows:
1. Click Browse, select the location of the vault and save the vault file under the

desired name.
2. Choose a drive letter from the menu. When you open the vault, a virtual disk

drive labeled with the selected letter appears in My Computer.
3. Type the vault password in the Password and Confirm fields.
4. If you want to change the default size (50 MB) of the vault, type the desired

value in the Vault size field.
5. Click Create if you only want to create the vault at the selected location. To

create and display the vault as a virtual disk drive in My Computer click
Create and Open.

Note
When you open the vault, a virtual disk drive appears inMy Computer. The drive
is labeled with the drive letter assigned to the vault.

● Add the files or folders you want to keep safe to the vault.
In order to add a file to a vault, you must first open the vault.
1. Browse to the .bvd vault file.
2. Right-click the vault file, point to BitDefender File Vault and select Open.
3. In the window that appears, select a drive letter to assign to the vault, enter

the password and click Open.
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You can now perform operations on the drive that corresponds to the desired file
vault using Windows Explorer, just as you would with a regular drive. To add a
file to an open vault, you can also right-click the file, point to BitDefender File
Vault and select Add to file vault.

● Keep the vault locked at all times.
Only open vaults when you need to access them or manage their content. To lock
a vault, right-click the corresponding virtual disk drive fromMy Computer, point
to BitDefender File Vault and select Lock.

●Make sure not to delete the .bvd vault file.
Deleting the file also deletes the vault contents.

For more information about operating with file vaults, please refer to “File Encryption”
(p. 162).
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40. Troubleshooting
This chapter presents some problems you may encounter when using BitDefender
and provides you with possible solutions to these problems. Most of these problems
can be solved through the appropriate configuration of the product settings.
If you cannot find your problem here, or if the presented solutions do not solve it,
you can contact the BitDefender technical support representatives as presented in
chapter “Support” (p. 236).

40.1. Installation Problems
This article helps you troubleshoot the most common installation problems with
BitDefender. These problems can be grouped into the following categories:
● Installation validation errors: the setup wizard cannot be run due to specific
conditions on your system.

● Failed installations: you initiated installation from the setup wizard, but it was not
completed successfully.

40.1.1. Installation Validation Errors
When you start the setup wizard, a number of conditions are verified to validate if
the installation can be initiated. The following table presents the most common
installation validation errors and solutions to overcome them.

Description&SolutionError
In order to run the setup wizard and install BitDefender
you need administrator privileges. Do any of the
following:

You do not have sufficient
privileges to install the
program.

● Log on to a Windows administrator account and run
the setup wizard again.

● Right-click the installation file and select Run as.
Type the user name and password of a Windows
administrator account on the system.

BitDefender was previously installed on your system,
but the installation was not completely removed. This
condition blocks a new installation of BitDefender.

The installer has detected
a previous BitDefender
version that was not
uninstalled properly. To overcome this error and install BitDefender, follow

these steps:
1. Go to www.bitdefender.com/uninstall and download

the uninstall tool on your computer.

Troubleshooting 210

BitDefender Total Security 2011

www.bitdefender.com/uninstall


Description&SolutionError
2. Run the uninstall tool using administrator privileges.
3. Restart your computer.
4. Start the setup wizard again to install BitDefender.

You are trying to install BitDefender on an unsupported
operating system. Please check the “System

The BitDefender product is
not compatible with your
operating system. Requirements” (p. 2) to find out the operating

systems you can install BitDefender on.
If your operating system is Windows XP with Service
Pack 1 or without any service pack, you can install
Service Pack 2 or higher and then run the setup wizard
again.
If you get such an error, you are trying to run an
incorrect version of the installation file. There are two

The installation file is
designed for a different
type of processor. versions of the BitDefender installation file: one for

32-bit processors and the other for 64-bit processors.
To make sure you have the correct version for your
system, download the installation file directly from
www.bitdefender.com.

40.1.2. Failed Installation
There are several installation fail possibilities:
● During installation, an error screen appears. You may be prompted to cancel the
installation or a button may be provided to run an uninstall tool that will clean up
the system.

Note
Immediately after you initiate installation, you may be notified that there is not
enough free disk space to install BitDefender. In such case, free the required amount
of disk space on the partition where you want to install BitDefender and then
resume or reinitiate the installation.

● The installation hangs out and, possibly, your system freezes. Only a restart
restores system responsiveness.

● Installation was completed, but you cannot use some or all of the BitDefender
functions.

To troubleshoot a failed installation and install BitDefender, follow these steps:
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1. Clean up the system after the failed installation. If the installation fails,
some BitDefender registry keys and files may remain in your system. Such
remainders may prevent a new installation of BitDefender. They may also affect
system performance and stability. This is why you must remove them before you
try to install the product again.
If this is the case, the easiest solution to follow is to remove BitDefender
completely from the system and then reinstall it. For more information, please
refer to “How Do I Remove BitDefender Completely?” (p. 245).

2. Verify possible causes why installation failed. Before you proceed to
reinstall the product, verify and remove possible conditions that may have caused
the installation to fail:
a. Check if you have any other security solution installed as they may disrupt

the normal operation of BitDefender. If this is the case, we recommend you
to remove all of the other security solutions and then reinstall BitDefender.

b. You should also check if your system is infected. Do any of the following:
● Use the BitDefender Rescue CD to scan your computer and remove any
existing threats. For more information, please refer to “BitDefender Rescue
CD” (p. 228).

● Open an Internet Explorer window, go to www.bitdefender.com and run an
online scan (click the scan online button).

3. Try again to install BitDefender. It is recommended that you download and run
the latest version of the installation file from www.bitdefender.com.

4. If installation fails again, contact BitDefender for support as described in “Support”
(p. 236).

40.2. My System Appears to Be Slow
Usually, after installing a security software, there may appear a slight slowdown of
the system, which to a certain degree is normal.
If you notice a significant slow down, this issue can appear for the following reasons:
● BitDefender is not the only security program installed on the system.
Though BitDefender searches and removes the security programs found during
the installation, it is recommended to remove any other antivirus program you
may use before installing BitDefender. For more information, please refer to “How
Do I Remove Other Security Solutions?” (p. 243).

● The Minimal System Requirements for running BitDefender are not met.
If your machine does not meet the Minimal System Requirements, the computer
will become sluggish, especially when multiple applications are running at the
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same time. For more information, please refer to “Minimal System Requirements”
(p. 2).

● There are too many invalid registry keys left in your Windows Registry.
Cleaning the Windows Registry can improve the performance of your system. For
more information, please refer to “Cleaning Windows Registry” (p. 176).

● Your hard disk drives are too fragmented.
File fragmentation slows down file access and decreases system performance.
Running the Disk Defragmenter can improve the performance of your system.
For more information, please refer to “Defragmenting Hard Disk Volumes” (p.
173).

● The applications running on your system are using too many resources.
The BitDefender Performance Monitor allows you to determine the impact of the
applications running on your system by means of CPU load, memory usage and
hard disk use.
You should be able to pinpoint the applications that are causing the system to
perform poorly, and close or monitor them. For more information, please refer to
“Performance Monitor” (p. 179).

40.3. Scan Doesn't Start
This type of issue can have two main causes:
● A previous BitDefender installation which was not completely removed
or a faulty BitDefender installation.
If this is the case, the easiest solution to follow is to remove BitDefender completely
from the system and then reinstall it. For more information, please refer to “How
Do I Remove BitDefender Completely?” (p. 245).

● BitDefender is not the only security solution installed on your system.
In this case, follow these steps:
1. Remove the other security solution. For more information, please refer to “How

Do I Remove Other Security Solutions?” (p. 243).
2. Remove BitDefender completely from the system.
3. Reinstall BitDefender on the system.

If this information was not helpful, you can contact BitDefender for support as
described in section “Support” (p. 236).
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40.4. I Can no Longer Use an Application
This issue occurs when you are trying to use a program which was working normally
before installing BitDefender.
You may encounter one of these situations:
● You could receive a message from BitDefender that the program is trying to make
a modification to the system.

● You could receive an error message from the program you're trying to use.
This type of situation occurs when the Active Virus Control module mistakenly
detects some applications as malicious.
Active Virus Control is a BitDefender module which constantly monitors the
applications running on your system and reports those with potentially malicious
behavior. Since this feature is based on a heuristic system, there may be cases
when legitimate applications are reported by Active Virus Control.
When this situation occurs, you can exclude the respective application from being
monitored by Active Virus Control.
To add the program to the exclusions list, follow these steps:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Antivirus > Shield.
3. Click Advanced Settings.
4. In the new window go to the Exclusions tab, click the Add button and browse

to the location of the program's .exe file (usually located in the C:\Program
Files).

5. Click OK to save the changes and close the window.
6. Close the BitDefender window and check if the issue still occurs.
If this information was not helpful, you can contact BitDefender for support as
described in section “Support” (p. 236).

40.5. I Cannot Connect to the Internet
You may notice that a program can no longer connect to the Internet or access
network services after installing BitDefender.
The Troubleshoot wizard will help you identify and solve the connection issue. To
start the wizard, open BitDefender and, depending on the user interface mode,
proceed as follows:
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Intermediate View
Go to the Security tab and click Configure Firewall in the Quick Tasks area
on the left side of the window. Select the Settings tab in the new window that
appears and click Troubleshoot.

Expert View
Go to Firewall > Settings and click Troubleshoot.

Follow the three-step guided procedure to start the troubleshooting. You can navigate
through the wizard using the Next button. To exit the wizard, click Cancel.
1. Welcome

Select I am trying to access the Internet and the action fails.
2. Identify Problem

Click Choose Application and Browse to locate the program's .exe file (usually
located in the C:\Program Files, i.e. Firefox.exe). Click Add.

3. Recommended Solution
Choose Yes, allow access. Click Finish and check if the issue still occurs.

If this information was not helpful, you can contact BitDefender for support as
described in section “Support” (p. 236).

40.6. I Cannot Use a Printer
Depending on the network you are connected to, the BitDefender firewall may block
the connection between your computer and a network printer.
In this case, the best solution is to configure BitDefender to automatically allow
connections to and from the respective printer.
The Troubleshoot wizard will help you identify and solve the connection issue. To
start the wizard, open BitDefender and, depending on the user interface mode,
proceed as follows:
Intermediate View

Go to the Security tab and click Configure Firewall in the Quick Tasks area
on the left side of the window. Select the Settings tab in the new window that
appears and click Troubleshoot.

Expert View
Go to Firewall > Settings and click Troubleshoot.

Follow the three-step guided procedure to start the troubleshooting. You can navigate
through the wizard using the Next button. To exit the wizard, click Cancel.
1. Welcome

Select I am trying to print and the action fails.
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2. Identify Problem
Click Choose Printer. Select the printer from the list, either by name or by IP
address. If you cannot find the device in the list, enter the IP address manually
in the edit field. Click Add.

3. Recommended Solution
Choose Yes, allow access. Click Finish and check if the issue still occurs.

If the Troubleshoot wizard indicates that the problem is not caused by the
BitDefender firewall on your computer, check for other potential causes, such as
the following:
● The firewall on the other computer may block file and printer sharing with your
computer.
▶ If the Windows Firewall is used, it can be configured to allow file and printer
sharing as follows: open the Windows Firewall settings window, Exceptions
tab and select the File and Printer Sharing check box.

▶ If another firewall program is used, please refer to its documentation or help
file.

● General conditions that may prevent using or connecting to the shared printer:
▶ You may need to log on to a Windows administrator account to access the
shared printer.

▶ Permissions are set for the shared printer to allow access to specific computer
and users only. If you are sharing your printer, check the permissions set for
the printer to see if the user on the other computer is allowed access to the
printer. If you are trying to connect to a shared printer, check with the user on
the other computer if you have permission to connect to the printer.

▶ The printer connected to your computer or to the other computer is not shared.
▶ The shared printer is not added on the computer.

Note
To learn how to manage printer sharing (share a printer, set or remove permissions
for a printer, connect to a network printer or to a shared printer), go to the Windows
Help and Support Center (in the Start menu, click Help and Support).

● Access to a network printer may be restricted to specific computers or users only.
You should check with the network administrator if you have permission to connect
to that printer.

If this information was not helpful, you can contact BitDefender for support as
described in section “Support” (p. 236).
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40.7. I Cannot Share Files with Another Computer
Depending on the network you are connected to, the BitDefender firewall may block
the connection between your system and another computer. As a result, you may
no longer share files with the other computer. In this case, the best solution is to
configure BitDefender to automatically allow connections to and from the respective
system.
The Troubleshoot wizard will help you identify and solve the connection issue. To
start the wizard, open BitDefender and, depending on the user interface mode,
proceed as follows:
Intermediate View

Go to the Security tab and click Configure Firewall in the Quick Tasks area
on the left side of the window. Select the Settings tab in the new window that
appears and click Troubleshoot.

Expert View
Go to Firewall > Settings and click Troubleshoot.

Follow the three-step guided procedure to start the troubleshooting. You can navigate
through the wizard using the Next button. To exit the wizard, click Cancel.
1. Welcome

Select I am trying to access a computer in my network and the action
fails.

2. Identify Problem
Click Choose Computer. Select the computer from the list, either by name or
by IP address. If you cannot find the computer in the list, enter the IP address
manually in the edit field. Click Add.

3. Recommended Solution
Choose Yes, allow access. Click Finish and check if the issue still occurs.

If this information was not helpful, you can contact BitDefender for support as
described in section “Support” (p. 236).

40.8. My Internet Is Slow
This situation may appear after you install BitDefender. The issue could be caused
by errors in the BitDefender firewall configuration.
To troubleshoot this situation, follow these steps:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Firewall > Settings.
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3. Clear the Firewall is enabled check box to temporarily disable the firewall.
4. Check if you can connect to the Internet with the BitDefender firewall disabled.

● If you still cannot connect to the Internet, the issue may not be caused by
BitDefender. You should contact your Internet Service Provider to verify if the
connection is operational on their side.
If you receive confirmation from your Internet Service Provider that the
connection is operational on their side and the issue still persists, contact
BitDefender as described in section “Support” (p. 236).

● If you manage to connect to the Internet after disabling the BitDefender firewall,
follow these steps:
a. Open BitDefender, click Options in the upper-right corner of the window

and choose Expert View.
b. Go to Firewall > Settings and select the box in order to enable the Firewall.
c. Click Advanced Settings, select Enable Internet Connection Sharing

and clear Block Port Scans.
d. Go to the Network tab in the main window.
e. Pull down the drop-down menu from the Network Type column and select

Home/ Office.
f. Go to the Generic column and set it to Yes. Set the Stealth Mode to

Remote.
g. Check if you can connect to the Internet.

If this information was not helpful, you can contact BitDefender for support as
described in section “Support” (p. 236).

40.9. How to Update BitDefender on a Slow Internet Connection
If you have a slow Internet connection (such as dial-up), errors may occur during
the update process.
To keep your system up to date with the latest BitDefender malware signatures,
follow these steps:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Go to Update > Settings.
3. UnderManual Update Settings, selectPrompt before downloading updates.
4. Click Apply and go to the Update tab.
5. Click Update Now and you will see that a new window will appear.
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6. Select only Signatures updates and then click Ok.
7. BitDefender will download and install only the malware signature updates.

40.10. My Computer Is Not Connected to the Internet. How Do
I Update BitDefender?

If your computer is not connected to the Internet, you must download the updates
manually to a computer with Internet access and then transfer them to your
computer using a removable device, such as a flash drive.
Follow these steps:
1. On a computer with Internet access, open a web browser and go to:

www.bitdefender.com/site/view/Desktop-Products-Updates.html
2. In theManual Update column, click the link corresponding to your product and

system architecture. If you don't know whether your Windows is running on 32
or 64 bits, please refer to “Am I Using a 32 bit or a 64 bit Version of Windows?”
(p. 244).

3. Save the file named weekly.exe to the system.
4. Transfer the downloaded file on a removable device, such as a flash drive, and

then to your computer.
5. Double-click the file and follow the wizard.

40.11. BitDefender Services Are Not Responding
This article helps you troubleshoot the BitDefender Services are not responding
error. You may encounter this error as follows:
● The BitDefender icon in the system tray is grayed out and a pop-up informs you
that the BitDefender services are not responding.

● The BitDefender window indicates that the BitDefender services are not
responding.

The error may be caused by one of the following conditions:
● an important update is being installed.
● temporary communication errors between the BitDefender services.
● some of the BitDefender services are stopped.
● other security solutions running on your computer at the same time with
BitDefender.

● viruses on your system affect the normal operation of BitDefender.
To troubleshoot this error, try these solutions:
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1. Wait a few moments and see if anything changes. The error may be temporary.
2. Restart the computer and wait a few moments until BitDefender is loaded. Open

BitDefender to see if the error persists. Restarting the computer usually solves
the problem.

3. Check if you have any other security solution installed as they may disrupt the
normal operation of BitDefender. If this is the case, we recommend you to remove
all of the other security solutions and then reinstall BitDefender.

4. If the error persists, there may be a more serious problem (for example, you may
be infected with a virus that interferes with BitDefender). Please contact
BitDefender for support as described in section “Support” (p. 236).

40.12. Antispam Filter Does Not Work Properly
This article helps you troubleshoot the following problems concerning the BitDefender
Antispam filtering operation:
● A number of legitimate e-mail messages are marked as [spam].
● Many spam messages are not marked accordingly by the antispam filter.
● The antispam filter does not detect any spam message.

40.12.1. Legitimate Messages Are Marked as [spam]
Legitimate messages are marked as [spam] simply because they look like spam
to the BitDefender antispam filter. You can normally solve this problem by adequately
configuring the Antispam filter.
BitDefender automatically adds the receivers of your e-mail messages to a Friends
List. The e-mail messages received from the contacts in the Friends list are
considered to be legitimate. They are not verified by the antispam filter and, thus,
they are never marked as [spam].
The automatic configuration of the Friends list does not prevent the detection errors
that may occur in these situations:
● You receive a lot of solicited commercial mail as a result of subscribing on various
websites. In this case, the solution is to add the e-mail addresses from which you
receive such e-mail messages to the Friends list.

● A significant part of your legitimate mail is from people to whom you never
e-mailed before, such as customers, potential business partners and others. Other
solutions are required in this case.

If you are using one of the mail clients BitDefender integrates into, try the following
solutions:
1. Indicate detection errors. This is used to train the Learning Engine (Bayesian) of

the antispam filter and it helps prevent future detection errors. The Learning
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Engine analyzes the indicated messages and learns their patterns. The next
e-mail messages that fit the same patterns will not be marked as [spam].

2. Decrease antispam protection level. By decreasing the protection level, the
antispam filter will need more spam indications to classify an e-mail message as
spam. Try this solution only if many legitimate messages (including solicited
commercial messages) are incorrectly detected as spam.

3. Retrain the Learning Engine (Bayesian filter). Try this solution only if the previous
solutions did not offer satisfactory results.

Note
BitDefender integrates into the most commonly used mail clients through an
easy-to-use antispam toolbar. For a complete list of supported mail clients, please
refer to “Software Requirements” (p. 2).

If you are using a different mail client, you cannot indicate detection errors and
train the Learning Engine. To solve the problem, try decreasing the antispam
protection level.

Add Contacts to Friends List
If you are using a supported mail client, you can easily add the senders of legitimate
messages to the Friends list. Follow these steps:
1. In your mail client, select an e-mail message from the sender that you want to

add to the Friends list.
2. Click the Add Friend button on the BitDefender antispam toolbar.
3. You may be asked to acknowledge the addresses added to the Friends list. Select

Don't show this message again and click OK.
You will always receive e-mail messages from this address no matter what they
contain.
If you are using a different mail client, you can add contacts to the Friends list from
the BitDefender interface. Follow these steps:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Click Antispam on the left-side menu.
3. Click the Status tab.
4. Click Manage Friends. A configuration window will appear.
5. Type the e-mail address you always want to receive e-mail messages from and

click the button to add the address to the Friends List.
6. Click OK to save the changes and close the window.
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Indicate Detection Errors
If you are using a supported mail client, you can easily correct the antispam filter
(by indicating which e-mail messages should not have been marked as [spam]).
Doing so will considerably improve the efficiency of the antispam filter. Follow these
steps:
1. Open your mail client.
2. Go to the junk mail folder where spam messages are moved.
3. Select the legitimate message incorrectly marked as [spam] by BitDefender.
4. Click the Add Friend button on the BitDefender antispam toolbar to add the

sender to the Friends list. You may need to click OK to acknowledge. You will
always receive e-mail messages from this address no matter what they contain.

5. Click the Not Spam button on the BitDefender antispam toolbar (normally
located in the upper part of the mail client window). This indicates to the Learning
Engine that the selected message is not spam. The e-mail message will be moved
to the Inbox folder. The next e-mail messages that fit the same patterns will no
longer be marked as [spam].

Decrease Antispam Protection Level
To decrease the antispam protection level, follow these steps:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Click Antispam on the left-side menu.
3. Click the Status tab.
4. Move the slider lower on the scale.
It is recommended to decrease protection by just one level and then wait enough
time to evaluate the results. If many legitimate e-mail messages are still being
marked as [spam], you can further decrease the protection level. If you notice that
many spam messages are not detected, you should not decrease the protection
level.

Retrain Learning Engine (Bayesian)
Before training the Learning Engine (Bayesian), prepare a folder containing only
SPAMmessages and another one containing only legitimate messages. The Learning
Engine will analyze them and learn the characteristics that define the spam or
legitimate messages that you usually receive. In order for the training to be efficient,
there must be over 50 messages in each category.
To reset the Bayesian database and retrain the Learning Engine, follow these steps:
1. Open your mail client.
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2. On the BitDefender antispam toolbar, click the Wizard button to start the
antispam configuration wizard.

3. Click Next.
4. Select Skip this step and click Next.
5. Select Clear antispam filter database and click Next.
6. Select the folder containing legitimate messages and click Next.
7. Select the folder containing SPAM messages and click Next.
8. Click Finish to start the training process.
9. When training is completed, click Close.

Ask for Help
If this information was not helpful, you can contact BitDefender for support as
described in section “Support” (p. 236).

40.12.2. Many Spam Messages Are Not Detected
If you are receiving many spam messages that are not marked as [spam], you
must configure the BitDefender antispam filter so as to improve its efficiency.
If you are using one of the mail clients BitDefender integrates into, try the following
solutions one at a time:
1. Indicate undetected spam messages. This is used to train the Learning Engine

(Bayesian) of the antispam filter and it usually improves antispam detection. The
Learning Engine analyzes the indicated messages and learns their patterns. The
next e-mail messages that fit the same patterns will be marked as [spam].

2. Add spammers to the Spammers list. The e-mail messages received from
addresses in the Spammers list are automatically marked as [spam].

3. Increase antispam protection level. By increasing the protection level, the
antispam filter will need less spam indications to classify an e-mail message as
spam.

4. Retrain the Learning Engine (Bayesian filter). Use this solution when antispam
detection is very unsatisfactory and indicating undetected spam messages no
longer works.

Note
BitDefender integrates into the most commonly used mail clients through an
easy-to-use antispam toolbar. For a complete list of supported mail clients, please
refer to “Software Requirements” (p. 2).
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If you are using a different mail client, you cannot indicate spam messages and
train the Learning Engine. To solve the problem, try increasing the antispam
protection level and adding spammers to the Spammers list.

Indicate Undetected Spam Messages
If you are using a supported mail client, you can easily indicate which e-mail
messages should have been detected as spam. Doing so will considerably improve
the efficiency of the antispam filter. Follow these steps:
1. Open your mail client.
2. Go to the Inbox folder.
3. Select the undetected spam messages.
4. Click the Is Spam button on the BitDefender antispam toolbar (normally located

in the upper part of the mail client window). This indicates to the Learning Engine
that the selected messages are spam. They are immediately marked as [spam]
and moved to the junk mail folder. The next e-mail messages that fit the same
patterns will be marked as [spam].

Add Spammers to Spammers List
If you are using a supported mail client, you can easily add the senders of the spam
messages to the Spammers list. Follow these steps:
1. Open your mail client.
2. Go to the junk mail folder where spam messages are moved.
3. Select the messages marked as [spam] by BitDefender.
4. Click the Add Spammer button on the BitDefender antispam toolbar.
5. You may be asked to acknowledge the addresses added to the Spammers list.

Select Don't show this message again and click OK.
If you are using a different mail client, you can manually add spammers to the
Spammers list from the BitDefender interface. It is convenient to do this only when
you have received several spam messages from the same e-mail address. Follow
these steps:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Click Antispam on the left-side menu.
3. Click the Status tab.
4. Click Manage Spammers. A configuration window will appear.
5. Type the spammer's e-mail address and click the button to add the address

to the Spammers List.
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6. Click OK to save the changes and close the window.

Increase Antispam Protection Level
To increase the antispam protection level, follow these steps:
1. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
2. Click Antispam on the left-side menu.
3. Click the Status tab.
4. Move the slider higher on the scale.

Retrain Learning Engine (Bayesian)
Before training the Learning Engine (Bayesian), prepare a folder containing only
SPAMmessages and another one containing only legitimate messages. The Learning
Engine will analyze them and learn the characteristics that define the spam or
legitimate messages that you usually receive. In order for the training to be efficient,
there must be over 50 messages in each folder.
To reset the Bayesian database and retrain the Learning Engine, follow these steps:
1. Open your mail client.
2. On the BitDefender antispam toolbar, click the Wizard button to start the

antispam configuration wizard.
3. Click Next.
4. Select Skip this step and click Next.
5. Select Clear antispam filter database and click Next.
6. Select the folder containing legitimate messages and click Next.
7. Select the folder containing SPAM messages and click Next.
8. Click Finish to start the training process.
9. When training is completed, click Close.

Ask for Help
If this information was not helpful, you can contact BitDefender for support as
described in section “Support” (p. 236).

40.12.3. Antispam Filter Does Not Detect Any Spam Message
If no spam message is marked as [spam], there may be a problem with the
BitDefender Antispam filter. Before troubleshooting this problem, make sure it is
not caused by one of the following conditions:
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● The BitDefender Antispam protection is available only for e-mail clients configured
to receive e-mail messages via the POP3 protocol. This means the following:
▶ E-mail messages received via web-based e-mail services (such as Yahoo, Gmail,
Hotmail or other) are not filtered for spam by BitDefender.

▶ If your e-mail client is configured to receive e-mail messages using other protocol
than POP3 (for example, IMAP4), the BitDefender Antispam filter does not check
them for spam.

Note
POP3 is one of the most widely used protocols for downloading e-mail messages
from a mail server. If you do not know the protocol that your e-mail client uses to
download e-mail messages, ask the person who configured your e-mail client.

● BitDefender Total Security 2011 doesn't scan Lotus Notes POP3 traffic.
You should also verify the following possible causes:
1. Make sure Antispam is enabled.

a. Open BitDefender.
b. Click the Options button in the upper-right corner of the window and choose

Preferences.
c. In the Security Settings category, check the antispam status.
If Antispam is disabled, this is what is causing your problem. Enable Antispam
and monitor the antispam operation to see if the problem is fixed.

2. Although very unlikely, youmay want to check if you (or someone else) configured
BitDefender not to mark spam messages as [spam].
a. Open BitDefender, click Options in the upper-right corner of the window and

choose Expert View.
b. Click Antispam on the left-side menu and then the Settings tab.
c. Make sure option Mark spam messages in subject is selected.

A possible solution is to repair or reinstall the product. However, you may want to
contact BitDefender for support instead, as described in section “Support” (p. 236).

40.13. BitDefender Removal Failed
This article helps you troubleshoot errors that may occur when removing BitDefender.
There are two possible situations:
● During removal, an error screen appears. The screen provides a button to run an
uninstall tool that will clean up the system.

● The removal hangs out and, possibly, your system freezes. Click Cancel to abort
the removal. If this does not work, restart the system.
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If removal fails, some BitDefender registry keys and files may remain in your system.
Such remainders may prevent a new installation of BitDefender. They may also
affect system performance and stability. In order to completely remove BitDefender
from your system, you must run the uninstall tool.
For more information, please refer to “How Do I Remove BitDefender Completely?”
(p. 245).
If this information was not helpful, you can contact BitDefender for support as
described in section “Support” (p. 236).
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41. Removing Malware from Your System
Malware can affect your system inmany different ways and the BitDefender approach
depends on the type of malware attack. Because viruses change their behavior
frequently, it is difficult to establish a pattern for their behavior and their actions.
There are situations when BitDefender cannot automatically remove the malware
infection from your system. In such cases, your intervention is required.
If you cannot find your problem here, or if the presented solutions do not solve it,
you can contact the BitDefender technical support representatives as presented in
chapter “Support” (p. 236).

41.1. BitDefender Rescue CD
BitDefender Rescue CD is a feature included in most BitDefender installation CD's
that allows you to scan and disinfect all existing hard drives before your operating
system starts. It can also help you save data from your compromised Windows PC
to a removable device.
If you don't have a BitDefender Rescue CD, you can download it in the form of an
ISO image from this location:
http://download.bitdefender.com/rescue_cd/
Download the .iso file and burn it to a CD or DVD using a tool of your choice.

Scanning the System with the BitDefender Rescue CD
To scan your system with the BitDefender Rescue CD, follow these steps:
1. Set up the BIOS of your computer to boot off the CD.
2. Put the CD in the drive and reboot the computer.
3. Wait until the BitDefender screen appears and select Start BitDefender Rescue

CD in the preferred language.
4. Wait for the boot process to complete. This may take a while.
5. As soon as the boot process has completed, the BitDefender signatures are

updated automatically and a scan of all detected hard disk partitions is started.

Saving Data with the BitDefender Rescue CD
Let's assume that you cannot start your Windows PC due to some unknown issues.
At the same time, you desperately need to access some important data from your
computer. This is where BitDefender Rescue CD comes in handy.
To save your data from the computer to a removable device, such as an USB flash
drive, follow these steps:
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1. Set up the BIOS of your computer to boot off the CD.
2. Put the CD in the drive and reboot the computer.
3. Wait until the BitDefender screen appears and select Start BitDefender Rescue

CD in the preferred language.
4. Wait for the boot process to complete. This may take a while.
5. As soon as the boot process has completed, the BitDefender signatures are

updated automatically and a scan of all detected hard disk partitions is started.
Your hard disk partitions will appear on the desktop. To view the contents of a
disk in a window similar to Windows Explorer, double-click it.

Note
When working with the BitDefender Rescue CD, you will deal with Linux-type
partition names. Disks that were not labeled under Windows will appear as
[LocalDisk-0] probably corresponding to the (C:) Windows-type partition,
[LocalDisk-1] corresponding to (D:) and so on.

6. Plug the removable device into an USB port on your computer. In a few moments
a window will appear showing the contents of the device.

7. You can copy files and folders as you would normally do in the Windows
environment.

If this information was not helpful, you can contact BitDefender for support as
described in section “Support” (p. 236).

41.2. What to Do When BitDefender Finds Viruses on Your
Computer?

You may find out there is a virus on your computer in one of these ways:
● You scanned your computer and BitDefender found infected items on it.
● A virus alert informs you that BitDefender blocked one or multiple viruses on your
computer.

In such situations, update BitDefender to make sure you have the latest malware
signatures and run a Deep System Scan to analyze the system.
As soon as the deep scan is over, select the desired action for the infected items
(Disinfect, Delete, Move to quarantine).

Warning
If you suspect the file is part of the Windows operating system or that it is not an
infected file, do not follow these steps and contact BitDefender Customer Care as
soon as possible.
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If the selected action could not be taken and the scan log reveals an infection which
could not be deleted, you have to remove the file(s) manually:
The first method can be used in Normal mode:
1. Turn off the BitDefender real-time antivirus protection. To find out how to do this,

please refer to “How Do I Enable / Disable the Real Time Protection?” (p. 245).
2. Display hidden objects in Windows. To find out how to do this, please refer to

“How Do I Display Hidden Objects in Windows?” (p. 246).
3. Browse to the location of the infected file (check the scan log) and delete it.
4. Turn on the BitDefender real-time antivirus protection.
In case the first method failed to remove the infection, follow these steps:
1. Reboot your system and enter in Safe Mode. To find out how to do this, please

refer to “How Do I Restart in Safe Mode?” (p. 243).
2. Display hidden objects in Windows.
3. Browse to the location of the infected file (check the scan log) and delete it.
4. Reboot your system and enter in normal mode.
If this information was not helpful, you can contact BitDefender for support as
described in section “Support” (p. 236).

41.3. How Do I Clean a Virus in an Archive?
An archive is a file or a collection of files compressed under a special format to
reduce the space on disk necessary for storing the files.
Some of these formats are open formats, thus providing BitDefender the option to
scan inside them and then take appropriate actions to remove them.
Other archive formats are partially or fully closed, and BitDefender can only detect
the presence of viruses inside them, but is not able to take any other actions.
If BitDefender notifies you that a virus has been detected inside an archive and no
action is available, it means that removing the virus is not possible due to restrictions
on the archive’s permission settings.
Here is how you can clean a virus stored in an archive:
1. Identify the archive that includes the virus by performing a Deep System Scan

of the system.
2. Turn off the BitDefender real-time antivirus protection.
3. Go to the location of the archive and decompress it using an archiving application,

like WinZip.
4. Identify the infected file and delete it.
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5. Delete the original archive in order to make sure the infection is totally removed.
6. Recompress the files in a new archive using an archiving application, like WinZip.
7. Turn on the BitDefender real-time antivirus protection and run a Deep system

scan in order to make sure there is no other infection on the system.

Note
It’s important to note that a virus stored in an archive is not an immediate threat to
your system, since the virus has to be decompressed and executed in order to infect
your system.

If this information was not helpful, you can contact BitDefender for support as
described in section “Support” (p. 236).

41.4. How Do I Clean a Virus in an E-Mail Archive?
BitDefender can also identify viruses in e-mail databases and e-mail archives stored
on disk.
Sometimes it is necessary to identify the infected message using the information
provided in the scan report, and delete it manually.
Here is how you can clean a virus stored in an e-mail archive:
1. Scan the e-mail database with BitDefender.
2. Turn off the BitDefender real-time antivirus protection.
3. Open the scan report and use the identification information (Subject, From, To)

of the infected messages to locate them in the e-mail client.
4. Delete the infectedmessages. Most e-mail clients also move the deletedmessage

to a recovery folder, from which it can be recovered. You should make sure the
message is deleted also from this recovery folder.

5. Compact the folder storing the infected message.
● In Outlook Express: On the File menu, click Folder, then Compact All Folders.
● In Microsoft Outlook: On the File menu, click Data File Management. Select the
personal folders (.pst) files you intend to compact, and click Settings. Click
Compact.

6. Turn on the BitDefender real-time antivirus protection.
If this information was not helpful, you can contact BitDefender for support as
described in section “Support” (p. 236).

41.5. How Do I Scan My Computer in Safe Mode?
BitDefender Manual Scan lets you scan a specific folder or hard disk partition without
having to create a scan task.
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This feature was designed to be used when Windows is running in Safe Mode.
If your system is infected with a virus which cannot be removed in normal mode,
you can try to remove the virus by starting Windows in Safe Mode and scanning
each hard disk partition using BitDefender Manual Scan.
To find out how you can access Safe Mode, please refer to “How Do I Restart in Safe
Mode?” (p. 243).
1. To scan your computer using BitDefender Manual Scan, follow the path from the

Windows start menu: Start → All Programs → BitDefender 2011 →
BitDefender Manual Scan.

2. Click Add Folder to select the scan target. A new window will appear.
3. Select the scan target :

● to scan your desktop, just select Desktop.
● to scan an entire hard disk partition, select it from My Computer.
● to scan a specific folder, browse for and select the respective folder.

4. Click Ok and Continue to start the scan.
5. Follow the Antivirus Scan wizard to complete the scan.

41.6. What to Do When BitDefender Detected a Clean File as
Infected?

There are cases when BitDefender mistakenly flags a legitimate file as being a threat
(a false positive). To correct this error, add the file to the BitDefender Exclusions
area:
1. Turn off the BitDefender real-time antivirus protection. To find out how to do this,

please refer to “How Do I Enable / Disable the Real Time Protection?” (p. 245).
2. Display hidden objects in Windows. To find out how to do this, please refer to

“How Do I Display Hidden Objects in Windows?” (p. 246).
3. Restore the file from the Quarantine area.
4. Insert the file in the Exclusions area.
5. Turn on the BitDefender real-time antivirus protection.
If this information was not helpful, you can contact BitDefender for support as
described in section “Support” (p. 236).
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41.7. How to Clean the Infected Files from System Volume
Information

The System Volume Information folder is a zone on your hard drive created by the
Operating System and used by Windows for storing critical information related to
the system configuration.
The BitDefender engines can detect any infected files stored by the System Volume
Information, but being a protected area it may not be able to remove them.
The infected files detected in the System Restore folders will appear in the scan log
as follows:
?:\System Volume Information\_restore{B36120B2-BA0A-4E5D-…
To completely and immediately remove the infected file or files in the data store,
disable and re-enable the System Restore feature.
When System Restore is turned off, all the restore points are removed.
When System Restore is turned on again, new restore points are created as the
schedule and events require.
In order to disable the System Restore follow these steps:
● For Windows XP:
1. Follow this path: Start → All Programs → Accessories → System Tool →

System Restore
2. Click System Restore Settings located on the left hand side of the window.
3. Select the Turn off System Restore check box on all drives, and click Apply.
4. When you are warned that all existing Restore Points will be deleted, click Yes

to continue.
5. To turn on the System Restore, clear the Turn off System Restore check

box on all drives, and click Apply.
● For Windows Vista:
1. Follow this path: Start → Control Panel → System and Maintenance →

System
2. In the left pane, click System Protection.

If you are prompted for an administrator password or confirmation, type the
password or provide confirmation.

3. To turn off the System Restore clear the check boxes corresponding to each
drive and click Ok.

4. To turn on the System Restore select the check boxes corresponding to each
drive and click Ok.
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● For Windows 7:
1. Click Start, right-click Computer and click Properties.
2. Click System protection link in the left pane.
3. In the System protection options, select each drive letter and click Configure.
4. Select Turn off system protection and click Apply.
5. Click Delete, click Continue when prompted and then click Ok.

If this information was not helpful, you can contact BitDefender for support as
described in section “Support” (p. 236).

41.8. What Are the Password-Protected Files in the Scan Log?
This is only a notification which indicates that BitDefender has detected these files
are either protected with a password or by some form of encryption.
Most commonly, the password-protected items are:
● Files that belong to another security solution.
● Files that belong to the operating system.
In order to actually scan the contents, these files would need to either be extracted
or otherwise decrypted.
Should those contents be extracted, BitDefender's real-time scanner would
automatically scan them to keep your computer protected. If you want to scan those
files with BitDefender, you have to contact the product manufacturer in order to
provide you with more details on those files.
Our recommendation to you is to ignore those files because they are not a threat
for your system.

41.9. What Are the Skipped Items in the Scan Log?
All files that appear as Skipped in the scan report are clean.
For increased performance, BitDefender does not scan files that have not changed
since the last scan.

41.10. What Are the Over-Compressed Files in the Scan Log?
The over-compressed items are elements which could not be extracted by the
scanning engine or elements for which the decryption time would have taken too
long making the system unstable.
Overcompressed means that BitDefender skipped scanning within that archive
because unpacking it proved to take up too many system resources. The content
will be scanned on real time access if needed.
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41.11. Why Did BitDefender Automatically Delete an Infected
File?

If an infected file is detected, BitDefender will automatically attempt to disinfect it.
If disinfection fails, the file is moved to quarantine in order to contain the infection.
For particular types of malware, disinfection is not possible because the detected
file is entirely malicious. In such cases, the infected file is deleted from the disk.
This is usually the case with installation files that are downloaded from untrustworthy
websites. If you find yourself in such a situation, download the installation file from
the manufacturer's website or other trusted website.
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42. Support
BitDefender strives to provide its customers with an unparalleled level of fast and
accurate support. If you experience any issue with or if you have any question about
your BitDefender product, you can use several online resources to quickly find a
solution or an answer. Or, if you prefer, you can contact the BitDefender Customer
Care team. Our support representatives will answer your questions in a timely
manner and they will provide you with the assistance you need.

42.1. Online Resources
Several online resources are available to help you solve your BitDefender-related
problems and questions.
● BitDefender Knowledge Base: http://www.bitdefender.com/help
● BitDefender Support Forum: http://forum.bitdefender.com
● the Malware City computer security portal: http://www.malwarecity.com
● the Video Tutorials
You can also use your favorite search engine to find out more information about
computer security, the BitDefender products and the company.

42.1.1. BitDefender Knowledge Base
The BitDefender Knowledge Base is an online repository of information about the
BitDefender products. It stores, in an easily accessible format, reports on the results
of the ongoing technical support and bugfixing activities of the BitDefender support
and development teams, along with more general articles about virus prevention,
the management of BitDefender solutions with detailed explanations, and many
other articles.
The BitDefender Knowledge Base is open to the public and freely searchable. The
extensive information it contains is yet another means of providing BitDefender
customers with the technical knowledge and insight they need. All valid requests
for information or bug reports coming from BitDefender clients eventually find their
way into the BitDefender Knowledge Base, as bugfix reports, workaround cheatsheets
or informational articles to supplement product helpfiles.
The BitDefender Knowledge Base is available any time at http://kb.bitdefender.com.

42.1.2. BitDefender Support Forum
The BitDefender Support Forum provides BitDefender users with an easy way to
get help and to help others.
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If your BitDefender product does not operate well, if it cannot remove specific viruses
from your computer or if you have questions about the way it works, post your
problem or question on the forum.
BitDefender support technicians monitor the forum for new posts in order to assist
you. You may also get an answer or a solution from amore experienced BitDefender
user.
Before posting your problem or question, please search the forum for a similar or
related topic.
The BitDefender Support Forum is available at http://forum.bitdefender.com, in 5
different languages: English, German, French, Spanish and Romanian. Click the
Home & Home Office Protection link to access the section dedicated to consumer
products.

42.1.3. Malware City Portal
The Malware City portal is a rich source of computer security information. Here you
can learn about the various threats your computer is exposed to when connected
to the Internet (malware, phishing, spam, cyber-criminals). A useful dictionary helps
you understand the computer security terms that you are not familiar with.
New articles are posted regularly to keep you up-to-date with the latest threats
discovered, the current security trends and other information on the computer
security industry.
The Malware City web page is http://www.malwarecity.com.

42.1.4. Video Tutorials
The video tutorials will walk you step-by-step through configuring the product. They
are created in a straightforward, down-to-earth manner that gets the message
across.
The most important objective is to ensure a pleasant experience by providing basic
and intermediate information on security principles, how to configure and how to
use BitDefender.
Themain goal is to replace the need for specialized help using product video tutorials
that provide information specifically on how to use and configure BitDefender.
For instance, instead of calling the BitDefender support for guidance or trying to
follow complicated procedures, you can watch and follow the steps presented by
the video tutorials.
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42.2. Asking for Help
The Troubleshooting and Getting Help section provides you with the necessary
information regarding the most frequent issues you may encounter when using this
product.
If you do not find the solution to your problem in the provided resources, you can
contact us directly:
● “Contact Us Directly from Your BitDefender Product” (p. 238)
● “Contact Us through Our Online Knowledge Base” (p. 239)

Important
To contact the BitDefender Customer Care you must have your BitDefender product
activated. For more information, please refer to “Registration and My Account” (p.
51).

Contact Us Directly from Your BitDefender Product
If you have a working Internet connection (Internet access), you can contact
BitDefender for assistance directly from the product interface (program window).
In order to ask for help, you can use the Integrated Support available in the product.
To use the Integrated Support, follow these steps:
1. Open BitDefender.
2. Click the Help and Support link, located in the bottom-right corner of the

window.
3. You have two options now:

● Launch a search in our database for the information you seek.
● Select the department, according to the issue encountered.
Customer service deals with purchasing, licenses, refunds, or renewal.
Technical support covers issues related to the product itself, and its
functionality.
Fight against malware addresses viruses related issues.

4. Read the relevant articles or documents and try the proposed solutions.
5. If the solution does not solve your problem, use the link in the article to launch

the Support Tool.
6. Enter your e-mail address, select the department and write a short description

of the problem.
Click Next.
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7. Please wait for a few minutes while BitDefender gathers product related
information. This information will help our engineers find a solution to your
problem.
Click Next.

8. Click Finish to send the information to the BitDefender Customer Care
Department. You will be contacted as soon as possible.

Contact Us through Our Online Knowledge Base
If you cannot access the necessary information using the BitDefender product,
please refer to our online knowledge base:
1. Go to http://www.bitdefender.com/help. The BitDefender Knowledge Base hosts

numerous articles that contain solutions to BitDefender-related issues.
2. Search the BitDefender Knowledge Base for articles that may provide a solution

to your problem.
3. Read the relevant articles or documents and try the proposed solutions.
4. If the solution does not solve your problem, use the link in the article to contact

BitDefender Customer Care.
5. Contact the BitDefender support representatives by e-mail, chat or phone.
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43. Contact Information
Efficient communication is the key to a successful business. During the past 10
years BITDEFENDER has established an unquestionable reputation by constantly
striving for better communication so as to exceed the expectations of our clients
and partners. Should you have any questions, do not hesitate to contact us.

43.1. Web Addresses
Sales department: sales@bitdefender.com
Technical support: www.bitdefender.com/help
Documentation: documentation@bitdefender.com
Partner Program: partners@bitdefender.com
Marketing: marketing@bitdefender.com
Media Relations: pr@bitdefender.com
Job Opportunities: jobs@bitdefender.com
Virus Submissions: virus_submission@bitdefender.com
Spam Submissions: spam_submission@bitdefender.com
Report Abuse: abuse@bitdefender.com
Product web site: http://www.bitdefender.com
Product ftp archives: ftp://ftp.bitdefender.com/pub
Local distributors: http://www.bitdefender.com/site/Partnership/list/
BitDefender Knowledge Base: http://kb.bitdefender.com

43.2. Local Distributors
The BitDefender local distributors are ready to respond to any inquiries regarding
their areas of operation, both in commercial and in general matters.
To find a BitDefender distributor in your country:
1. Go to http://www.bitdefender.com/site/Partnership/list/.
2. The contact information of the BitDefender local distributors should be displayed

automatically. If this does not happen, use the Partner Locator tool from the
left-side menu to select the area and the country you reside in.

3. If you do not find a BitDefender distributor in your country, feel free to contact
us by e-mail at sales@bitdefender.com. Please write your e-mail in English in
order for us to be able to assist you promptly.

43.3. BitDefender Offices
The BitDefender offices are ready to respond to any inquiries regarding their areas
of operation, both in commercial and in general matters. Their respective addresses
and contacts are listed below.
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U.S.A
BitDefender, LLC
6301 NW 5th Way, Suite 3500
Fort Lauderdale, Florida 33309
Phone (office&sales): 1-954-776-6262
Sales: sales@bitdefender.com
Technical support: http://www.bitdefender.com/help
Web: http://www.bitdefender.com

Germany
BitDefender GmbH
Airport Office Center
Robert-Bosch-Straße 2
59439 Holzwickede
Deutschland
Office: +49 2301 91 84 222
Sales: vertrieb@bitdefender.de
Technical support: http://kb.bitdefender.de
Web: http://www.bitdefender.de

UK and Ireland
Business Centre 10 Queen Street
Newcastle, Staffordshire
ST5 1ED
E-mail: info@bitdefender.co.uk
Phone: +44 (0) 8451-305096
Sales: sales@bitdefender.co.uk
Technical support: http://www.bitdefender.com/help
Web: http://www.bitdefender.co.uk

Spain
BitDefender España, S.L.U.
Avda. Diagonal, 357, 1º 1ª
08037 Barcelona
Fax: +34 93 217 91 28
Phone: +34 902 19 07 65
Sales: comercial@bitdefender.es
Technical support: www.bitdefender.es/ayuda
Website: http://www.bitdefender.es
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Romania
BITDEFENDER SRL
West Gate Park, Building H2, 24 Preciziei Street
Bucharest
Fax: +40 21 2641799
Sales phone: +40 21 2063470
Sales e-mail: sales@bitdefender.ro
Technical support: http://www.bitdefender.ro/suport
Website: http://www.bitdefender.ro
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44. Useful Information
This chapter presents some important procedures that you must be aware before
starting to troubleshoot a technical issue.
Troubleshooting a technical situation in BitDefender requires a fewWindows insights,
therefore the next steps are mostly related to the Windows operating system.

44.1. How Do I Remove Other Security Solutions?
The main reason for using a security solution is to provide protection and safety for
your data. But what happens when you have more than one security product on
the same system?
When you use more than one security solution on the same computer, the system
becomes unstable. The BitDefender Total Security 2011 installer automatically
detects other security programs and offers you the option to uninstall them.
If you did not remove the other security solutions during the initial installation, follow
these steps:
● For Windows XP:
1. Click Start, go to Control Panel and double-click Add / Remove programs.
2. Wait a few moments until the list of installed software is displayed.
3. Find the name of the program you want to remove and select Remove.
4. Wait for the uninstall process to complete, then reboot your system.

● For Windows Vista and Windows 7:
1. Click Start, go to Control Panel and double-click Programs and Features.
2. Wait a few moments until the installed software list is displayed.
3. Find the name of the program you want to remove and select Uninstall.
4. Wait for the uninstall process to complete, then reboot your system.

If you fail to remove the other security solution from your system, get the uninstall
tool from the vendor website or contact them directly in order to provide you with
the uninstall guidelines.

44.2. How Do I Restart in Safe Mode?
Safe mode is a diagnostic operating mode, used mainly to troubleshoot problems
affecting normal operation of Windows. Such problems range from conflicting drivers
to viruses preventing Windows from starting normally. In Safe Mode only a few
applications work and Windows loads just the basic drivers and a minimum of
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operating system components. This is why most viruses are inactive when using
Windows in Safe Mode and they can be easily removed.
To start Windows in Safe Mode:
1. Restart the computer.
2. Press the F8 key several times before Windows starts in order to access the boot

menu.
3. Select Safe Mode in the boot menu and press Enter.
4. Wait while Windows loads in Safe Mode.
5. This process ends with a confirmation message. Click Ok to acknowledge.
6. To start Windows normally, simply reboot the system.

44.3. Am I Using a 32 bit or a 64 bit Version of Windows?
To find out if you have a 32 bit or a 64 bit operating system, follow these steps:
● For Windows XP:
1. Click Start.
2. Locate My Computer on the Start menu.
3. Right-click My Computer and select Properties.
4. If you see x64 Edition listed under System, you are running the 64 bit version

of Windows XP.
If you don't see x64 Edition listed, you are running a 32 bit version of Windows
XP.

● For Windows Vista and Windows 7:
1. Click Start.
2. Locate Computer on the Start menu.
3. Right-click Computer and select Properties.
4. Look under System in order to check the information about your system.

44.4. How Do I Find Out My Proxy Settings?
In order to find these settings, follow these steps :
● For Internet Explorer 8:
1. Open Internet Explorer.
2. Select Tools > Internet Options.
3. In the Connections tab click LAN settings.
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4. Look under Use a proxy server for your LAN and you should see the
Address and Port of the proxy.

● For Mozilla Firefox 3.6:
1. Open Firefox.
2. Select Tools > Options.
3. In the Advanced tab go to Network tab.
4. Click Settings.

● For Opera 10.51:
1. Open Opera.
2. Select Tools > Preferences.
3. In the Advanced tab go to Network tab.
4. Click Proxy servers button to open the proxy settings dialog.

44.5. How Do I Remove BitDefender Completely?
Follow these steps in order to remove BitDefender correctly:
1. Go to www.bitdefender.com/uninstall and download the uninstall tool on your

computer.
2. Run the uninstall tool using administrator privileges.
3. Restart your computer.

44.6. How Do I Enable / Disable the Real Time Protection?
BitDefender provides continuous, real-time protection against a wide range of
malware threats by scanning all accessed files, e-mail messages and the
communications through Instant Messaging Software applications (ICQ, NetMeeting,
Yahoo Messenger, MSN Messenger).
Normally the real-time protection in BitDefender is enabled and you should not turn
it off.
When you are trying to troubleshoot a problem or to remove a virus, you may need
to disable the real-time protection. They address one of these situations:
● A slowdown issue with the system after installing BitDefender
● An issue with one of the programs or applications after installing BitDefender
● Error messages which could appear shortly after installing BitDefender
Follow these steps so that youmay enable/ disable real-time protection temporarily:
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1. Open BitDefender, click Options in the upper-right corner of the window and
choose Expert View.

2. Go to Antivirus > Shield.
3. Clear the Real-time protection is enabled check box to temporarily disable

antivirus protection (or select it if you want to enable the protection).
4. You must confirm your choice by selecting from the menu how long you want

the real-time protection to be disabled.

Note
The steps for disabling the real-time protection in BitDefender should be used as a
temporary solution and only for a short period of time.

44.7. How Do I Display Hidden Objects in Windows?
These steps are useful in those cases where you are dealing with a malware situation
and you need to find and remove the infected files, which could be hidden.
Follow these steps to display hidden objects in Windows:
1. Click Start, go to Control Panel and select Folder Options.
2. Go to View tab.
3. Select Display contents of system folders (for Windows XP only).
4. Select Show hidden files and folders.
5. Clear Hide file extensions for known file types.
6. Clear Hide protected operating system files.
7. Click Apply and then Ok.
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Glossary
ActiveX

ActiveX is amodel for writing programs so that other programs and the operating
system can call them. ActiveX technology is used with Microsoft Internet Explorer
to make interactive Web pages that look and behave like computer programs,
rather than static pages. With ActiveX, users can ask or answer questions, use
push buttons, and interact in other ways with the Web page. ActiveX controls
are often written using Visual Basic.
Active X is notable for a complete lack of security controls; computer security
experts discourage its use over the Internet.

Adware
Adware is often combined with a host application that is provided at no charge
as long as the user agrees to accept the adware. Because adware applications
are usually installed after the user has agreed to a licensing agreement that
states the purpose of the application, no offense is committed.
However, pop-up advertisements can become an annoyance, and in some cases
degrade system performance. Also, the information that some of these
applications collect may cause privacy concerns for users who were not fully
aware of the terms in the license agreement.

Archive
A disk, tape, or directory that contains files that have been backed up.
A file that contains one or more files in a compressed format.

Backdoor
A hole in the security of a system deliberately left in place by designers or
maintainers. Themotivation for such holes is not always sinister; some operating
systems, for example, come out of the box with privileged accounts intended
for use by field service technicians or the vendor's maintenance programmers.

Boot sector
A sector at the beginning of each disk that identifies the disk's architecture
(sector size, cluster size, and so on). For startup disks, the boot sector also
contains a program that loads the operating system.

Boot virus
A virus that infects the boot sector of a fixed or floppy disk. An attempt to boot
from a diskette infected with a boot sector virus will cause the virus to become
active in memory. Every time you boot your system from that point on, you will
have the virus active in memory.

Browser
Short for Web browser, a software application used to locate and display Web
pages. The two most popular browsers are Netscape Navigator and Microsoft
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Internet Explorer. Both of these are graphical browsers, which means that they
can display graphics as well as text. In addition, most modern browsers can
present multimedia information, including sound and video, though they require
plug-ins for some formats.

Command line
In a command line interface, the user types commands in the space provided
directly on the screen using command language.

Cookie
Within the Internet industry, cookies are described as small files containing
information about individual computers that can be analyzed and used by
advertisers to track your online interests and tastes. In this realm, cookie
technology is still being developed and the intention is to target ads directly
to what you've said your interests are. It's a double-edge sword for many people
because on one hand, it's efficient and pertinent as you only see ads about
what you're interested in. On the other hand, it involves actually "tracking" and
"following" where you go and what you click. Understandably so, there is a
debate over privacy and many people feel offended by the notion that they are
viewed as a "SKU number" (you know, the bar code on the back of packages
that gets scanned at the grocery check-out line). While this viewpoint may be
extreme, in some cases it is accurate.

Disk drive
It's a machine that reads data from and writes data onto a disk.
A hard disk drive reads and writes hard disks.
A floppy drive accesses floppy disks.
Disk drives can be either internal (housed within a computer) or external (housed
in a separate box that connects to the computer).

Download
To copy data (usually an entire file) from a main source to a peripheral device.
The term is often used to describe the process of copying a file from an online
service to one's own computer. Downloading can also refer to copying a file
from a network file server to a computer on the network.

E-mail
Electronic mail. A service that sends messages on computers via local or global
networks.

Events
An action or occurrence detected by a program. Events can be user actions,
such as clicking a mouse button or pressing a key, or system occurrences, such
as running out of memory.

False positive
Occurs when a scanner identifies a file as infected when in fact it is not.
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Filename extension
The portion of a filename, following the final point, which indicates the kind of
data stored in the file.
Many operating systems use filename extensions, e.g. Unix, VMS, and MS-DOS.
They are usually from one to three letters (some sad old OSes support no more
than three). Examples include "c" for C source code, "ps" for PostScript, "txt"
for arbitrary text.

Heuristic
A rule-based method of identifying new viruses. This method of scanning does
not rely on specific virus signatures. The advantage of the heuristic scan is that
it is not fooled by a new variant of an existing virus. However, it might
occasionally report suspicious code in normal programs, generating the so-called
"false positive".

IP
Internet Protocol - A routable protocol in the TCP/IP protocol suite that is
responsible for IP addressing, routing, and the fragmentation and reassembly
of IP packets.

Java applet
A Java program which is designed to run only on a web page. To use an applet
on a web page, you would specify the name of the applet and the size (length
and width, in pixels) that the applet can utilize. When the web page is accessed,
the browser downloads the applet from a server and runs it on the user's
machine (the client). Applets differ from applications in that they are governed
by a strict security protocol.
For example, even though applets run on the client, they cannot read or write
data onto the client's machine. Additionally, applets are further restricted so
that they can only read and write data from the same domain that they are
served from.

Macro virus
A type of computer virus that is encoded as a macro embedded in a document.
Many applications, such as Microsoft Word and Excel, support powerful macro
languages.
These applications allow you to embed a macro in a document, and have the
macro execute each time the document is opened.

Mail client
An e-mail client is an application that enables you to send and receive e-mail.

Memory
Internal storage areas in the computer. The termmemory identifies data storage
that comes in the form of chips, and the word storage is used for memory that
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exists on tapes or disks. Every computer comes with a certain amount of physical
memory, usually referred to as main memory or RAM.

Non-heuristic
This method of scanning relies on specific virus signatures. The advantage of
the non-heuristic scan is that it is not fooled by what might seem to be a virus,
and does not generate false alarms.

Packed programs
A file in a compression format. Many operating systems and applications contain
commands that enable you to pack a file so that it takes up less memory. For
example, suppose you have a text file containing ten consecutive space
characters. Normally, this would require ten bytes of storage.
However, a program that packs files would replace the space characters by a
special space-series character followed by the number of spaces being replaced.
In this case, the ten spaces would require only two bytes. This is just one packing
technique - there are many more.

Path
The exact directions to a file on a computer. These directions are usually
described by means of the hierarchical filing system from the top down.
The route between any two points, such as the communications channel between
two computers.

Phishing
The act of sending an e-mail to a user falsely claiming to be an established
legitimate enterprise in an attempt to scam the user into surrendering private
information that will be used for identity theft. The e-mail directs the user to
visit a Web site where they are asked to update personal information, such as
passwords and credit card, social security, and bank account numbers, that
the legitimate organization already has. The Web site, however, is bogus and
set up only to steal the user’s information.

Polymorphic virus
A virus that changes its form with each file it infects. Since they have no
consistent binary pattern, such viruses are hard to identify.

Port
An interface on a computer to which you can connect a device. Personal
computers have various types of ports. Internally, there are several ports for
connecting disk drives, display screens, and keyboards. Externally, personal
computers have ports for connecting modems, printers, mice, and other
peripheral devices.
In TCP/IP and UDP networks, an endpoint to a logical connection. The port
number identifies what type of port it is. For example, port 80 is used for HTTP
traffic.
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Report file
A file that lists actions that have occurred. BitDefender maintains a report file
listing the path scanned, the folders, the number of archives and files scanned,
how many infected and suspicious files were found.

Rootkit
A rootkit is a set of software tools which offer administrator-level access to a
system. The term was first used for the UNIX operating systems and it referred
to recompiled tools which provided intruders administrative rights, allowing
them to conceal their presence so as not to be seen by the system
administrators.
The main role of rootkits is to hide processes, files, logins and logs. They may
also intercept data from terminals, network connections or peripherals, if they
incorporate the appropriate software.
Rootkits are not malicious in nature. For example, systems and even some
applications hide critical files using rootkits. However, they are mostly used to
hide malware or to conceal the presence of an intruder into the system. When
combined with malware, rootkits pose a great threat to the integrity and the
security of a system. They canmonitor traffic, create backdoors into the system,
alter files and logs and avoid detection.

Script
Another term for macro or batch file, a script is a list of commands that can be
executed without user interaction.

Spam
Electronic junk mail or junk newsgroup postings. Generally known as any
unsolicited e-mail.

Spyware
Any software that covertly gathers user information through the user's Internet
connection without his or her knowledge, usually for advertising purposes.
Spyware applications are typically bundled as a hidden component of freeware
or shareware programs that can be downloaded from the Internet; however, it
should be noted that the majority of shareware and freeware applications do
not come with spyware. Once installed, the spyware monitors user activity on
the Internet and transmits that information in the background to someone else.
Spyware can also gather information about e-mail addresses and even
passwords and credit card numbers.
Spyware's similarity to a Trojan horse is the fact that users unwittingly install
the product when they install something else. A common way to become a
victim of spyware is to download certain peer-to-peer file swapping products
that are available today.
Aside from the questions of ethics and privacy, spyware steals from the user
by using the computer's memory resources and also by eating bandwidth as it
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sends information back to the spyware's home base via the user's Internet
connection. Because spyware is using memory and system resources, the
applications running in the background can lead to system crashes or general
system instability.

Startup items
Any files placed in this folder will open when the computer starts. For example,
a startup screen, a sound file to be played when the computer first starts, a
reminder calendar, or application programs can be startup items. Normally, an
alias of a file is placed in this folder rather than the file itself.

System tray
Introduced with Windows 95, the system tray is located in the Windows taskbar
(usually at the bottom next to the clock) and contains miniature icons for easy
access to system functions such as fax, printer, modem, volume, and more.
Double click or right-click an icon to view and access the details and controls.

TCP/IP
Transmission Control Protocol/Internet Protocol - A set of networking protocols
widely used on the Internet that provides communications across interconnected
networks of computers with diverse hardware architectures and various
operating systems. TCP/IP includes standards for how computers communicate
and conventions for connecting networks and routing traffic.

Trojan
A destructive program that masquerades as a benign application. Unlike viruses,
Trojan horses do not replicate themselves but they can be just as destructive.
One of the most insidious types of Trojan horse is a program that claims to rid
your computer of viruses but instead introduces viruses onto your computer.
The term comes from a story in Homer's Iliad, in which the Greeks give a giant
wooden horse to their foes, the Trojans, ostensibly as a peace offering. But
after the Trojans drag the horse inside their city walls, Greek soldiers sneak
out of the horse's hollow belly and open the city gates, allowing their compatriots
to pour in and capture Troy.

Update
A new version of a software or hardware product designed to replace an older
version of the same product. In addition, the installation routines for updates
often check to make sure that an older version is already installed on your
computer; if not, you cannot install the update.
BitDefender has it's own update module that allows you to manually check for
updates, or let it automatically update the product.

Virus
A program or piece of code that is loaded onto your computer without your
knowledge and runs against your will. Most viruses can also replicate
themselves. All computer viruses are manmade. A simple virus that can copy
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itself over and over again is relatively easy to produce. Even such a simple
virus is dangerous because it will quickly use all available memory and bring
the system to a halt. An even more dangerous type of virus is one capable of
transmitting itself across networks and bypassing security systems.

Virus definition
The binary pattern of a virus, used by the antivirus program to detect and
eliminate the virus.

Worm
A program that propagates itself over a network, reproducing itself as it goes.
It cannot attach itself to other programs.
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